PrintShop Mail
Connect

OL® Software

User Guide







PrintShop Mail
Connect

OL® Software

User Guide
Version 2019.1
Last Revision: 2020-01-16

Objectif Lune, Inc.
2030 Pie-IX, Suite 500
Montréal, QC, Canada, H1V 2C8

+1(514) 875-5863
www.objectiflune.com

All trademarks displayed are the property of their respective owners.

© Obijectif Lune, Inc. 1994-2020. All rights reserved. No part of this documentation may be
reproduced, transmitted or distributed outside of Objectif Lune Inc. by any means whatsoever
without the express written permission of Objectif Lune Inc.

Objectif Lune Inc. disclaims responsibility for any errors and omissions in this documentation
and accepts no responsibility for damages arising from such inconsistencies or their further
consequences of any kind. Objectif Lune Inc. reserves the right to alter the information
contained in this documentation without notice.

OBJECTIF LUNE


http://www.objectiflune.com/

Table of Contents

Table of Contents . . 4
Welcome to PrintShop Mail Connect 2019.1 . ... . 14
Setup And Configuration .. . 15
System and Hardware Considerations ... ... ... 15
ANtIVIrUS EXCIUSIONS 16
Database Considerations . ... 17
Environment considerations ... . L 22
Language and Encoding Considerations ... .. ... .. 24
Network Considerations ... ... 25
Engine configuration ... 26
Performance Considerations .. ... . ... 29
System reqQUIremMEN S 31
Installation and Activation .. 34
Where to obtain the installers ... L 34
Installation - important information ... .. 34
Installation - "How t0" quides ... . .. . 34
AV At ON 35
Installation Prerequisites ... . .. 35
User accounts and SeCUNtY ... . 35
Installing PrintShop Mail Connect on Machines without Internet Access ........................ 36
Installation Wizard . 37
Running Connectinstallerin SilentMode ... .. .. 42
Activating @ LiCeNSe .. L 51
Migrating to a new workstation ... 53
Pre e reNCeS 59
UPGrading ol 83
Connect: a peek underthe hood ... . . 84
The Connectdatabase ... ... . L 85
The File SI0re L 85
TNE ENGINES 85
KN OWN LSS UGBS L 86

The OL Connect 2019.1 license update does not cater for existing AFP input licenses ....86
The Update Client OL for Connect 2019.1 does not cater for standalone Connect Print 87

Page 4

PrintShop Mail Connect



Manager installations ... .

Page break changes in 20101 . 87
Minor differences in AFP and IPDS outputintroduced in 20191 ... .. .. ... 87
Issue with image placementin 2019.1 when using some customized AFP and IPDS
Printer DefinitioNs . 87
Issue after erroneous or incomplete update or re-installation ... 88
Backend database might require periodic maintenance ... .. ... 89
Windows 10 Search service impacting Connect ... ... 89
Job Creation Presets: External Sorting change introduced in2018.2 ............................ 90
Business Graphics: Backward Compatibility Issues introduced in 2018.1 ....................... 90
KNOWN FONt ISSUS e 90
Minor differences in PCL, AFP and IPDS output introduced in 2018.1 ... 91
Windows Server 2016 iSSUE ... 91
Limit of 100MB of image files within a single job ... ... . 91
Print Output: Booklet Impositioning changes introduced in 2018.1 ... 92
Installation Paths with Multi-Byte Characters ... ... ... .. 92
SWiItChiNg LanQuages ... 92
GoDaddy Certificates ... .. 93
My S QL Compatibility .. 93
Available Printer Models . . 93
Color Model in Style Sheets ... . 93
Image Preview in Designer . 93
VPP QU DU 93
Magic Number changes when installing Docker ... . .. .. . .. 94
UNINS alliNg .o L 94
Important Note: Stop any active Anti-Virus software before uninstalling Connect. ............ 94
Impacts upon other Applications and Services ... .. 95
Uninstallation Wizard ... 95
Connect: a peek underthe hood ... .. 96
The Connectdatabase ... .. 96
The File St0re 97
TNe ENQINES 97
Connect file QY PeS 98
The DeSIgN e 100
DeSIgNer DaSICS . 100
FeatUIeS 101
T emMPlateS 102
Page 5

PrintShop Mail Connect



SO I ONS 110
PNt 115
COPY Pt o 117
Creating a Printtemplate with a Wizard ... ... 117
Print CONM Xt L 123
PNt SECHONS 127
P g 137
MaS el Pages ... L 145
M Edia 148
Bl L 155
Designing an Email template .. ... 156
Creating an Email template with a Wizard ... . .. . . 160
Email CONteXt . 163
Email templates 166
Email header settings ... ..o 169
Email attachments 175
Content elements 179
Element types 179
Editing HT ML L 180
A DU S L 181
Inserting an element 182
Selecting an element . 183
Deleting an element L 184
Styling and formatting an element ... 184
B arCOUe 185
B OXES 237
BUSINESS GraphiCs ... 241
DAt 248
Hyperlink and mailto Nk ... 250
N AGES .o 252
T A e 260
Textand special characters ... . 264
SN PP S 266
Adding a snippetto the Resources ... ... 267
Adding a snippetto a section ... . 268
Creating @ SNiPPeT .o 268
Page 6

PrintShop Mail Connect



Editing @ SNIPPet . 268

Renaming a snipPet ..o 269
Translating a snipPPet .. . 269
Styling and formatting ... ... 270
Local formatting versus style sheets ... .. 270
LAy oUt PrOPEI S L 270
Styling templates with CS S files ... L 271
Styling text and paragraphs ... .. 281
How to position elements . 286
Rotating €lements 289
Styling atable . 290
StYliNG AN IMAQE . 294
Background color and/orimage ... 297
B OO L 299
COlOTS 301
O S 305
LOCalE . L 309
S PACING 310
Using a Sass file .. 311
Personalizing Content .. 312
Variable data ... 312
Conditional CoONteNt . 313
DYNaMIC IMaAGES ..o 313
SN PP S . 313
S I S 314
Loading data ... L 314
Variable Data .. 322
Formatting variable data ... ... .. . 328
Showing content conditionally ... ... 330
Conditional Print SeCtiONS ... 333
DYNaMIC IMaAGES ..o 334
P e el N CES L 336
COTG Servers preferenCes ..o 336
Clean-up Service preferenCes ... o 337
Database Connection preferences ... 341
DataMapper preferenCes ... . o 344
Editing preferenCes ..o L 345
Page 7

PrintShop Mail Connect



Email PreferenCe s 347

Emmet PreferenCes . 349
ENGINe SetUD 352
Language Setting Preferences ... .. ..o 352
Log Setting PreferencCes ... .. oo 353
Print PreferenCes . L 355
ProJeCt WizZards 357
SaVING PreferenCes ... 357
Scheduling PreferenCes .. ... L 358
Scripting PreferenCes ... 359
Writing YoUr OWN SCIIP S L. 360
S I P Y DS . 360
Creating a new Standard ScCript ... .. 362
WIHtING @ SCII Pt 364
ManNaging SCHIP S . 366
TeStiNG SO S 369
OptiMIZING SCIIPES 374
Loading a snippet via a SCript ... . 379
Loading contentusing a server's APl .. . 381
The script flow: When sCripts rUN . L 384
Selectors iN CONNECT L. 385
CONtrOl SO P S 390
Post Pagination SCripls ... . 405
Translating templates ... 412
Translating atemplate ... 413
Tagging elements for translation ... ... 414
PlUralization 417
Exporting and importing translation files ... ... 418
DesignerUser Interface ... ... 420
DHal0GS oo 421
Keyboard shorCULS .. . . 503
NS L 509
P AN S 519
T OO0 DAIS 539
W elCOME SO N 545
PNt QP ONS .. 546
JOb Creation Presets . . 632
Page 8

PrintShop Mail Connect



Output Creation Presets . oo 645

Page breakdoWn 667
Australia Post 4 State Settings ... .. ... 674
Codabar Settings ... ... 676
Code 128 Setting S ... o o 679
Code 39 SettiNg s ... oL 682
Datamatrix Settings ... . . 685
EAN-128 Settings ... o 687
EAN-13 Setting S o 690
EAN-8 Settings ... L 693
Interleaved 2 of 5 Settings ... .. .. 696
KIX Code (Dutch Post) Settings ... ... 698
Japan Post Settings ... ... 700
P47 Settings ... 702
QR Code Settings ... .. 705
Royal Mail 4 State Settings ... ... L 709
Royal Mail 2D Settings ... ... 711
UP C-A SettinNg s ... o 713
UPC-E Settings ... 716
US Postal Service IMB Settings ... .. L 719
US Postal Service IMPB Settings ... 722

Designer SCript AP L 748

Standard Script AP 749

EXAMD O 758

E XA S 759

E XA S 760

E XA S 763

EXamMPIeS 765

E XA S 766

EXaMIDl S 767

E XA S 768

EXaMDI S 769

E XA S 770

E XA S 771

Page 9

PrintShop Mail Connect



E XA S 771

E XA S 772

E XA e 773

E XA e L 773

E XA e L 774

B XA e 774
E XML 775

E XA S 777
Creating a table of contents ... ... 778

E XA e 779

E XA S 780

E XA S 782

E XA S 784

E XA S 784
Replace elements with a snippet ... 785
Replace elements with a set of snippets ... ... 785

E XA e 786

E XA e 787
Creating a Date objectfrom a string ... ... 796
CoNtrol SCript AP 811
E XA S 827
Post Pagination Script AP . L 838
Setting the margins of a Print section ... .. 854
Setting the header and footer of a MasterPage ... . 854
Generating QU PUL .. 856
PNt QU UL L 856
Email QU DU 857
Generating Print OUtpUL L 857
Print settings in atemplate ... 859
Aborting content creation ... .. 859
Print Using Standard Print Output Settings ... . 860
Print Using Advanced Printer Wizard ... . . . 861
Adding print output Models to the Print Wizard ... ... .. .. 862
Splitting printing into more than one file ... ... 864
Print output variables .. 864
Generating Email OUlpUL . 873
Email output settings in the Email context and sections ... 874

Page 10

PrintShop Mail Connect



Aborting content creation ... . 876

Using an ESP with PrintShop Mail Connect ... .. . . . 876
Optimizing atemplate ... 881
S TIPS 882
NG L 882
Print Manager 884
Print Manager Introduction Video ... .. 884
Print Manager USage ... .o 884
Print Manager Interface ... ... 885
MENU OPtONS 885
PN ErS PANE 886
Printer QUEUE PaNE .. 893
JOb QUEUE PaNE 902
MEeSSagES PaANE . 904
JOb HistOry pane .. 905
Printer Capabilities pane ... 906
Printer Status Pane ... 907
Print Manager PreferencCes .. .. 908
License Update Required for Upgrade to Connect 2019.1 ... ... ... ... 917
OV IV W 918
OL Connect 2019.1 Enhancements ... . 919
SCript DeUGG e 919
Improved Data Model VieW ... 920
New Translation feature .. .. 921
Installer ImpProvemMeNntS . 922
Print Manager Improvements . 922
Connect 2019.1 Designer Updates ... ... 923
Scripting IMpProVemMEN S 923
Barcode Improvement S 924
General Designer Improvements and Fixes ... ... 925
Connect 2019.1 Output updates ... .. .. 926
Fonthandling ..o oL 926
Print Output Improvements .. L 926
General Output Improvements .. 930
Print Wizard and Preset Wizard Improvements ... ... 931
Dynamic Print Control Improvements ... . .. 931
Import MuUtiple Presets L 932
Page 11

PrintShop Mail Connect



Improved Data Filtering Oplions ... . 932

General Print Wizard Improvements ... 934
KNOWN ISSUCS . 935
PreVioUS RelIEaASES .. 935

OV IV W 935

Connect 2018.2.1 Enhancements/FiXes .. ... ... 937

Connect 2019.1 ENhancements .. 938

Connect 2019.1 DesignerUpdates ... ... 942

Connect 2019.1 Output updates ... . 951

Print Wizard and Preset Wizard Improvements ... ... . 955

Connect 2019.1 Print Manager updates ... .. .. .. ... 961

KN OWN S S UGBS e 961

OV IV W 962

Connect 2018.1.6 Enhancements/FiXes .. ... ... 963

Connect 2018.1.5 Enhancements/FiXes .. ... ... 964

Connect 2018.1.4 Enhancements/FiXes .. ... 964

Connect 2018.1.3 Enhancements/FiXes .. ... ... 964

Connect 2018.1.2 Enhancements/FiXes .. ... 964

Connect 2018.1.1 Enhancements/FiXes ... ... 965

Connect 2018.1 General Enhancements ... . 966

Connect 2018.1 Designer Enhancements/Fixes ... 974

Connect 2018.1 Output Enhancements/FiXes ... ... 981

Connect 2018.1 Print Manager Enhancements/Fixes ... . 984

KN OWN IS SUBS e 985

OV IV W 985

Connect 1.8 General Enhancements and Fixes ... ... . 988

Connect 1.8 Performance Related Enhancements and Fixes .................................... 992

Connect 1.8 Designer Enhancements and Fixes ... ... ... ... 993

Connect 1.8 Output Enhancements and Fixes ... 997

Connect 1.8 Print Manager Enhancements and Fixes ... 1003

KNOWN IS SUBS . 1004

OV IV W 1005

Connect 1.7.1 General Enhancements and Fixes ... . ... . 1006

Connect 1.7.1 Designer Enhancements and Fixes ... ... ... ... 1010

Connect 1.7.1 Output Enhancements and Fixes ... ... . 1018

KN OWN S SUBS 1025

OV IV W 1026

Page 12

PrintShop Mail Connect



Connect 1.6.1 General Enhancements and Fixes ... .. . 1028

Connect 1.6.1 Designer Enhancements and Fixes ... ... ... ... 1030
Connect 1.6.1 Output Enhancements and Fixes ... . 1031

KN OWN S S UGBS 1033
OV IV W 1034
Connect 1.5 Designer Enhancements and Fixes ... ... 1035
Connect 1.5 Output Enhancements and Fixes ... ... 1038
Connect 1.5 General Enhancements and Fixes ... ... 1039

KN OWN IS SUBS . 1040

OV IV W 1041
Connect 1.4.2 Enhancements and FiXes ... . L 1042
Connect 1.4.1 New Features and Enhancements ... ... 1042
Connect 1.4.1 Designer Enhancements and Fixes ... . 1044
Connect 1.4.1 Output Enhancements and Fixes ..., 1045
KNOWN IS SUBS .o 1046
Knowledge Base ... ... 1049
Legal Notices and Acknowledgements ... ... ... . . ... 1050
Copyright Information . L 1055

Page 13

PrintShop Mail Connect



Welcome to PrintShop Mail Connect
2019.1

Note

Since we are always looking for new ways to make your life easier, we welcome your
questions and comments about our products and documentation. Use the feedback tool
at the bottom of the page or shoot us an email at doc@ca.objectiflune.com.

PrintShop Mail Connectis a tool designed to optimize customer communications. Itis designed
to improve the creation, distribution, interaction and maintenance of your communications.

The PrintShop Mail Connect Designer is designed to create output for print and email within a
single template and from many data types. Output presets applied outside the design phase
make templates printing device independent.

The Designer has an easy-to-use interface that makes it possible for almost anyone to create
multi-channel output. More advanced users may use native HTML, CSS and JavaScript.

This online documentation covers PrintShop Mail Connect version 2019.1.
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Setup And Configuration

This chapter describes the PrintShop Mail Connectinstallation and the different considerations
that are important in regards to the installation and use of PrintShop Mail Connect.

» "System and Hardware Considerations" below

"Installation and Activation" on page 34

"Known Issues" on page 86

« "Engine configuration" on page 26

System and Hardware Considerations

There are a variety of considerations to be aware of. These are documented in the following
pages:

« "System requirements" on page 31

« "Database Considerations" on page 17

« "Environment considerations" on page 22

« "Known Issues" on page 86

« "Language and Encoding Considerations" on page 24
« "Antivirus Exclusions" on the facing page

« "Performance Considerations" on page 29
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Antivirus Exclusions

Article #: Product: Version:
INFO-0002A PrintShop Mail Connect 1.5 and up
Description

The information on this page is designed to assist IT managers and IT professionals decide
what anti-virus strategy to follow with consideration to OL Connect and their internal
requirements and needs. This page describes the mode of operation and the files and folders
used by OL Connect as well as the files, folders and executables that are recommended to be
ignored for best possible performance and to avoid issues caused by antivirus file locks.

IT managers and IT professionals then may decide the anti-virus strategy to follow for their
internal requirements and needs depending on the statements outlined herein.

Directories and folders

Main installation folder

All Connect applications are installed under an arbitrarily selectable main folder. We will speak
of the "Installation Target" in the following. This installation target will hold the executables and
required files and folders for the operation of the whole product suite. All these files and folders
are static after their installation. It depends on the company virus protection strategy, if such
files and folders will be monitored or not. A virus protection on these files and folders should,
however, not have a big — if even any — impact on the performance of the Connect suite.

With some exceptions, which are listed below.

Working folders

Working folders for Connect are created and used on a per-user-basis under the respective
user's profile folder, accessible on Windows with the standardized system variable
%USERPROFILE% in the subfolder "Connect". Working folders are:

« %USERPROFILE%\Connectifilestore: This folder will hold non-intermediate files for the
operation of Connect. Files in this folder will be used frequently, but not with a high
frequency. Supervising this folder with a virus protection system should not have too
much of an impact on the speed of the whole Connect suite.
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« %USERPROFILE%\Connect\logs: As the name implies, log files are created and
updated here. These log files are plain text files. Virus protection may have an impact on
the speed of the whole Connect suite.

« %USERPROFILE%\Connect\temp: Storage folder for temporary data, usually
intermittent files in multiple folders. Virus protection on this folder and its subfolders may
have a serious impact on the performance of Connect.

« %USERPROFILE%\Connect\workspace: Usually containing settings and helper files
and folders. Supervising this folder with a virus protection system should not have too
much of an impact on the speed of the whole Connect suite.

Database 1

Depending on the components installed, a database instance is created in a folder called
"connect.database" under the Windows system temp folder.. This folder is accessible via the
standardized system variable % TMP%. Usually, folders holding such temporary files and
folders should be excluded from a virus protection, because this influences the overall
performance of the whole system at all. However the responsible person for the computer
protection has to decide about the monitoring of such temporary folders following the company
guidelines.

Database 2

Another database instance for Connect will be hold and used under the folder, which is
intended to hold data, accessible by and for all users. The path to this folder is stored in the
standardized system variable %PROGRAMDATA%. The Connect database instance is located
in the subfolder "Connect\MySQL".

As this database will be in extremely strong usage, virus protection on this folder and its sub-
folders may have a serious impact on the performance of Connect.

Database Considerations

This page describes the different considerations and pre-requisites for the database back-end
used by PrintShop Mail Connect, whether using the MySQL instance provided by the installer,
or pre-existing (external) instance.
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Using the MySQL Instance from the Installer

The MySQL Instance provided in the Installation Wizard is already pre-configured with options
to provide the most stable back-end setup.

These are the specific options that have been changed in our version of "my.ini":

« max_connections =200 : PrintShop Mail Connect uses a /ot of database connections.
This number ensures that even in high volume environments, enough connections will be
available.

« max_allowed_packet = 500M : In some implementations, especially when using Capture
OnTheGo, large packet sizes are required to allow transferring binary files. This
substantial packet size maximum setting ensures that the data received by PrintShop Mail
Connect will be able to be stored within the database.

« character-set-server = utf8 , collation-server = utf8_unicode_ci, default-character-
set=utf8 : These indicate database support for UTF-8/Unicode.

Installing / Updating Connect using an existing MySQL instance

If MySQL Server is already present and you wish to use it, the following should be taken into
consideration:

o The minimum supported MySQL version is 5.1.31.

« The MySQL account must have access to all permissions using the GRANT Command,
including creating databases.

« The database configuration must include the options detailed in the "Using the MySQL
Instance from the Installer" above topic above.

» The database configuration must allow the use of mixed case table names.
This is particularly an issue on Linux MySQL installations.

o The SQL instance must be open to access from other computers. This means the bind-
address option should not be setto 127.0.0.1 or localhost.

Warning

If you chose not to install the supplied MySQL database, and instead opt for using a pre-
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existing (External) database then you yourself must ensure that the External database is
accessible to Connect.

Objectif Lune Inc. will take no responsibility for database connections to any but the
supplied MySQL database.

Options available within the installer:

« The Configuration page for the local MySQL is displayed.

o MySQL settings are pre-filled with default values if no existing MySQL database
configuration is found.

« MySQL settings are pre-filled with existing database configuration settings, if they point to
a MySQL database type.

Installing Connect using an existing Microsoft SQL Server instance

If Microsoft SQL Server is already present and you wish to use it, the following should be taken
into consideration:

Warning

If you chose not to install the supplied MySQL database, and instead opt for using a pre-

existing (External) database then you yourself must ensure that the External database is
accessible to Connect.

Objectif Lune Inc. will take no responsibility for database connections to any but the
supplied MySQL database.

Note

Since PrintShop Mail Connect version 1.6 the minimum required version of the MS SQL
Serveris SQL Server 2012.
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« When MS SQL is selected, the default values for root user are sa and 1433 for the port.

. If database settings from a previous OL Connect installation are found, the pre-exising
settings will be displayed for the matching database type. For MS SQL settings, this will
only work if they were created with Server Config Tool 1.5.0 or later, or the Installer for
OL Connect 1.6.0 or later.

If the database type is changed in the Installer configuration page, the default values for
this database type will be displayed.

If the pre-existing database settings are set to Hsqgldb, the default database type selection
will be MySQL.

« Selected database settings are stored in the preferences, and can be found in this file:
C:\ProgramData\Objectif Lune\OL
Connect\.settings\ConnectHostScope\com.objectiflune.repository.eclipselink.generic.pref
S

Updating With No Local MySQL Product

o When updating a Connect installation from 1.5.0 which contains a Server Product but no
local MySQL Product, the Database Configuration Page will detect which database type
was set before (especially if the database configuration was switched from MySQL to MS
SQL using the Server Configuration Tool), and default to those settings.

« On Update from 1.4.2 or earlier, the Database Configuration Page will always default to
MySQL connection settings, and if the installation was manually tweaked to connect to
MS SQL Server, the user has to switch to "Microsoft SQL Server" type and enter
connection details again.

When modifying Connect

« Iflocal MySQL is removed from an installation, the Database Configuration page will offer
additionally the Microsoft SQL Server database type with respective default values.

« Iflocal MySQL is added to an installation, the usual MySQL Configuration page with
default values will be displayed.

If the user has installed the Installer Supplied MySQL and then switches to an external
Microsoft SQL by using the Server Configuration Tool, the supplied MySQL cannot be switched
off. By design the installer adds a service dependency between Connect Server and the
supplied MySQL service.
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Note

The Microsoft SQL selection capability will be available only with 1.6 version and
upwards.

To remove this dependency the user needs to do the following

1. Have a foreign Microsoft SQL running, ready for use with Connect Server.

N

Use the Server Configuration Tool "Database Connection preferences" on page 341 to
switch the database to Microsoft SQL.

Re-start the Connect Server Service, so that the modifications become active.
Counter check that everything is working properly with Microsoft SQL.

Open a command-line prompt with full administration rights.

o a kW

Enter the command sc config OLConnect Server depend= /. Thisremoves the
dependency.

Please be aware: The key word depend must be followed immediately by the equal sign,
but between the equal sign and the forward slash there must be a space.

Additional information can be found here: http://serverfault.com/questions/24821/how-
to-add-dependency-on-a-windows-service-after-the-service-is-installed#228326.

7. After the dependency has been removed, it is possible to stop the supplied MySQL
service (OLConnect_MySQL).

Warning
If a Connect 1.5 user wants to use Microsoft SQL instead of MySQL for the Connect Server,

there are several points to be taken care of. These are:

« Ifa MySQL instance exists which could be used intermediately, then this should be
selected during the setup. This ensures, that nothing gets installed. Otherwise the
supplied MySQL needs to be installed and the switch to Microsoft SQL needs to be
done as outlined above.

« ltis not possible to uninstall the supplied MySQL hereafter, when running the
Connect 1.5 Installer in Modify mode.
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Important

If a Server Product and a MySQL Product were selected to be installed on Connect 1.5.0, and
then the Server Configuration Tool is used to switch the database used by the Server to an
external Microsoft SQL, then the Update to 1.6 requires an extra step. The procedure is as
follows:

1. Run the Update to Connect 1.6. This will assume the local MySQL database needs to
be updated and configured, so the user has to enter a root password on the MySQL
Configuration Page (can be any password matching Connect security rules).

2. After the update, the Connect 1.6 Setup needs to be run once more to modify Connect.
3. On the Product Selection page, now the MySQL product can be unselected.

4. When stepping forward in the Wizard, the Database Configuration page will be displayed
which allows to configure the Microsoft SQL Server with appropriate settings.

After this modification, the local MySQL is removed, and also the service dependency from
Server to MySQL is removed.

Note

If Connect was initially installed not containing the local MySQL product (i.e. on 1.5
installation an external MySQL was configured as database), then the Update to 1.6 will
allow to select either external MySQL or external Microsoft SQL on the Database

Configuration Page.

Environment considerations

Terminal Server/Service Support

PrintShop Mail Connect does not support Terminal Server (or Terminal Service) environment
as possible under Windows 2000, 2003 and 2008. This is to say, if Terminal Service is
installed on the server where PrintShop Mail Connectis located, unexpected behaviours may
occur and will not be supported by Objectif Lune Inc.. Furthermore, using PrintShop Mail
Connectin a Terminal Service environment is an infringement of our End-User License

Agreement.

Virtual Machine Support

PrintShop Mail Connect supports the following virtual environments:
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o VMWare Environments. This includes VMWare Player, VMWare Workstation as well as
VMWare ESX Server.

« VMWare VMotion. This means the virtual machine hosting PrintShop Mail Connect can
be automatically moved from one ESX server to another in a clustered installation.

o Microsoft Hyper-V/Azure infrastructure environments.

PrintShop Mail Connectis not officially supported on any other virtual machines such as Virtual
PC, Parallels, Bochs, Xen, etc.

Warning

Copying (duplicating) a Virtual Machine with Connect installed and using both images
simultaneously constitutes an infringement of our End-User License Agreement.

Note

While some virtual machine environments (from VMWare and Microsoft) are supported,
other virtual environments (such as Parallels, Xen and others) are not supported at this
time.

Remote Desktop Support

Tests have demonstrated that PrintShop Mail Connect can be used through Remote Desktop. It
is however possible that certain combination of OS could cause issues. If problems are
encountered, please contact OL Support and we will investigate.

PrintShop Mail Connect 1.3 and later have been certified under Remote Desktop.

32-bit or 64-bit Operating Systems?

PrintShop Mail Connectis a 64-bit software and can only be installed on 64-bit operating
systems.

Antivirus Considerations

« Antivirus software may slow down processing or cause issues if they are scanning in
temporary folders or those used by PrintShop Mail Connect. Please see Antivirus
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Exclusion for more information.

« Antivirus software might interfere with installation scripts, notably a vbs script to install
fonts. McAfee, in particular, should be disabled temporarily during installation in order for
MICR fonts to install and the installation to complete successfully.

Windows Search Indexing Service

Tests have concluded that the Windows Search service, used to provide indexing for Windows
Search, can interfere with Connect when installing on a virtual machine. If the installation
hangs during the last steps, it is necessary to completely disable this service during installation.

o Click on Start, Run.

Type in services.msc and click OK.

Locate the Windows Search service and double-click onit.

Change the Startup Type to Disable, and click Stop to stop the service.

Try the installation again.

Once completely, you may re-enable the service and start it.

Commandline switches and .ini entries

PrintShop Mail Connectis intended to work stably and reliably, based on Java and the Eclipse
framework. To ensure this reliability and robustness, many Java and Eclipse parameters have
been tested and tuned, which is reflected in the respective .ini entries and the used command
line switches. A collection of valuable settings has been elaborated and found its entry in
PrintShop Mail Connect “good switches list” (called the “whitelist”).

The protection of the end user’s system is one of our main goals and therefore we have
implemented a very strict verification mechanism, which ensures, that only these whitelisted ini
entries and command-line switches are accepted, when one of Connect components is started
and run. Please be therefore advised, that any non-whitelisted ini entry or command-line switch
will be accepted and will - if tried to be used - lead to the respective application’s “sudden
death”. If you should encounter such a behaviour then please double-check your Connect log
file/s for respective entries.

Language and Encoding Considerations

Please note the following considerations:

Page 24

PrintShop Mail Connect



« Language:

« PrintShop Mail Connect is currently offered in several languages. These languages
can be switch between via the Preferences dialog. The current languages include:

« English

« French

o German

o Spanish

« ltalian

« Korean

« Portuguese

o Chinese (Simplified)
o Chinese (Traditional)
« Japanese.

The defaultlanguage is English.
The PrintShop Mail Connect help system (this document) is currently only available
in English.
« Encoding:
« Issues can sometimes be encountered in menus and templates when running

PrintShop Mail Connect on a non-English operating system. These are due to
encoding issues and will be addressed in a later release.

Network Considerations

The following should be taken into consideration in regards to network settings and
communications

« Ifalocal proxy is configured (in the Internet Explorer Options dialog), the option
Bypass proxy server for local addresses must be checked, or some features
depending on local communication will not work.

Firewall/Port considerations

For Firewall/Port considerations, please see this article in the Knowledge Base: Connect
Firewall/Port Configuration
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Engine configuration

The Designer cooperates with different engines to handle specific tasks. A Merge engine
merges the template and the data to create Email output, or to create an intermediary file for
Printed output. The intermediary file is in turn used by a Weaver engine to prepare the Print
output. (For more information see: "Connect: a peek under the hood" on page 96).

Settings for these engines are made in the Scheduling Preferences (Window > Preferences >
Scheduling). This topic explains the principles behind these settings and provides guidelines
for configuring the engines in such a way as to achieve the highest possible output speeds.

Tip
Other ways to enhance performance are explained in another topic: "Performance Considerations"
on page 29.

Speed quota: ppm and speed units

The highest possible output speed depends first and foremost on your licence.

With no Performance Pack, PrintShop Mail Connect can generate output at 250 ppm (pages,
and/or emails, per minute) for Subscription licence, or 1000ppm for Perpetual licence.
Additional Performance Packs increase this quota.

The number of engines that are allowed to operate in parallel to create the same type of output
are referred to as speed units. PrintShop Mail Connect provides 1 speed unit (with both
licence types).

It is important to note that only output operations are limited by this quota.

« The Weaver engine always requires a speed unit to run.
e A Merge engine only requires a speed unit when creating Email output.

« The Datamapper engine doesn't need a speed unit.
Merge engines involved in a Print operation don't need a speed unitin order to run. Itis therefor

possible to launch multiple Merge engines, which in most situations increases PrintShop Mail
Connect's performance.
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Number of Merge engines

When first installed, PrintShop Mail Connect is configured to use 1 Merge engine. A Merge
engine will run mostly single-threaded. To benefit from modern multi-core systems it is
recommended that several Merge engines run in parallel.

As a rule of thumb, you will want to run as many Merge engines as the system has cores. The
print statistics message dialog shows both the number of Merge engines and cores. However,
modern hardware typically has both full cores and hyper-threading or logical cores. Both are
counted as cores in this dialog, but the logical cores should not be counted as a full core when
determining how many Merge engines to use. As a guide, count logical cores for only 25%-50%
of a full core.

For example: on an Intel i7 CPU that comes with 4 cores and 4 additional hyper-threading
cores, Windows Task Manager will show 4 cores and 8 logical processors on its performance
tab. On a CPU like this, 5 or 6 Merge engines can be configured to run in parallel.

Itis advised that you do not configure more engines than can be backed by actual processing
power . This adds overhead while not adding processing power.

To configure the number of Merge engines:

1. Select Window > Preferences... from the menu; under Scheduling, select Scheduling -
Merge engine.

2. SetLocal engines launched to a number appropriate for your system.

3. Initially, you can set Parallel engines per job to the same number as the Local engines
launched, for both medium and large jobs (see "Job size limits" on the facing page,
below).

4. Always set Maximum concurrent engines per type to the same number as the Local
engines launched, for both medium and large jobs.

5. Click OK or Apply.

Note

Since PrintShopMail Connect can only handle one job at a time, it isn't useful to make any 'engine
reservations'. Reserved engines cannot be used by jobs of another type. All Merge engines should
be "floating".

Page 27

PrintShop Mail Connect



Job size limits

Job size is a relative concept. In a small service company a job may be considered large when
it counts 1,000 records, whereas in an insurance company the same job may be seen as small.
PrintShop Mail Connectlets you define job sizes by setting the maximum number of records in
a small job, and the minimum number of records in a large job. Jobs that are neither small nor
large are medium sized. (Note that the term 'records’ refers to top-level records only. Detail
records are not considered.) These job size limits could have an impact on performance.

« Small jobs always get just one engine. Do not set the limit for small jobs too high; small
jobs should be easily handled by one engine.

« The number of engines used for medium and large jobs is configurable.

Which job size limits are ideal in your setup can't be said beforehand. It requires testing to find
the minimum and maximum number of records in jobs that benefit from running with more than
one Merge engine. Take into account that jobs with fewer records could actually be medium or
large if each individual record outputs 10,000 pages.

« To setthe job size limits, select Window > Preferences... from the menu; then go to
Scheduling.

« Under Scheduling - Merge engine you can set the number of Parellel engines per job
for medium and large jobs.

Example

Testing may reveal that jobs between 50 and 250 records benefit from running with 2 Merge
engines, but that running those jobs with more Merge engines doesn't result in higher output
speeds or even takes a bit longer.

In this case, the maximum number of records in a small job should be set to 50; the minimum
number of records in a large job could be set to 250. Subsequently, the Parallel engines per job
setting could be set to 2 for medium jobs, and for large jobs it should be set to the maximum
number of Merge engines available.

Memory per engine

As explained above, PrintShop Mail Connect can be configured to use multiple Merge engines.
By default, each Merge engine, as well as the Datamapper engine and Weaver engine, is set to
use 640MB of RAM. To make optimum use of the machine's capabilities it might be useful to
increase the amount of memory that an engine can use.
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« For complex templates with a lot of pages per document, there is a chance that the Merge
engines will run better with more memory.

« For jobs with heavy graphics, jobs that use Cut & Stack impositioning and jobs that use
particular variables that entail page buffering (see "Content variables" on page 868), the
maximum memory usage of the Weaver engine can be relevant.

The Maximum memory per engine setting is found in the scheduling preferences of each
engine type; see Merge Engine Scheduling and Weaver Engine Scheduling.

Performance Considerations

This page is a guide to getting the most performance out of PrintShop Mail Connect as well as
a rough guideline to indicate when it's best to upgrade.

Performance analysis details

In PrintShop Mail Connect, after each print job, a message dialog displays a print job summary
(see "Print Job Summary dialog" on page 469). This summary may help you determine how
best to maximize the performance of PrintShop Mail Connect.

With no Performance Pack, PrintShop Mail Connect's Weaver engine can generate output at
250 ppm (pages, or emails) per minute) for Subscription licence, or 1000ppm for Perpetual
licence. Additional Performance Packs increase this quota.

If your print jobs are not running at the licensed speed, there may be several ways to improve
the performance, as described below. Note however that it is not guaranteed that the licensed
speed can be achieved with any job. Creating output for templates with very complex scripts or
complex graphics resources will take a certain amount of time, even on high-end hardware.

If your print jobs are running at the licensed speed, then improving performance will require
purchasing either a Performance Pack or upgrading to PlanetPress or PReS Connect (see
Performance Packs). For advice please contact your local sales office (see Objectif Lune's
Contact page).

Engine configuration

A Merge engine merges the template and the data to create Email output, or to create an
intermediary file for Printed output. The intermediary file is in turn used by a Weaver engine to
prepare the Print output.
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Configuring these engines to match the hardware configuration is probably the fastest and most
effective way to improve Connect's performance. See "Engine configuration" on page 26.

« Number of Merge engines. When first installed, PrintShop Mail Connectis configured to
use 1 Merge engine. A Merge engine will run mostly single-threaded. To benefit from
modern multi-core systems it is recommended to run several Merge engines in parallel.
See "Number of Merge engines" on page 27.

« Job size limits. PrintShop Mail Connect lets you define job sizes by setting the maximum
number of records in a small job, and the minimum number of records in a large job. Jobs
that are neither small nor large are medium sized. Job size limits could have an impact on
performance. See "Job size limits" on page 28.

« Memory per engine. To make optimum use of the machine's capabilities it might be
useful to increase the amount of memory that an engine can use. See "Memory per
engine" on page 28.

Template optimization

When you find that the speed per Merge engine - the Content Creation speed - is low,
optimizing a template can make a huge difference. For advice on how to optimize a template
see: "Optimizing a template" on page 881.

Network and internet connections

Use a fast network and internet connection or avoid loading external or internet resources.
Using images, JavaScript or CSS resources located on a slow network or on a slow internet
connection will obviously lead to a loss of speed. While we do our best for caching, a document
with 5,000 records which queries a page that takes 1 second to return a different image each
time will, naturally, slow output generation down by up to 83 minutes.

Hardware configuration

When processing speed is important, the following is suggested before looking into
Performance Packs to enhance performance (and after addressing the other issues mentioned
in this topic).

« Antivirus exclusions. Sometimes, virus scanners, other security software or indexing
services can interfere. It can help to disable those kinds of tools for the areas where

Connect stores intermediate files. You could exclude the entire
C:\Users\<connectuser>\Connect folder. See also: Antivirus Exclusions .
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« Use a high-performance, low-latency hard drive. Connect benefits from fast I/O.
Preferably use a Solid State Drive (SSD) or similar for storage.

o Use atleast 8+ GB High-Quality RAM. Check memory usage while the Print command is
being executed to see if you need more than the minimum of 8GB. Assuming that the
Designer needs 1GB each, and that each engine needs 1GB as well, you can roughly
estimate how much memory is needed.

« Consider using a physical machine instead of a virtual machine. When running on a
Virtual Machine, the machine may report that it has sufficient hardware (cores) available,
but in a virtual environment you need to make sure that this hardware is not being shared
with lots of other virtual machines.

« Consider using hardware with more physical cores. PrintShop Mail Connect doesn't limit
the number of Merge engines that is used for a Print job, so if the number of physical
cores is low, it makes sense to see if that can be increased. When running on a virtual
machine, this is usually easy. When running on a physical machine, it means that you
may have to switch hardware.

« Forboth virtual and non-virtual environments, make sure the machine is not busy with all
kinds of other processes.

System requirements

These are the system requirements for PrintShop Mail Connect 2019.1
Operating system (64-bit only)

« Microsoft Windows 2008 R2 Server

o Microsoft Windows 2012/2012 R2 Server
« Microsoft Windows 2016 Server

o Windows 7

« Microsoft Windows 8.1

« Microsoft Windows 10 (Pro and Enterprise versions only)

Note

Windows Vista, Windows 8.0, Windows 2003 Server and earlier versions of Windows are
not supported by OL Connect products.

Page 31

PrintShop Mail Connect



Virtual Environments

o VMWare/VSphere

« Hyper-V

o Azure

« Amazon Web Services (AWS)

Minimum hardware requirements

As with any software application, minimum hardware requirements represent the most basic
hardware on which the software will run. Note however that settling for the minimum
specification is unlikely to produce the performance you expect from the system. It can be used
when configuring a trial or a development system, however.

File system: NTFS (FAT32 is not supported)

o CPU: multi-core

« RAM: 6GB

« Disk Space: 4GB for the software modules, 5GB for work files*1

*1: depends on the amount of data you process through OL Connect. For instance, a PostScript
file containing several thousands of documents could easily take up several GBs.

Recommended hardware requirements

Due to its versatility, OL Connect is used for a wide variety of applications. Consequently, itis
difficult to determine which hardware configuration will produce the best results for any given
implementation. The following specs should therefore be viewed as a general guideline thatis
most likely to produce expected results for most implementations. You should, however, keep
in mind that it may not represent the optimal setup for your particular application.

For more information and tips about performance considerations, see "Performance
Considerations" on page 29.

File system: NTFS (FAT32 is not supported)

o CPU: Intel Core i7-4770 Haswell or equivalent

- RAM: 16GB

Disk Space: 4GB for the software modules, 20GB for work files*1

Page 32

PrintShop Mail Connect



« Storage Type: Solid State Drive (SSD)
« Networking: 10Gb Ethernet

*1: depends on the amount of data you process through OL Connect. For instance, a PostScript
file containing several thousands of documents could easily take up several GBs.

Requirements for individual Connect modules

OL Connect Products comprises multiple modules that can be operated separately on multiple
PCs. Each module has its own set of requirements that may differ from the other modules.
While the hardware requirements described above are relatively generic when installing all
Connect modules on a single server, they should not be interpreted literally for each individual
module.

When installing on multiple PCs, keep the following rules of thumb in mind:

o The Connect Workflow module requires less RAM but fast hard drive access. It also
benefits from fast multi-core CPUs, in order to run processes in parallel.

o The Connect Server module requires more RAM and benefits from fast multi-core CPUs.
Disk access speed is less of a concern.

o The Connect Designer module requires more RAM and fast disk access to provide a
responsive user-experience.

« The back-end database (MySQL by default) benefits from more RAM, speedy disk access
and fast networking as it will be solicited by all modules simultaneously.

Editions of Connect Products

There are three editions of OL Connect: PrintShop Mail Connect, PlanetPress Connect and
PReS Connect.

While all three editions share common modules, they are generally not used for the same
purposes. Technically speaking, their hardware requirements would therefore be the same but
in practice, PReS Connectis likely to require higher-end hardware while PrintShop Mail
Connect will generally require less power to achieve expected results.

Note

As with any JAV A application, the more RAM available, the faster PrintShop Mail Connect will
execute.
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Installation and Activation

This topic provides detailed information about the installation and activation of PrintShop Mail
Connect 2019.1.

Note

A PDF version of this guide is available for use in offline installations. Click here to
download it.

Where to obtain the installers

The installers for PrintShop Mail Connect 2019.1 can be obtained on DVD or downloaded as
follows:

« If you are a Customer, the installers can be downloaded from the Objectif Lune Web
Activation Manager or through the OL Update Client ifitis activated.

« Ifyou are a Reseller, the installers can be downloaded from the Objectif Lune Partner
Portal site or through the OL Update Client if it is activated.

Installation - important information

For important information about the Installation, including requirements and best practices,
please see the following topics:

o Installation Prerequisites

o User accounts and security

Migrating to a new computer

« "Upgrading from previous Connect Versions" on page 83

Installation - "How to" guides

For information on how to conduct the installation itself, chose from the following topics:
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o Installation

« Silent Installation

« Installation on machines without Internet access

Activation

For information on licensing, please see Activating your license.

Installation Prerequisites

« Make sure your system meets the System requirements.

o PrintShop Mail Connect Version 2019.1 can be installed under a regular user account
with Administrator privileges.

e PrintShop Mail Connect must be installed on an NTFS file system.

o PrintShop Mail Connect requires Microsoft .NET Framework 4.5 already be installed on
the target system.

o Connect 2019.1 requires updated Connect License and/or Update Client.
See "Upgrading from previous Connect Versions" on page 83 for details.

User accounts and security

Connect generally requires only standard Windows user credentials to run, but does require a
user with local Windows Administrator when installing the software and when activating the
software license. This is to allow read/write access to protected Windows folders and registry
entries.

The following links contain the details as to when and where Windows Administrator rights are
required:

« Connect Installation: Connect Installation

« Activating Connect: Activating a License

Permissions for PrintShop Mail Connect Designer

PrintShop Mail Connect Designer does not require any special permissions to run besides that
of a regular program. It does not require administrative rights and only needs permission to
read/write in any folder where templates are located.
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If generating Print output, PrintShop Mail Connect Designer requires permission on the printer
or printer queue to send files.

Installing PrintShop Mail Connect on Machines without
Internet Access

Installing PrintShop Mail Connect2019.1 in offline mode requires some extra steps. These are
listed below.

Updating Connect

Updating to Connect 2019.1 from earlier Connect version

In order to update PrintShop Mail Connectto 2019.1 itis first necessary to update the Connect
License.

For details on how to upgrade the Connect License offline see the Upgrading Connect on
machines with no internet access section in the Update Client 1.2.40 Upgrade Guide.

Initial Connect Installation

GoDaddy Root Certificate Authority needs to be installed

In order to install PrintShop Mail Connect it is necessary for the GoDaddy Root Certificate
Authority to be installed (G2 Certificate) on the host machine and for this to be verified online.
When a machine hosting the installation does not have access to the Internet, the installation
will fail because the verification cannot be performed. To solve this problem one must first
ensure that all Windows updates have been installed on the host machine. Once the Windows
updates are confirmed as being up to date, then complete the following steps:

1. Go to https://certs.godaddy.com/repository and download the following two certificates to
copy to the offline machine:

« GoDaddy Class 2 Certification Authority Root Certificate - G2 - the file is gdroot-
g2.crt

« GoDaddy Secure Server Certificate (Intermediate Certificate) - G2 - the file is
gdig2.crt

2. Install the certificates: Right mouse click -> Install Certificate, and follow the steps through
the subsequent wizard.
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3. Now copy the PrintShop Mail Connect installer to the offline machine and start the
installation as normal

Windows certificate validation - Certificate Revocation List retrieval should be switched
off

For your security Objectif Lune digitally signs all relevant files with our own name and
certificate. The integrity of these files is checked at various times by different, context related,
methods. One of these checks, done during the installation process, uses the Windows
certificate validation check. .

The Windows certificate validation process not only checks the integrity of a file against its
signature, but also usually checks if the certificate itself is still valid. That check is done against
the current Certificate Revocation List (CRL), which needs to be retrieved from the internet.
However, if the machine in question does not have internet access, the retrieval of the CRL
must fail, which will lead to subsequent validation issues.

To circumvent such issues it is highly recommended to switch off the CRL retrieval prior to
installing Connect on machines without internet access. There is no security risk associated
with this, as the CRLs would never be retrievable without internet access, anyway. Advantage
of the switch will not only be found during the installation and operation of Connect, but also in
some speed improvements for any application which use signed binaries.

To switch off CRL retrieval on the computer, complete the following steps:

Open the “Internet Options” via the Control Panel

. Select the “Advanced” tab and scroll down to “Security” node.

. Click the OK button to close the dialog.

1.
2
3. Uncheck the entry “Check for publisher’s certificate revocation” under that node.
4
5. Re-start the computer.

Installation Wizard

Updating to Connect 2019.1 from earlier Connect version

In order to update PrintShop Mail Connectto 2019.1 itis first necessary to update the Connect
License.

For details on how to upgrade the Connect License see "Users of Connect prior to 2019.1" on
page 83
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Starting the PrintShop Mail Connect installer

The PrintShop Mail Connect installer may be supplied as an ISO image or on a DVD.

« Ifan ISO image, you can choose between the following, depending upon your Operating
System and the choices available:

1. Burn the ISO image onto a DVD
2. Un-zip the contents to a folder (keeping the internal folder structure intact)
3. Mount the ISO image from within Windows Explorer

» Ifona DVD, eitherinsert the DVD and initiate the installation from there or copy the
contents to a folder on the target computer (keeping the folder structure intact)

Navigate to the PrintShop Mail_Connect_Setup_x64.exe and double-click on it. After a short
pause the Setup Wizard will appear as a guide through the installation steps.

Note that PrintShop Mail Connect requires prior installation of Microsoft NET Framework 4.5.
For a full list of other prerequisites, see "Installation Prerequisites" on page 35.

Running the Installation with extra logging

The installer can be run with enhanced logging options, if needed.
To do so, run the PrintShop Mail_Connect _Setup x64.exe from the command line with one of
the following command line options:

e PrintShop Mail Connect Setup x64.exe --verbose
This adds extra debugging style logging to the installation process.

e PrintShop Mail Connect Setup x64.exe --trace
This adds full trace style logging to the installation process. The log file this produces will
be very large, as this option logs everything.

Selecting the required components

After clicking the Next button, the component selection page appears, where the different
components of PrintShop Mail Connect can be selected for installation. Currently, the following
are available:

« PrintShop Mail Connect Designer: The Designer module (see "The Designer" on

page 100) can be installed standalone (with no other installed modules) on as many
machines as you like. It does not require a license to run as a standalone designer tool .
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This allows for any number of people to use the Designer for creating jobs, but without
production capabilities such as automation and commingling.

« MySQL:
A supplied MySQL database used by PrintShop Mail Connect.
The database is used for referencing temporary Connect files and for sorting temporarily
extracted data, and similar.

A pre-existing MySQL or Microsoft SQL server (referred to as an external database, in
this documentation) could be used instead, for the same purposes.

The external database could reside on the same computer or on a separate server.

If you wish to make use of an external database, please make sure the MySQL option is
not selected.

Warning

If you chose not to install the supplied MySQL database, and instead opt to use a
pre-existing external database, then you must ensure that your external database is
accessible to Connect, yourself.

Objectif Lune Inc. will take no responsibility for database connections to any but the
supplied MySQL database.

See "Database Considerations" on page 17 for more information about setting up
external databases.

« Installation Path: This is the location where modules are to be installed.

Note

To cater for MySQL requirements, the installation path cannot contain any non
ASCII characters (such as Asian language Unicode characters). Nor can it contain
characters that Windows disallows in filenames (such as '?', ">' or trailing spaces).
If an invalid character is entered, the Installation Path entry box will turn red and a
description of the error will be displayed in the information area.

The installer can also calculate how much disk space is required for installing the selected
components as well as how much space is available:
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« Disk space required: Displays the amount of space required on the disk by the selected
components.

« Disk space available on drive: Displays the amount of space available for installation on
the drive currently in the Installation Path.

« Recalculate disk space: Click to re-check available disk space. This is useful if space
has been made available for the installation while the installer was open.

« Source repository location: Displays the path where the installation files are located.
This can be a local drive, installation media, or a network path.

End User License Agreement

The next page displays the End User License Agreement, which needs to be read and
accepted before clicking Next.

Configuring Supplied Database Connection

The Default Database Configuration page appears if the supplied MySQL module was
selected for installation in the Product Selection screen. It defines the administrative password
for the MySQL server as well as which port it uses for communication.

The installer will automatically configure the Connect Serverto use the supplied password and
port.

« MySQL user 'root' Password: Enter the password for the 'root', or administration
account, for the MySQL server. The password must be at least 8 characters long and
contain at least one of each of the following:

» alower case character(a, b, c...)

« an upper case character (A, B, C ..)

« anumericdigit(1,2,3...)

« apunctuation character (@, $, ~ ...)
For example: "This1s@K"

Note

When updating from an earlier Connect version, the appropriate MySQL password
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must be entered or the update will fail.

If the password is subsequently forgotten, then MySQL must be uninstalled and its
database deleted from disk before attempting to reinstall.

« Confirm MySQL user 'root' Password: Re-enter to confirm the password. Both
passwords must match for installation to continue.

o TCP/IP Port Number: The port on which MySQL will expect, and respond to, requests. A
check is run to confirm whether the specified TCP\IP Port Number is available on the
local machine. Ifitis already being used by another service (generally, an existing
MySQL installation), the number is highlighted in red and a warning message is
displayed at the top of the dialog.

Note

The MySQL database controlled by the OLConnect MySQL service communicates
through port 3306 by default.

Click Next to display the Selection Confirmation page.

Selection Confirmation

This page confirms the installation selections made.

Click Next to start the installation itself. This process can take several minutes.

Completing the installation

This screen describes a summary of the components that have been installed.

« Configure Update Check checkbox: This option is enabled by default. It causes the
Product Update Manager to run after the installation is complete. This allows
configuring PrintShop Mail Connect to regularly check for entitled updates.

Note: this checkbox may not be available in the event that an issue was encountered
during the installation.

« Show Log...: If an issue was encountered during the installation, click this button to
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obtain details. This information can then be provided to Objectif Lune for troubleshooting.

« When ready, click the Finish button to close the installation wizard, and initialize the
Product Update Manager, if it was selected.

The Product Update Manager

If the Configure Update Check option has been selected, a message will be displayed after
clicking “Finish” in the setup. The message details the information that needs to be sent back to
Objectif Lune Inc. in order to determine when/if the software needs updating.

Click “Yes” to install or open the Product Update Manager where the frequency with which the
updates can be checked and a proxy server (if required) can be specified.

Note

If the Product Update Manager was already installed by another Objectif Lune Inc.
application, it will be updated to the latest version and will retain the settings previously
specified.

Select the desired options and then click OK to query the server and obtain a list of any
updates that are available for your software.

« Note that the Product Update Manager can also be called from the “Objectif Lune
Update Client option in the Start menu.

« It can be uninstalled via Control Panel | Programs | Programs and Features.
Product Activation

After installation, it is necessary to activate the software. See Activating your license for more
information.

Before activating the software, please wait 5 minutes for the database to initialize. If the
software is activated and the services rebooted too quickly, the database can become
corrupted and require a re-installation.

Running Connect installer in Silent Mode

Updating to Connect 2019.1 from earlier Connect version
In order to update PrintShop Mail Connect to 2019.1 itis first necessary to update the Connect
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License.
For details on how to upgrade the Connect License see "Users of Connect prior to 2019.1" on
page 83

Required and optional properties

PrintShop Mail Connect can be installed in a so called "silent mode" to allow an automated
setup during a company wide roll-out or comparable situations. The trigger for the Connect
Installer to run in silent mode is a text file with the fixed name install.properties, which is
located either in the same folder as the PrintShop Mail_Connect_Setup_x86_64.exe orin the
unpacked folder of the installer.exe.

Note

Only the installation can be run silently. Silent Mode does not apply to uninstalling,
modifying, or updating Connect. Any previous version of Connect must be uninstalled
before using the Silent Installer (see: "Uninstalling" on page 94).

The required properties file has the following attributes:

« Comment Lines, starting with # (e.g. # The options to configure an external database)

« Key =Value pairs (e.g. install.product.0 = Connect Designer)

For supported keys, please refer to the next paragraph.

Note

The install.properties file notation must follow commons configuration rules. Please
refer to Properties files for more details.

Required and optional properties

Required properties depend on the specified product. Only fields related to that specified
product must be entered. If no product is mentioned, properties must be specified for all valid
Connect products.

Here is an example of an install.properties file.
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# Verbose logging
logging.verbose = true

# Product selection
install.product.0 = Connect Designer
install.product.l Connect Server

# Server settings
server.runas.username = Localadmin
server.runas.password = admin

# Database configuration
database.type = mysqgl
database.host = 192.168.116.10
database.port = 3308

database.username = root
database.password = admin
database.schema = my ol

Verbose logging (optional)

By default, the Silent Installer will log the same way as the GUl installer. That means logging
of error and warnings, and certain information during database configuration. A more verbose
logging can be switched on by using logging.verbose = true.

Product selection (optional)

By default, if nothing is entered for the products to be installed (install.product.X), Silent
Installer will install all products which are visible to the user for the respective brand (except for
the Server Extension, because only Server or Server Extension can be installed at the same
time).

PrintShop Mail defaults

install.product.0 = Connect Designer
install.product.l = Connect Print Manager
install.product.?2 MySQL
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Note

The values of install.product properties must contain the exact product names.

Server configuration (required if Server is selected for install)

For Server, the following properties need to be provided:

server.runas.username = <username>
server.runas.password = <password>

Server Extension configuration (required if Server Extension is selected for install)

For Server Extension, the following properties need to be provided:

server.runas.username = <username>

server.runas.password = <password>

server.master.host = <IP or name>

server.master.port = <port>

server.master.authenticate = true or false
server.master.username = <username for the Connect Server>
server.master.password = <password>

Database configuration

Case 1: MySQL is among the selected Connect products to be installed (new MySQL
installation)

If MySQL is selected and there is no previous MySQL configuration on the machine, the
following properties should be defined:

database.password = <password> (required and must meet the rules)
database.port = <port> (3306 is the default port value)
database.unlocked = true or false (the default value is false,
optional)

Note

The unlocked option should only be used when the database requires an external
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access.

If the Silent Installer runs with the default product selection, MySQL is included, and
hence the database.unlocked = true property may be optionally set if MySQL on this
machine is intended to serve as the central database also for remote machines.

If the Silent Installer runs with the explicit installation of a stand-alone (install.product.0 =
Connect Server), the database.unlocked property is irrelevant.

Note

The port will be defined automatically for the MySQL installation. All connect products
selected in the Silent Installer will automatically be configured to use the MySQL running
under the port defined by the database.port property, regardless of the default port 3306
or any other user defined port.

A different port is required if 3306 is already taken on that machine by another
application.

Case 2: The Connect Server is selected and MySQL is not selected

In this case, an external database must be configured for the Server (and other Connect
products included in the Silent installation) to be used.

2a: Configuring an external MySQL database

To configure an external MySQL database, the following properties should be defined:

database.type = mysqgl (required)

database.host = <host> (default value is localhost, otherwise
required)

database.port = <port> (default value is 3306, otherwise required)
database.username = <username> (default value 1is root, otherwise
required)

database.password = <password> (required)

database.schema = <schema name> (default value is objectiflune,
optional)
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2b: Configuring an external Microsoft SQL Server database

Note

Since PrintShop Mail Connect version 1.6 the minimum required version of the MS SQL
Serveris SQL Server 2012.

To configure an external Microsoft SQL Server database, the following properties should be

defined:

database.type = Microsoft SQL Server (required)

database.host = <host> (default value is localhost, otherwise
required)

database.port = <port> (default value is 1433, otherwise required)
database.username = <username> (default value 1s sa, otherwise
required)

database.password = <password> (required)

database.schema = <schema name> (default value is objectiflune,
optional)

Repository selection

The Connectinstallation process requires a repository from which the installer copies (locally)
or downloads (online installation) all selected Connect products.

In Silent Installer mode, the installation process looks for the property product.repository in
the install.properties file and then proceeds with the following steps:

1. If the property exists, and its value contains an existing file location with a repository, the
installer will attempt to install from that repository.

2. Ifthe property exists, and its value starts with http:/, the installer will attempt to install from
that location. It will fail if no repository can be found at this location.

3. If none of the conditions mentioned in the previous steps are met, the installer will look
next for a local "repository" folder (located in the same folder as the running Installer
(Setup) executable file). If a repository is found, the installer will attempt to install from that
repository.

4. As alast resort, the installer will attempt to install from the default Connect Update Site
URL.
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Examples

product.repository = http://192.168.79.73/Connect/Version
0l/repository
product.repository

C:\\1s0\\2.0.0.39695 unpacked\\repository

Locale definition

It is possible to define the Locale which affects the installation language and installed locale for
Connect products by using the following properties in the install.properties file:

user.language
user.country

Locales supported by Connect

The Connect Setup supports a dedicated list of Locales, which is saved in the preinstall.ini file.
Each entry consists of a language tag and a country tag, formatted by the pattern:

<language>-<country>

The current list of supported Locales is found below, but it may be enhanced in future releases:

« en-US (English, US)

« de-DE (German, Germany)
« fr-FR (French, France)

« ja-JP (Japanese, Japan)

o zh-CN (Chinese, China)

» zh-HK (Chinese, Hongkong)
o zh-MO (Chinese, Macau)

e zh-TW (Chinese, Taiwan)

« it-IT (ltalian, Italy)

« pt-BR (Portuguese, Brazil)

« €s-419 (Spanish, Latin America)

Locale selection by defining user.language and user.country

If both user.language and user.country are defined in the install.properties file, the
combination must match exactly one of the supported locales, otherwise the Installer will exit
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with an error.

For example, user.language = fr and user.country = CA will cause an error since fr-CA is not
in the list of supported Locales.

Locale selection by defining only user.language

If only user.language is defined in the install.properties file, the Installer will attempt to find a
Locale in the list which starts with the given language code. The first match is selected for
installation. If no match is found, the Installer will exit with an error.

For example:

user.language = zh, will result in an installation with the Locale zh-CN

user.language = no, will resultin an error

Default Locale selection

If neither user.language nor user.country is defined in the install.properties file, the Installer will
select a default Locale:

1. Ifthe System Locale is in the list of supported Locales, it will be selected.

2. Otherwise, if there is an entry in the list of supported Locales, which matches the System
language, it will be selected (e.g. on a fr-CA system, fr-FR is selected).

3. As last resort, the first Locale in the preinstall.ini is selected (usually that should be en-
usS).

Getting the exit code of a silent installation

If getting the exit code of a silent installation is desirable, use the following procedure.

1. Create a new local folder on the machine (or VM) on which Connect shall be installed
and copy/extract the contents of the Connect ISO into this folder.

2. Open a command prompt with Administrator privileges and use the "cd" command to
access this local folder.

3. Run this command to unpack the contents of the Connect Setup executable (as a sample,

we use the PReS Connect brand):
PReS Connect Setup x86 64.exe -nr -gm2 -InstallPath=".\\"
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4. In the local folder, the repository subfolder should now be located next to the
preinstall.exe, installer.exe and other Installer files.

5. Create the install.properties file for silent installation in the local folder.

6. With a batch file calling preinstall.exe and then querying the %errorlevel %, silent
installation can be started and the exit code can be evaluated. See the sample batch file

below.
Exit codes
0 = Success

1 = General Error in preinstall (e.g. not supported settings for user.language / user.country, for
reason see preinstall_err.log)

2 = Unknown Error in preinstall

10 = General Error in Installer application (for reason see OL_Install_<timestamp>.log)

Sample batch file

@echo off
preinstall.exe

if errorlevel 10 goto err installer
if errorlevel 2 goto err unknown
if errorlevel 1 goto err preinstall

echo Success
goto:eof

:err installer
echo "Installer error - see OL Install <timestamp>.log"
goto:eof

:err unknown
echo "Unknown preinstall error - see preinstall err.log"
goto:eof

:err preinstall

echo "Preinstall error - see preinstall err.log"
goto:eof
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Activating a License

PrintShop Mail Connect comes with a30 day trial license period during which time it is not
necessary to have a commercial license to run the application. This allows time for reviewing
the applications and for organizing a commercial license. If a modification to the trail license is
required, such as to allow an extension to the trial period, or for extra functionality, then a new
activation code will need to be requested.

Obtaining the PrintShop Mail Connect Magic Number

To obtain an activation file the OL™ Magic Number must first be retrieved. The Magic Number
is a machine-specific code that is generated based on the computer's hardware and software
using a top-secret Objectif Lune family recipe. Each physical computer or virtual computer has
a different Magic Number, and each requires a separate license file to be functional.

To get the PrintShop Mail Connect Magic Number open the Connect Software Activation
application.

Open the Start Menu

Click on All Programs and browse to the Objectif Lune folder.

Open the Connect Software Activation shortcut.

The PrintShop Mail Connect Software Activation application consists of the following:
« License Information subsection:

o Magic Number: Displays the PrintShop Mail Connect Magic Number.

. -1Copy the magic number to the clipboard: Click to copy the Magic
Number to the clipboard. It can then be pasted in the activation request email
using the Windows CTRL+V keyboard shortcut.

+ Licensed Products subsection:

« Name: Displays the name of the application or module relevant to this

activation.
The Information button i provides detailed information about the application

or module license.

« Serial Number: Displays the trial license serial number or the activation serial
number if the product has been activated in the past.

« Expiration Date: Displays the date when the activation will expire, or the
current date if the product is not activated.
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« End-User License Agreement - Appears only when loading a license file:
o License: This box displays the EULA. Please note that this agreement is
legally binding.
« lagree: Select to accept the EULA. This option must be selected to install the
license.

« ldon'tagree: Select if you do not accept the EULA. You cannot install the
license if this option is selected.

« Load License File: Click to browse to the Connect license file (.olconnectlicense),
once it has been received.

« Install License - Active only when a license file is Loaded: Click to install the
license and activate the software.

» Close: Click to cancel this dialog.
Even if a license file has been Loaded, it will not be installed if this dialog is
Cancelled before the Install License button was clicked.

Requesting a license
After getting the Magic Number, a license request must be done for PrintShop Mail Connect:
o Customers must submit their Magic Number and serial number to Objectif Lune via the

Web Activations page: http://www.objectiflune.com/activations. The OL Customer Care
team will then send the PrintShop Mail Connect license file via email.

« Resellers can create an evaluation license via the Objectif Lune Partner Portal by
following the instructions there: http:/extranet.objectiflune.com/

Note that if you do not have a serial number, one will be issued to you by the OL Activations
team.

Accepting the license will activate it, after which the PrintShop Mail Connect services will need
to be restarted. Note that in some case the service may not restart on its own. To resolve this
issue, restart the computer, or start the service manually from the computer's Control Panel.

Activating PrintShop Mail Connect

To activate PrintShop Mail Connect, simply save the license file somewhere on your computer
where you can easily find it, such as on your desktop. You can then load the license by double-
clicking on it, or through the PrintShop Mail Connect Software Activation tool.

Page 52

PrintShop Mail Connect


http://www.objectiflune.com/activations
http://extranet.objectiflune.com/

Activating the PrintShop Mail Connect license requires the user to have local Windows
Administration rights.

« Using a user profile that has local Windows Administration rights, open the Start Menu
« Click on All Programs, then browse to the Objectif Lune folder.
« Run the “Connect Software Activation” tool.

« Click the Load License File button, and browse for the .olconnectlicense file you
received from Objectif Lune Inc..

« Read the EULA and click the I agree option to accept it.

« Click Install License to activate the license. The license will then be registered on the
computer and you will be able to start using the software.

Warning

After installation message will appear warning that the Server services will need to be
restarted. Just click OK to proceed.

Migrating to a new workstation

The purpose of this document is to provide a strategy for transferring a Connect installation to a
new workstation. The following guide applies to OLConnect v1.x/201x.x .
Before installing the software

Before upgrading to a new version, even on a new workstation, consult the product's release
note to find out about new features, bug fixes, system requirements, known issues and much
more. Simply go to the product page and look for "Release notes" in the Downloads area.

You should also consult the following pages for some technical considerations before
installing:

» "Network Considerations" on page 25
« "Database Considerations" on page 17

« "Environment considerations" on page 22
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« "Installation Prerequisites" on page 35

« "Antivirus Exclusions" on page 16

Downloading and installing the software

In order to migrate to a new workstation, the software must already be installed on the new
workstation. Follow the "Installation and Activation" on page 34 guide to download and install
the newest version of PrintShop Mail Connect on the new workstation.

Backing up files from the current workstation

The first step in migrating to a new workstation would be to make sure all necessary production
files and resources are backed up and copied over to the new system.

Note

Although it is not necessary to convert all of your documents when upgrading to the latest
version, we strongly recommended doing so. It is considered "Best Practice" to convert
the documents to the version installed.

Backing up Connect Resources

The following resources are used by Connect and can be backed up from their respective
folders:

e Job Presets (.OL-jobpreset):
C:\Users\
[UserName] \Connect\workspace\configurations\JobCreationConfig

e Output Presets (.OL-outputpreset):
C:\Users\
[UserName] \Connect\workspace\configurations\PrinterDefinitionCo
nfig
o OL Connect Print Manager Configuration files (.OL-ipdsprinter):
C:\Users\
[UserName] \Connect\workspace\configurations\PrinterConfig

o OL Printer Definition Files (.OL-printerdef):
C:\Users\
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[UserName] \Connect\workspace\configurations\PrinterDefinitionCo
nfig

o OMR Marks Configuration Files (.hcf):
C:\Users\ [UserName] \Connect\workspace\configurations\HCFFiles

Where [username] needs to be replaced with your own Windows user name.
Other Resources

« OL Connect Designer Templates or Package files, copied from the folder where they
reside.

« All PostScript, TrueType, Open Type and other host based fonts used in templates must
be reinstalled on the new workstation.

« Import all dynamic images and make sure their paths match those in the old server.

» Make sure the new workstation can also access network or remote images, JavaScript,
CSS, JSON, and HTML resources referenced in the Connect templates.

Secondary software and licenses

The following only applies to specific secondary products and licenses that interact or are
integrated into the main product.

Image, Fax and Search Modules

« Reconfigure the Image and Fax outputs with the new host information.

« Import the Search Profile and rebuild the database in order to generate the database
structure required by the Workflow.

Capture

1. Download the latest version of the Anoto PenDirector.

2. Before installing the PenDirector, make sure the pen’s docking station isn’t plugged into
the server. Then install the PenDirector.

3. Stop the Messenger 8 service on the old and new server from the Workflow menu
bar: Tools > Service Console > Messenger > right-click and select Stop.
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4. Import the following files and folders from the old server into their equivalent location on
the new server:
C:\ProgramData\Objectif Lune\PlanetPress Workflow 8\PlanetPress
Watch\capture\PPCaptureDefault.mdb
C:\ProgrambData\Objectif Lune\PlanetPress Workflow 8\PlanetPress
Watch\DocumentManager
C:\ProgramData\Objectif Lune\PlanetPress Workflow 8\PlanetPress
Watch\PGC

5. If Capture was previously using an external MySQL or Microsoft SQL Server, reconfigure
the ODBC connection details as previously from the Workflow Preferences by clicking on
the Workflow button at the top left corner and clicking on Preferences, then reconfigure
the PlanetPress Capture options under Behavior >PlanetPress Capture > Use ODBC
Database.

6. Startthe Messenger 8 service on new server from the Workflow menu bar: Tools >
Service Console > Messenger > right-click and select Start.

OL Connect Send

« As of version 8.6 the Connect Send plugins are installed automatically with Workflow. If
you are using an older version, run the OL Connect Send Plug-in Installer on the new
Workstation to re-install the Connect Send plugins.

« Reconfigure the Server URL and port during the OL Connect Send Printer Driver setup.

« Re-run the OL Connect Send printer driver setup on client system and select the Repair
option to point the clients to the new Server URL.

Configuring the Connect Engines

Any changes made to the Server preferences require the OLConnect_Server service to be
restarted to take effect.

1. Stop the OLConnect_Server service from Control Panel > Administrative Tools >
Services > OLConnect_Server > Stop.

2. Configure the Merge and Weaver Engines scheduling preferences as in the previous
installation

« Open the Server Configuration from:
C:\Program Files\Objectif Lune\OL Connect\Connect Server
Configuration\ServerConfig.exe
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« Configure the DataMapper, Merge and Weaver engines preferences under
Scheduling (see Engine Setup preferences). As of version 2018.1 these
preferences include the minimum (Xms) and maximum (Xmx) memory utilization for
the Server, Merge and Weaver engines .

« Configure any other options for the Clean-up Service.

3. Ifthe version used on the new machine is 1.8/8.8 or older, you may have to manually
configure the minimum (Xms) and maximum (Xmx) memory utilization for the Server,
Merge and Weaver engines as previously or better (see also: "Memory per engine" on
page 28):

« Editthe Xms (minimum RAM size) and Xmx (maximum RAM size) fields in the
following configuration files:

e C:\Program Files\Objectif Lune\OL Connect\Connect
Server\Server.ini

e C:\Program Files\Objectif Lune\OL Connect\Connect Merge
Engine\MergeEngine.ini

e C:\Program Files\Objectif Lune\OL Connect\Connect
Weaver Engine\WeaverEngine.ini

4. Now start the OLConnect_Server service

Configuring the Server Extensions

In the case where the OLConnect MySQL is installed on the new Master Server, it is important
to reconnect all Server Extension systems to the new Master Server.

Perform the following action on each Server Extension:

1. Stop the OLConnect_ServerExtension service from Control Panel > Administrative
Tools > Services > OLConnect_ServerExtension > Stop.

2. Open the Server Extension Configuration from:
C:\Program Files\Objectif Lune\OL Connect\Connect Server
Extension\ServerExtension.exe

3. Click on Database Connection and configure the JDBC Database connection settings so
that the hostname points to the new Master Server.

4. Click on Scheduling and type in the location of the new Master Server.

5. Startthe OLConnect_ServerExtension service.
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Transferring software licenses

Once all the above resources have been transferred over to the new server, it is recommended
to thoroughly test the new system - in demo mode - with sample files under normal production
load to identify points of improvement and make sure the output matches the user's
expectation.

Output generated at this point will normally bear a watermark which can be removed by
transferring licenses from the old server to the new one.

« To transfer Connect and Workflow licenses, the user is usually required to complete a
License Transfer Agreement which can be obtained from their local Customer Care
department.

« If you want to transfer your licenses to the new machine right away, you may ask your

local Customer Care department for a 30day Transition activation code for your o/d
machine.

« Upgrades cannot be activated using the automated Activation Manager. Contact your
local Customer Care department.

To apply the license file received from the Activation Team:

1. Ensure that all services are stopped on your old machine before activating and starting
the services on the new machine. Attempting to run the software with the same license
simultaneously will not only run into errors but it is a breach of our EULA.

2. Startthe PReS Connect, PlanetPress Connect or PrintShopMail Connect Software
Activation module:
C:\Program Files\Objectif Lune\OL Connect\Connect Software
Activation\SoftwareActivation.exe

Click on Load License File to import the license.OLConnectLicense.
Start the Software Activation module on the Extension servers, where applicable.

Click on Load License File to import the above same license.OLConnectLicense.

o 0 bk

Restart the OLConnect_Server service and restart the OLConnectServer_Extension
service on the Extension servers, where applicable.

7. The number of Expected Remote Merge and Weaver engines should now be
configurable in the Connect Server Configuration module (C: \Program
Files\Objectif Lune\OL Connect\Connect Server

Configuration\ServerConfig.exe)
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To apply the PlanetPress Capture License:

1. Open the Workflow Configuration.

2. Click on Help on the Menu Bar and click on PlanetPress Capture License manager to
import your license.

Uninstalling PrintShop Mail Connect from the previous workstation

Itis recommended to keep the previous install for a few days until everything is completed.
However, once your transition is successful and complete, the OL Connect software must be
uninstalled from the original server. See "Uninstalling" on page 94.

Preferences

The Preferences dialog is used to modify the general software preferences. Changes made in
this dialog affect the software globally, not individual templates and data mapping
configurations.

The Preferences dialog is separated into individual tabs, where each tab controls certain
aspects of the software.

To open the Preferences dialog, select Window > Preferences.
The General Preferences also provides you with buttons to :

o Reset all Warning Dialogs: This re-enables all warning dialogs that might have been
previously disabled by selecting the "Don't show again" checkbox within the dialog.

« Restore Defaults. This option restores the preferences to Defaults. This applies to the
current Preferences page only, but not other Preferences.

« Apply: This option applies the settings made within the current Preferences page, but
does not close the Preferences dialog.

COTG Servers preferences

This option allows one or more Capture OnTheGo servers to be set up, in order to be used with
the Capture OnTheGo WIM product.
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o Name: Enter a unique name.
« URL: Enter a valid URL (including the protocol, e.g. http://).

+ Restore Defaults: Removes all custom servers from the list and resets to the default
Capture OnTheGo server.

The COTG Servers Preferences also provides you with buttons to :

« Restore Defaults. This option restores the preferences to Defaults. This applies to the
current Preferences page only, but not other Preferences.

« Apply: This option applies the settings made within the current Preferences page, but
does not close the Preferences dialog.

Clean-up Service preferences

The Clean-up Service defines how the Connect database and the temporary files created
during Connect production runs are cleaned up after the production run has finished.

As part of the job production process PrintShop Mail Connect uses a database for intermediate
storage and also creates various temporary "managed" files. These files include data
extractions, configuration files and any intermediate files created during the production process.
Connect keeps track of all these files through references held within the Connect database.

All the files created and the database references to them are stored for a set amount of time in
order to allow Connect to reuse them. However, we do not want to store these indefinitely,
because the database would run out of space. The solution is to use the "Clean-up Service" to
remove the temporary data and files once they are no longer needed.

The more items that are present in the database, and the larger they are, the more time and
processing power (CPU) that will be required for cleaning them up. Thus a regular Clean-up of
the database (as often as possible) is recommended.

This is especially the case if items are not going to be retrieved from the database at a later
date. i.e. If the Connect job is not going to be re-run.

The clean-up can always be set to run outside of business hours (see the Run according to
the cron schedule option below), to reduce impact upon Production systems.
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The values below define when the specified targets are to be set as being ready for deletion,
not when they are actually deleted. The actual deletion occurs only as per the cron job
scheduling; or when PrintShop Mail Connect is started (if Run at application start up is
selected); or when the Run Now button is pressed.

« Enable clean-up service: Check to enable the Clean-up services. When checked, either
or both of the Database clean-up and File clean-up services can be set individually.
If the box is not checked, then no Clean-up will occur.

« Run at application start up: Click to start the clean-up service when the Designer
module is opened.
e Run according to the cron schedule: Enter the interval at which the Clean-up service

runs.
To understand how to write a cron job schedule, please refer to the Quartz Scheduler

tutorial.

Note

If the Product managing the service is set to Designer, then the Designer must be
running at the time that the cron job is scheduled, for the Clean-up to run.

« Product managing the service: Select which of the applications will run the service.For
PrintShop Mail Connect the Designer is the only choice.

Note

The Server Engine is set as the default as it is generally considered the best
option.

This is particularly the case when using a scheduled cron job, as the Sever Engine
is always running, whilst the Designer might well not be at the scheduled time (in

which case the clean-up will fail to run).

« Database Clean-up Service:

« Allow database clean-up service: Select this checkbox to enable the database
Clean-up settings, and enable the actual clean-up.
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« Threads to use for database deletions: The number of Threads to be used
in the clean-up. PrintShop Mail Connect is a multi-threaded application, and
the clean-up is likewise.

Tip

The default number of threads is considered the best compromise for
running both clean-up and production jobs simultaneously. If experience
suggests that the clean-up is not running efficiently, then upping the
number of threads here would be recommended. Conversely, if

production appears to be suffering courtesy of the clean-up process,
then reduce the number of threads here.

In general, higher end machines (those with multiple cores) will allow a
higher numbers of threads, whilst low end machines will perform better
with a lower number of threads.

« Number of entities in each deletion batch: The number of entities to be
deleted at a time. This is done to break the clean-up into smaller chunks. This
improves PrintShop Mail Connect clean-up responsiveness, whilst the clean-
up is occurring.

The number selected here applies to all the following settings.
i.e. a selection of 1,000 would delete 1,000 data records within a Data Set,
1,000 content items within a Content Set, and so on.

e Minimum time to retain Data Sets: The minimum time a Data Set (and all the
records it contains) is retained within the database before being set for
deletion.

Tip
In order to prevent attempts at deleting database objects which might
still be in use, itis recommended that all Minimum time retention values

should always be set to at least the length of your longest job. Preferably
with some extra time added, for good measure.
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For example, if your longest job takes 45 to 50 minutes to run, then set
the retention time to 55 minutes (or 1 hour) to ensure that all the
database objects created during job processing survive for the duration
of the job.

e Minimum time to retain Content Sets: The minimum time a Content Set (and
all the content items it contains) is retained within the database before being
set for deletion.

e Minimum time to retain Job Sets: The minimum time a Job Set (and all the
jobs information it contains) is retained within the database before being set
for deletion.

o Minimum time to retain Managed Files: The minimum time file references (to
files such as data mapping configurations and templates) are retained within
the database before being set for deletion.

e Minimum time to retain other entities: The minimum time any orphaned data
(such as Finishing tables, Media tables, DataModels and Properties tables)
are retained within the database before being set for deletion.

« Database Partition Settings:
« Use Database Partitioning: Select to use Database Partitioning.

« Empty partition count: The number of empty partitions that are created each
clean-up run. This defaults to 24.

« Partition Size: Enter the Iength of time before partitions are switched. This can
be entered in minutes, hours, days, weeks or months.

o File Clean-up Service:

« Allow file clean-up service: Check to automatically detect orphan files and set
them for deletion. Orphan files could be resources and internal files used by
Connect, but which are not needed by any running job.

e Minimum time to retain orphaned files: The minimum time during which
orphaned files are kept in the database before being set for deletion.

The Clean-up Services Preferences also provides you with buttons to :
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e Run Now: This will run the clean-up service immediately.

o Restore Defaults. This option restores the preferences to Defaults. This applies to the
current Preferences page only, but not other Preferences.

« Apply: This option applies the settings made within the current Preferences page, but
does not close the Preferences dialog.

Database Connection preferences

Dialog used to change the PrintShop Mail Connect back-end Database.
This dialog supports the swapping of the back-end database between various vendor
databases. Note, however, that the alternate vendor database(s) must already be installed and

available in order to swap to them.

This is not a migration tool. It is a simple connection tool, that enables shifting to a different
back-end database. Any existing data will not be transferred/ migrated between the databases,
and any existing File Stores will be cleansed by the Clean-up Service after the swap.

When shifting to a different back-end database, the changes won't be applied until PrintShop
Mail Connectis restarted. Including the Connect services. A full machine restart is
recommended, as this provides the cleanest restart of all the services.

« Basic Connection Settings selections:

« Database vendor: Select the database type from the drop down list.

Note

Moving from one vendor database to another will reset all screen selections to
defaults, regardless of what may have been previously selected.

« Database URL: This is a read-only summation of the current database connection
settings.
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Tip

If the Test Connection button shows that the database cannot be
successfully connected to using the selected settings, then the contents of this
field could be used to try to connect to the database outside of PrintShop Mail

Connect. This should help in determining and refining the acceptable
connection options.

« Hostname: Enter the IP Address or alias of the server where database resides.

« Database Instance Name: Enter an existing Microsoft SQL Server's instance

name.
This option only applies to existing Microsoft SQL Server instances, and not for

MySQL.
o Port: Enter Port number. The defaults are those which the vendors use by default.

« Schema: The individual database schema, within the vendor database.

Note

If a previously non-existent schema were chosen here, then a new schema of
that name will be created within the database when the back-end database
swap is applied. The tables within that schema, though, will not be created
until Connect is restarted.

o Username: Enter the database login username.

Tip

Itis considered best practice for this user to have root privileges.

o Password: Enter the password associated with selected username.
« Advanced Connection Settings selections:

« Maximum concurrent threads: This option sets the maximum database threads.
The maximum setting is determined by the specific capabilities of the machine
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Connectis installed upon (CPU speed and the amount of cores being the major
determinants).

Tip
Leaving this value set to the default maximum should be the best option in

most circumstances.
We recommended this entry be left at the default value.

« Custom database parameters table: These are extra parameters which are
appended to the database connection URL. The default values are those which
have been determined to be useful in connecting to specific vendor databases.

« Property: These are free field text fields.

Note

These fields and their associated values get appended to the JDBC
connection and therefore must follow all rules regarding acceptable
URL addresses for such.

« Value: The value applied to the associated Property.
o 1 Add: Used to add extra Property values to the table.

. @ Delete: Used to remove existing Property values from the table.

» Test Connection: Use to test if current connection settings will connect to the
specified database.

« Restore Defaults: Will restore the settings to PrintShop Mail Connect
HyperSQL standard defaults.

« Apply: When a database connection is confirmed as correct this button becomes
active, and is used to actually apply the database swap.

The Database Connection Preferences also provides you with buttons to :
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« Test Connection: This will run a test on the current Database Connection settings.

o Restore Defaults. This option restores the preferences to Defaults. This applies to the
current Preferences page only, but not other Preferences.

« Apply: This option applies the settings made within the current Preferences page, but
does not close the Preferences dialog.

DataMapper preferences

DataMapper XML Preferences

« Display New Line Character as { : Check to show line returns as [ in the Data Viewer,
when XML files are shown. If the option is unchecked, you will not see spaces and line
returns after element names in the Data Viewer.

DataMapper Default Format Settings

DataMapper stores user preferences for the Date, Number and Currency formats. By default,
the user preferences are set to the system preferences. These user preferences become the
default format values for any newly created data mapping configuration.

Format settings can also be defined at the data mapping configuration level (Data mapping
configurations) and/or per field in the Data Model. Any format settings specified in an existing
field are always used, regardless of the user preferences or data source settings.

« Negative Sign Before : A negative sign will be displayed before any negative value.
« Decimal Separator : Set the decimal separator for a numerical value.

« Thousand Separator : Set the thousand separator for a numerical value.

« Currency Sign : Set the currency sign for a currency value.

» Date Format : Set the date format for a date value.

« Date Language : Set the date language for a date value (ex: If English is selected, the
term May will be identified as the month of May).

o Treat empty as 0 : A numerical empty value is treated as a 0 value.

The DataMapper Preferences also provides you with buttons to :
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» Restore Defaults. This option restores the preferences to Defaults. This applies to the
current Preferences page only, but not other Preferences.

« Apply: This option applies the settings made within the current Preferences page, but
does not close the Preferences dialog.

Editing preferences

These preferences define different editing options in the Designer module.

« Object Resizing for <div> elements: This defines in which contexts to enable the
resizing of <div> elements (including Positioned and Inline boxes). Resizing <div>
elements may cause layouts to produce undesirable results especially when using
Foundation templates.

« Enable for Print Context: Check to enable <div> resizing in the Print contexts.
« Enable for Email Context: Check to enable <div> resizing in the Email contexts.
o Detail tables preview limit

« Maximum number of records to show in preview: This setting limits the number
of records to show in detail tables in both the Designer (Preview tab) and
Datamapper. The lower this number, the shorter the time before the preview or the
next record will appear.

CSS options

A CSS preprocessor is a CSS extension language that allows you to enhance CSS with code
(variables, for example) and then compile it into plain CSS. CSS Preprocessor Sass is
integrated in Connect.

For more information about Sass, see: Sass website.

The CSS options relate to the way Sass (.scss) files are compiled in Connect. See also: "Using
a Sass file" on page 311.

« Output style: This setting determines the use of spaces and indentation in the compiled
CSS file. For examples of the available output styles, see: Sass reference: Output style.

« Compact: Each CSS rule takes up only one line, with every property defined on
that line. Nested rules are placed next to each other with no new line, while
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separate groups of rules have new lines between them.

« Compressed: This output style minifies the output. It has no whitespace except that
necessary to separate selectors and a new line at the end of the file. It also includes
some other minor compressions, such as choosing the smallest representation for
colors. It's not meant to be human-readable.

« Expanded: This is the default output style. Each property and rule take up one line.
Properties are indented within the rules, but the rules aren'tindented in any special
way.

o Nested: Each property has its own line, but the indentation isn't constant. Each rule
is indented based on how deeply an elementis nested in the HTML and CSS
structure.

« Auto compile on saving .scss files: When this option is checked, a .scss file is
compiled into a .css file whenever you save it, overwriting any previously compiled
version of the .css file. By default this option is enabled.

Color options

Many of the colors in the user interface of Connect Designer can be adjusted. Click the small
colored square next to the field that holds the default color value, to open the Color dialog and
pick a color (see "Color Picker" on page 436).

« Edges: The edges around elements in a section in the Workspace. Click the Show
Edgesicon to toggle the visibility of these edges.

« Box Objects: This color highlights positioned boxes, inline boxes and Div
elements; see "Boxes" on page 237.

« Table: This color highlights tables, and the rows and columns in tables; see "Table"
on page 260.

« Resizable Table: This color highlights tables for which the option Allow resizing
has been checked when adding the table; see "Table" on page 260.

e Forms: This color highlights forms; see Forms.

« Shared Content: This color highlights shared content, such as shared snippets;
see "Snippets" on page 266.

« Margin and guides: These settings only apply to Print sections.

« Guides: This is the color for rulers that can help position content correctly; see
"Guides" on page 287.
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« Margins: This color delineates the content area on a page; see "Pages" on
page 137.

« Bleed box: This color delineates the printable area on a page; see "Page settings:
size, margins and bleed" on page 138.

o Master pages: These edges are only visible on Master pages; see "Master Pages" on
page 145.

« Header and Footer Margin: This color highlights the header and footer margin set

for the Master page; see "Adding a header and footer" on page 146.

« Objects: This color highlights all elements on the Master page.

« Script Result Highlighter:

« Results: Hovering over a script in the Scripts pane highlights content that will be
affected by the script; see "Personalizing content" on page 312.

Images preferences

« Transparent PDF image preview: Check this option so that PDF resources added to the

template (including in the Master Page and Media) display using transparency. Note that
this can affect display performance (showing transparent PDFs is slower) but will not

affect output speed.

The Editing Preferences also provides you with buttons to :

« Restore Defaults. This option restores the preferences to Defaults. This applies to the
current Preferences page only, but not other Preferences.

« Apply: This option applies the settings made within the current Preferences page, but
does not close the Preferences dialog.

Email Preferences

Email (General) Preferences

o Default From Group:

o Name: Enter the name that is set by default in the "From name" field in the Send
Email and Send Test Email dialogs ("Send (Test) Email" on page 482).

Page 70

PrintShop Mail Connect



« Email Address: Enter the email that is set by defaultin the "From Email" field in the
Send Email and Send Test Email dialogs ("Send (Test) Email" on page 482).

e Litmus account Group:

« Email Test address: If you have a Litmus account, enter the test address to use
when sending a test email (see "Send (Test) Email" on page 482). For more
information on Litmus, please see http:/litmus.com/.

Email (SMTP) Preferences

SMTP server presets can be selected when sending emails using either the Send Email or
Send Test Email dialog. (See "Send (Test) Email" on page 482 and "Email header settings" on
page 169). For all presets, the password is not saved and must be re-entered when sending
emails.

« The Add, Edit and Delete buttons let you create and manage the presets.

« SMTP Host Settings: These settings can be made or edited after clicking the Add or Edit
button.

« Name: The name of the preset. This will show up in the Send Email dialog.

e Host: The SMTP server through which the emails are to be sent. Can be a host
(mail.domain.com) or an IP address.

o Port: The specified port number will be added to the host name, for example:
smtp.mandrillapp.com:465.

« Use authentication: Check if a user name and password are needed to send
emails through the host.

« Start TLS: Enabled if authentication is checked. Sends emails through Transport
Layer Security (TLS), which is sometimes referred to as SSL.

« User: Enter the user name used to connect to the SMTP server.

» Restore Defaults: There are three default presets, each for working with a different Email
Service Provider (ESP): Mandrilapp.com, Sendgrid and Mailgun (see "Using an ESP with
PrintShop Mail Connect" on page 876).

« Apply: Apply the new settings without closing the Preferences dialog.
The Email Preferences also provides you with buttons to :

o Restore Defaults. This option restores the preferences to Defaults. This applies to the
current Preferences page only, but not other Preferences.
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« Apply: This option applies the settings made within the current Preferences page, but
does not close the Preferences dialog.

Emmet Preferences

Emmetis a framework that enables the lightning-fast creation of HTML code though the use of
a simple and effective shortcut language resembling CSS Selectors (see "Emmet" on

page 158). The Emmet functionality is available in the HTML and CSS source editors of
Connect Designer. Emmet transforms abbreviations for HTML elements and CSS properties to
the respective source code.

This is, for example, the abbreviation for a <div> element with the class row:

div.row

On pressing the Tab key, this abbreviation is transformed to:

<div class="row"></div>

To learn more about Emmet itself, please see their website Emmet.io and the Emmet.io
documentation. Emmet is a plugin. All options listed below are Emmet's default options. They
are not specifically adjusted for Connect.

Common Emmet preferences

Expand abbreviations by Tab key: Check to enable the Expand Abbreviation function.

... in files with extension: Enter a comma-separated list of all file extensions in which
expand abbreviation will work.

« Upgrade web editors: This Emmet option doesn't affect how Emmet works in Connect
Designer.

« Extensions Path: Choose a folder where to put json and js files to extend Emmet. This
includes custom snippets, preferences and syntax profiles. For more information see
Customization.

Emmet Abbreviation Preferences

This Preferences tab lets you add and manage custom abbreviations. All standard
abbreviations can be found in Emmet's documentation: Abbreviations.
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If there is no need to transform the text while expanding it, create an Emmet snippet instead
(see below).

o New: Add a new abbreviation.
« Name: The name of the abbreviation is also its trigger.
« Context: The contextin which the abbreviation is enabled (HTML, CSS, etc.).
« Description: A short description of the abbreviation .

« Pattern: This defines what an abbreviation expands to. Since Emmet is mostly used
for writing HTML/XML tags, abbreviation definition uses XML format to describe
elements; see Abbreviation types.

« Automatically insert: This standard option doesn't affect how Emmet works in
Connect Designer.

« Edit: Edit the currently selected abbreviation.
« Remove: Remove the currently selected abbreviation.

« Import: Click to open a browse dialog to import an XML file containing exported
abbreviations. The imported abbreviations are added to the current list.

« Export: Click to open a Save as dialog to export all the abbreviations in an XML file that
can be shared and re-imported.

« Preview box: Shows what the selected abbreviation is expanded to.
+ Restore Defaults: clear all custom abbreviations.

« To temporarily disable an abbreviation, uncheck the checkbox next to the name of the
abbreviation in the list.

Emmet Output Preferences

The Output Preferences dialog is used to control how the expanded (output) code behaves
when expanding abbreviations and snippets. There are 6 different dialogs to control output and,
while they all have identical options, they control different output types: CSS, HAML, HTML,
XML, XSL and the "Default" one controlling the rest of the types.

These options are equivalent to Emmet's syntaxProfiles.json feature.

Emmet Snippets Preferences

Emmet Snippet are similar to abbreviations in that they are expanded when the Tab key is
pressed, but they are just blocks of plain text. Anything in a snippet will be outputted “as is”,
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without any transformation.

« New: Click to create a new snippet.
« Name: The name of the abbreviation is also its trigger.
« Context: The contextin which the snippetis enabled (HTML, CSS, etc.).
« Description: A short description of the snippet.
« Pattern: The pattern defines what a snippet expands to.

« Automatically insert: This option doesn't affect how Emmet works in Connect
Designer.

« Edit: Modify the currently selected snippet.
« Remove: Remove the currently selected snippet from the list.

« Import: Click to open a browse dialog to import an XML file containing exported snippets.
The imported snippets are added to the current list.

« Export: Click to open a Save as dialog to export all the snippets in an XML file that can
be shared and re-imported.

« Preview box: Shows what the selected snippet is expanded to.

« Totemporarily disable a snippet, uncheck the checkbox next to the name of the snippetin
the list.

Emmet Variables Preferences

Variables are placeholders used in Emmet snippets to output predefined data. For example, the
html:5 snippet of HTML syntax has the following definition:

<!doctype html>\n<html lang="${lang}">...</body>\n</html>

In the example above, ${lang} is used to refer lang variable defined in variables below. If your

primary language is, for example, Russian, you can simply override lang variable with ru value
and keep the original snippets. Also, you can override variable values with inline abbreviation
attributes: html:5[lang=ru].

« Name: The name of the variable. This should be a single alphanumeric string with no
spaces or special characters. For example, the myVar name is referred to as ${myVar}.

« Value: The value of the variable when the snippet is expanded.

« New: Click to create a new variable and define its name and value.
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« Edit: Click to modify the currently selected Variable.

« Remove: Click to delete the currently selected Variable.

The Emmet Preferences also provides you with buttons to :

« Reload Engine. This allows you to reload the Emmet engine based upon the current
settings.

« Restore Defaults. This option restores the preferences to Defaults. This applies to the
current Preferences page only, but not other Preferences.

« Apply: This option applies the settings made within the current Preferences page, but
does not close the Preferences dialog.

Engine Setup

See Engine Setup Peferences.

Language Setting Preferences

« Display language: Select a language from the drop-down list to be used as the language
of the User Interface (after the software is restarted).

« Default Locale: The default locale sets the locale for new templates. By default this is the
system's locale. The locale can be changed per template; see "Locale" on page 309.

« Select System Locale to use the operating system's locale settings.

« Select Explicit Locale to choose a static locale from the drop-down list.

Default Locale

The Default Locale preferences are only available in the Designer Preferences. This setting
determines the locale for new templates. By default this is the system's locale. Select System
Locale to use the operating system's locale settings.Select Explicit Locale to choose a specific
locale from the drop-down Explicit Locale list. The Locale can be changed on a per template
basis. See "Locale" on page 309.

The Language Settings and Default Locale Preferences also provides you with buttons to :

Page 75

PrintShop Mail Connect



» Restore Defaults. This option restores the preferences to Defaults. This applies to the
current Preferences page only, but not other Preferences.

« Apply: This option applies the settings made within the current Preferences page, but
does not close the Preferences dialog.

Log Setting Preferences

PrintShop Mail Connect logs the activities it undertakes whilst running. New Connect logs are
created daily and are held for a period before they are automatically deleted.

The settings on this page determine the level of logging and how long the log files should be
retained.

These log files can be an essential resource when diagnosing issues with OL Support. The
logging settings are global to all Connect applications and the Logging Preferences can be
adjusted from within any of the Designer and Print Manager dialogs.

The settings are:

« Overall Logging Level selection: Select the overall Connect Logging level. This controls
how much logging Connect will do.
By default the logging level is set at the midpoint of Info, but it can be set higher to include
more logging (All, Trace, Debug), or lower to reduce the amount of logging (Warning,
Error).
The logging is hierarchical, with each Logging Level selection containing all of the
Logging Levels below it. The default logging Info Level contains all Error and Warning
entries plus informational log entries.

Warning

Higher logging settings will have an impact upon Connect production speeds, as well as leading to
substantially larger log files.

We recommended leaving the logging level to Info and only using the higher levels of logging in
conjunction with advice from OL support.
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« Rollover policy selection: Chose whether to retain Connect log files for a certain number
of days (Daily logs) or based upon some predetermined hard disk usage limitations
(Size-based logs). The selection are as follows:

« Daily Logs: Use this setting to determine how many days Connect Logs are to be
kept, before they are deleted.

« Number of days to retain logs: This value only impacts upon historic

(closed) logs.

Chose between 1 and 99,999 days.

The default value is set to 10 days for a new installation and 99,999 days on
existing installations (to preserve backward compatibility).

« Size-based logs: Use this setting to restrict log file size, and to keep only a
specified number of them.
By combining the maximize individual log file size with the amount of log files to
retain, this effectively allows a hard disk space usage limitation to be placed upon
the logging process.

« Maximum size for log file: This sets the maximum size a log file can reach
before the logging system creates a new file.

« Number of files to keep:This sets the maximum number of log files keptin
the log folder. The default value is set to 50 for a new Connect installation and
99, 999 for an existing installation (to preserve backward compatibility).

« Logging pattern edit box: This edit box determines the formatting of the individual log

entries.
By defaultitis set to a date/time value which allows for simple searching within log files.

Warning

We recommend leaving the Logging pattern to the default value.

If you do need to change the Logging pattern, please see the Pattern Formatting
guide for help in doing so.

« Log message preview display: This displays a real time example of the format and
content of individual log file entries, based upon the Logging pattern setting.
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Advanced Log Settings

The Advanced settings over-ride the Overall logging settings, and provide a greater level of
logging granularity.

Warning

Higher logging settings will have an impact upon Connect production speeds, as well as
leading to substantially larger log files.

The Advanced Log Settings should only be set in conjunction with advice from
OL support, to ensure that only the most relevant settings are set to the higher logging
levels.

This Preferences page allows you to add (| ;) or remove (| 2) individual Connect Packages, or

change their logging settings (#).
The Log Setting and Advanced Log Setting Preferences also provides you with buttons to :

» Restore Defaults. This option restores the preferences to Defaults. This applies to the
current Preferences page only, but not other Preferences.

« Apply: This option applies the settings made within the current Preferences page, but
does not close the Preferences dialog.

Print Preferences

Available Printers Preferences

The Available Printers preferences control which printer definitions are available when
generating print output or creating Output Presets. Any printer that is unchecked in this dialog
will not be visible in the "Model" drop-down of the Print Options dialog; see "Print Options" on
page 647 and "Adding print output Models to the Print Wizard" on page 862.

Available Printer Preferences:
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« Selected Printers: Lists the available Printer Definition Files in the system. Note that
these are not installed Windows printers or printer queues, but PrintShop Mail Connect
Printer Definition Files.

« Printer checkbox: This checkbox selects/deselects all printers in the list. Click to check
all, click again to uncheck all.

General Print Preferences

The General Print Preferences are used to set communication settings with the PrintShop Mail
Connect Server module that does the actual generation of print output. The Server module can
be located on the same computer (hostname: localhost) or on a different machine. Multiple
Designer modules can use a single Server module to generate Print output, as long as the
appropriate hostname, username and password are provided. In essence, this can be used to
create a single Print Server.

Print Measurements Preferences

o Units: Use the drop-down to specify the default measurements system used for
dimensions of the template and boxes. In addition it defines the coordinates/position of
box elements.

The default unit will be added automatically when geometry values are entered without a
unitin the Attributes pane or in the Box Properties dialog.

« Flip insert guide axis: Check this option to flip the axis on which guides are inserted.
Normally, dragging a guide from a horizontal ruler inserts a horizontal guide (see
"Guides" on page 287). With this option checked, dragging a guide from a horizontal ruler
inserts a vertical guide.

The Print Preferences also provides you with buttons to :

o Test Print Server URL. This button is only available for the General Print Preferences. It
tests the Print Server URL settings made within that Preferences page.

» Restore Defaults. This option restores the preferences to Defaults. This applies to the
current Preferences page only, but not other Preferences.

« Apply: This option applies the settings made within the current Preferences page, but
does not close the Preferences dialog.
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Project Wizards

Project Wizard deployment settings

« Workflow Configurations

« Encoding: By default, Project Wizards set the encoding of the Workflow
configuration that they create to the encoding of the system on which the Designer
runs (system default).

If Workflow runs on another machine, and that system has a different active code
page, Workflow may be unable to correctly interpret all the characters that are used
in the configuration file (in path or file names, for example). To prevent this, you may
select an encoding from the list.

Saving Preferences

The saving preferences are a way control if and how often PrintShop Mail Connect saves your
work in the background, and if how many backup files it creates when you save the template or
data mapping configuration. See also: "Saving a template" on page 104.

Auto Save

After a template or data mapping configuration has been saved for the first time, Connect
Designer can auto save it with a regular interval.

« Enable: activate the Auto Save function.

« Interval (minutes): enter a number of minutes, e.g. 3 to auto-save the template or data
mapping configuration every 3 minutes.

Auto Backup

Connect Designer can automatically create a backup file when you manually save a template
or data mapping configuration. The Auto Save function does not cause backup files to be
created.

« Enable: activate the Auto Backup function.

« Revisions to keep: Enter the maximum number of backup files. When the maximum is
reached, Auto Backup will overwrite the oldest file.

« Destination: Select the directory in which the backups should be stored.
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« Original: the directory in which the original file is stored.

« Other directory: use the Browse button to select another directory.

Backup files have the same name as the original file with two underscores and a progressive
number (without leading zeros) at the end: originalname__1.0L-template, originalname__
2.0L-template, etc.

The Save Preferences also provides you with buttons to :

« Restore Defaults. This option restores the preferences to Defaults. This applies to the
current Preferences page only, but not other Preferences.

« Apply: This option applies the settings made within the current Preferences page, but
does not close the Preferences dialog.

Scheduling Preferences

The Designer's scheduling preferences are a way to control precisely how the PrintShop Mail
Connect Designer handles jobs when

For more information about scheduling preferences in PrintShop Mail Connect also see
"Performance Considerations" on page 29.

Scheduling options

This preference page defines what is considered a small or large job (anything in between is
considered "medium" jobs). For a detailed description of all options, see Scheduling
Preferences.

Scheduling - Merge engine

This preference page defines how different instances and speed units are attributed to different
jobs when creating output documents. For a detailed description of all options, see Merge
Engine Scheduling.

Scheduling - Weaver engine

This preference page determines the number of engines launched, as well as their speed,
when generating Print Output of any type. For a detailed description of all options, see Weaver
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Engine Scheduling.
The Scheduling Preferences also provides you with buttons to :

» Restore Defaults. This option restores the preferences to Defaults. This applies to the
current Preferences page only, but not other Preferences.

« Apply: This option applies the settings made within the current Preferences page, but
does not close the Preferences dialog.

Scripting Preferences

The Scripting preferences define different options related to scripting within PrintShop Mail
Connect. See also: "Testing scripts" on page 369.

+ General:

« Script timeout at design time (sec): In Preview mode or when running the Script
Profiler (see the Profile Scripts dialog), a long running script is stopped after the
amount of time set here. The defaultis 2 seconds, the minimum is 1 second.

« Expanded script quotes style: When the Expand button in a Script Wizard is
clicked, the expanded script will use either double (") or single (‘) quotation marks.

Tip
Using single quotation marks in a script simplifies adding HTML fragments,
which typically use double quotes.

« Designer scripting profiling group:

« Number of iterations: Enter the number of times to run scripts when running the
Profile Scripts dialog. The defaultis 1000. Accepted values are 1 to 1000000000.
Yes, that's 1 billion - which would take a /ong time to run!

The Scripting Preferences also provides you with buttons to :
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» Restore Defaults. This option restores the preferences to Defaults. This applies to the
current Preferences page only, but not other Preferences.

« Apply: This option applies the settings made within the current Preferences page, but
does not close the Preferences dialog.

Upgrading

This page provides information about Upgrading to PrintShop Mail Connect version 2019.1.
Upgrade information is detailed in the following pages:

» "Upgrading from previous Connect Versions" below
« Upgrading from PReS Classic
« Upgrading from PlanetPress Suite 6/7

» How to perform a Workflow migration

« How to perform a Capture migration
Upgrading from previous Connect Versions

Users of Connect prior to 2019.1

Users of all Connect versions prior to 2019.1 should note that Update Client 1.2.40 is a
prerequisite for both OL Connect 2019.1 and Connect Workflow 2019.1 installations. Only
Update Client 1.2.40 has the capacity to upgrade the OL Connect license to the newer format
that is required by the installers of those products.

If you do not have Update Client version 1.2.40 installed already, then the next time you run
your Update Client it will show that there is an update available of itself to Version 1.2.40 (or
later).

Simply click on the “Install” icon # to initiate the upgrade.

-

For further details on how to upgrade the Update Client and update your Connect License see
the Update Client 1.2.40 Upgrade Guide.
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Note that an erroneous or incomplete uninstall before a reinstall or upgrade to a newer version
of OL Connect may cause issues (see Product or engine exits within a second of starting in
Connect's Knowledge Base).

Note

If an error occurs during uninstallation or after/when re-installing Connect after uninstalling i,
please see: Problems during a Connect installation or version upgrade in Connect's
Knowledge Base.

Connect: a peek under the hood

Connect consists of visible and invisible parts.

The visible part is of course the Designer, that you use to create templates and Print Presets.
The invisible parts process the Connect job to provide the actual output. This topic introduces
you to those parts.

Here's a simplified, graphical representation of the architecture of PrintShop Mail Connect.

Loading Data DataM:’:\pper
engine
Connect

Database

Content Merge
Creation engine(s)

Templates

Job Presets Job Creation

File Store
Output Output Weaver

Presets Creation engine(s)
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The Connect database

The Connect database is the database back-end used by Connect itself when processing jobs.
It can be either the MySQL instance provided by the Connect installer, or a pre-existing
(external) instance (see "Database Considerations" on page 17).

All generated items (records, content items etc.) are stored in this database .

Note

Email content items are not stored in the Connect database.

A clean-up of the database is performed at regular intervals in accordance with the settings
(see "Clean-up Service preferences" on page 337).

The File Store

Connect has its own File Store which it uses for transient files.
The Clean-up service takes care of removing obsolete files when those files are not marked as
permanent (see "Clean-up Service preferences" on page 337).

The engines

DataMapper engine. A DataMapper engine extracts data from a data file. This is an internal
engine, for which there are no settings to make.

Merge engine/s. A merge engine merges data with a template using the scripts in the template,
in order to create (PrintorEmail) content items.

The number of merge engines is configurable (see Merge Engine Scheduling): it can be
increased depending on the capacity of the machine that runs the solution (see "Performance
Considerations" on page 29).

Weaver engine . The Weaver engine creates Print output from Print content items. It takes the
settings made in Print Presets or in the Print Wizard into account.
The number of Weaver engines is configurable as well (see Weaver Engine Scheduling).
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Speed units

The number of 'speed units' is the maximum number of Merge engines or Weaver engines that
are allowed to work in parallel. The output speed of all engines together is limited to a certain
number of output items (web pages, emails, or printed pages) per minute. How many speed
units you have and what the maximum total output speed will be is determined by your licence
and any additional Performance Packs you might have.

PrintShopMail Connect always has just one speed unit. Performance Packs only increase the
output speed. But there is one important twist: when generating Print output, the limit imposed
by the number of speed units, only applies to the Weaver engine; when creating Email , the
limit applies to the Merge engines only (the Weaver engine is not involved). So, when
generating Print output, multiple Merge engines can be used. The number of Merge engines is
only limited to one when creating Email output.

Each Merge engine and each Weaver engine needs at least one speed unit. However, since
the number of engines is configurable, and since small, medium and large jobs may run
concurrently, the number of engines in use may not match the number of available speed units.
When there are more speed units than there are engines in use, the Connect server distributes
the speed units and the maximum output speed to the engines proportionally.

For advice on engine settings, see "Engine configuration" on page 26.

Known Issues

This page lists important information about issues that apply to PrintShop Mail Connect 2019.1.

The OL Connect 2019.1 license update does not cater for
existing AFP input licenses

AFP Inputis an add on option for OL Connect licenses. Unfortunately, the update to the 2019.1
version of the OL Connect license does not cater for existing AFP input licenses.

If you have an existing AFP input license we ask that you contact your local Customer Care
team after the initial license update is complete and have them add the AFP input option back
into your license.
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The Update Client OL for Connect 2019.1 does not cater for
standalone Connect Print Manager installations

The Connect Print Manager is a standalone Connect tool that is used in production sites to
manage print jobs. It can be installed and run on standalone machines without a Connect
license.

The Update Client for Connect 2019.1 looks for a Connect license as part of the update
process, but it will not find one on standalone Connect Print Manager installations. As a result
the Update Client will not recognize that there is a Connect update available to the Print
Manager machine.

In order to update Connect Print Manager to version 2019.1 you will need to download the
Connect 2019.1 installer outside of the Update Client. The Connect 2019.1 installer can be
downloaded from the Web Activation Manager site, or you could ask your local Administration
for the installer, as it would likely already have been downloaded for installation by the
document designers.

Page break changes in 2019.1

Improved page breaking in Connect 2019.1 might impact upon some existing templates.
It is recommended that you check page breaking in existing jobs, where page breaks at a
specific location are a known criteria.

Minor differences in AFP and IPDS output introduced in
2019.1

Connect 2019.1 now defaults to "Scale to Fit" for both IPDS and AFP output.
Please note that this may have an impact when printing pre-existing Connect jobs (made in
Connect versions predating 2019.1) on older printer models that do not support "Scale to Fit".

Issue with image placement in 2019.1 when using some
customized AFP and IPDS Printer Definitions

An issue with image placement in Connect 2019.1 AFP and IPDS output was discovered just
prior to the release. The issue is specific to AFP and IPDS 600 DPI Printer Definitions that are
not set to "Scale to Fit".
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As "Scale to Fit" is now switched on by default in all standard Connect 2019.1 AFP and IPDS
Printer Definitions, none of those should encounter the issue.

This issue will be fixed in a subsequent patch release.

Issue after erroneous or incomplete update or re-installation

If one or more products (the Connect Designer, Connect Server, Software Activation, Print
Manager, or Server Configuration Tool) or engines exit within a second of starting, this may be
caused by a recent erroneous or incomplete uninstall before a reinstall or upgrade to a newer
version of OL Connect. (See Product or engine exits within a second of starting in Connect's
Knowledge Base.)

This may be solved by deleting the sUserProfile$\Connect\.eclipse directory.
For guidance on a full manual uninstallation please see the Solution in: Problems during a
Connectinstallation or version upgrade in Connect's Knowledge Base.
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Backend database might require periodic maintenance

Databases maintain a variety of statistics in order to optimize performance. When high levels of
inserts and/or deletions occur, the statistical data keeping can struggle to keep up. Over a
period of prolonged and intensive processing this can resultin a degradation in performance,
with the whole database slowing down as it struggles to clean itself up.

In Connect terms the effect can be felt as the Data Mapper and/or Job Creation progressively
slowing down.

To cure this issue, it is recommended that you periodically run manual maintenance on the
backend database.

If using MS-SQL, you can run the following command in a query window:

set @a=null, @c=null, @b=concat ("show tables where",ifnull (concat (" "Tables in
",database(),"" like '",@Qc,"' and"),'')," (@a:=concat ws(',',6@a, Tables in
",database(),"))");

Prepare "bd’ from @b;
EXECUTE “bd;
DEALLOCATE PREPARE "bd;

set @a:=concat ('optimize table ', Qa);
PREPARE “sgl”~ FROM (@a;

EXECUTE “sqgl’;

DEALLOCATE PREPARE "sql’;

set @a=null, @b=null,@c=null;

If using MySQL, the following script should be run in a query window:
sp_updatestats

Windows 10 Search service impacting Connect

The Windows 10 Search service runs as a background task, indexing files and folders. It has
been noted that this background task is sometimes preventing files being added to the Connect
temporary files folder when large amounts of files are being output and copied.

If this is an issue for you, we suggest disabling Search Indexing on the
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C:\Users\<username>\Connect folder.

This issue will be fixed in a later release.

Job Creation Presets: External Sorting change introduced in
2018.2

Versions prior to 2018.2 did not correctly save the line end characters for external sort
configurations in Job Creation Presets, which meant the job could not be externally sorted. This
issue has been fixed in version 2018.2. However, Job Creation Presets created with an earlier
version may still have the wrong line end character for external sorting. To fix this, open the Job
Creation Preset in the new version, reset the line end setting in the sorting options and then
save the preset.

Business Graphics: Backward Compatibility Issues
introduced in 2018.1

As a consequence of changes in both the user interface and the underlying technology,
Business Graphics made with a version prior to PrintShop Mail Connect 2018.1 may not
display correctly when opened in version 2019.1.

The currently known backward compatibility issues are listed here:

All charts

e Legend position: The position of the legend is not converted. It defaults to 'left' in a
converted chart.

« NOTE: Expanded custom chart scripts cannot be converted.
Pie charts

« Default colors: The default colors (used when no pie chart colors are specified) have
changed.

Known Font issues

The following font(s) are known to have issues in PrintShop Mail Connect 2019.1:
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« Benton Sans CFF font

Minor differences in PCL, AFP and IPDS output introduced
in 2018.1

The browser component (Mozilla Gecko) used in the WY SIWY G editor of the Designer was
updated for Connect 2018.1. This allows use of new CSS properties, such as flexbox.

However this update could lead to increased output file sizes for some PCL, AFP and IPDS
jobs. This is generally not a cause for concern, however there might be some associated
increase in processing times, as well as some minor differences in the output. For example,
table line widths and font spacings might differ slightly (particularly for SMALL CAPS text),
which could lead to slightly different word-wrapping in some circumstances.

Windows Server 2016 issue

As of PrintShop Mail Connect 2018.1 Connect is officially supported under Windows Server
2016.

Please note, however, that the Objectif Lune Inc. Update Client application might be blocked
by the enhanced security settings in Windows Server 2016.

To fix this, add http://updates.ca.objectiflune.com to the list of trusted web sites on that machine,
or lower the internet access rules.

Limit of 100MB of image files within a single job

The browser component (Mozilla Gecko) used in the WY SIWY G editor of the Designer was
updated for Connect 2018.1. This allows use of new CSS properties, such as flexbox.

However this update also introduced a limit of 100MBs for image files included within a single
job. The limitis set at 100MB deliberately, as this allows most jobs to run faster. However, if a
job requires more than 100MBs of image files, then the Connectimage cache size can be
increased to cater for such.

Please contact OL Support for instructions on how to modify the image memory cache value, if
needed.
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Print Output: Booklet Impositioning changes introduced in
2018.1

When Booklet Impositioning is enabled, all pages within a document need to be changed to
duplex prior to Impositioning . The method for duplexing jobs has been changed to now always
combine existing pages into the front and backsides of sheets, rather than adding empty
backsides to any simplex pages.

The result is that now every document in the job becomes a booklet without any empty pages
between the first page and the last page.

With some exceptions. Booklet Impositionings that require a multiple of 4 pages (Saddle
binding and Perfect binding) will still get empty pages added, when needed.

Installation Paths with Multi-Byte Characters

When installing the Traditional Chinese or Japanese versions of Connect, if the user specifies
an alternative installation path containing multi-byte/wide-char characters it can break some of
the links to the Connect-related shortcuts in the Start Menu and cause an error to appear at the
end of the installer. The workaround for the moment is to use the default installation path. The
problem will be addressed in a later release.

Switching Languages

Changing the language using the Window > Preferences > Language Setting menu option
does not currently change all of the strings in the application to the selected language. This is a
known issue and will be fixed in a later release.

In the meantime we offer the following workaround for anyone who needs to change the
language:

1. Go to the .ini files for the Designer and Server Config:

e C:\Program Files\Objectif Lune\OL Connect\Connect
Designer\Designer.ini

e C:\Program Files\Objectif Lune\OL Connect\Connect Server
Configuration\ServerConfig.ini

2. Change the language parameter to the required one under Duser.language=en | es | de |
fr|it|ja|ko|pt|tw|zh
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Only one of the above language tags should be selected. Once saved, Connect will appearin
the selected language at next start-up.

GoDaddy Certificates

When installing Connect offline, dialogs allow installing the GoDaddy certificates. Most users
should use the default settings and click Next. In some cases, however, this may not work
correctly. For this reason those users should activate Place all certificates in the following
store and then select the Trusted Root Certification Authorities as the target certificate store.

MySQL Compatibility

The minimum supported MySQL version is 5.1.31.

Available Printer Models
Note that only the single Printer Model (Generic PDF) will appear on the Advanced page of the

Print Wizard by default.

To add additional printer models click on the settings - button next to the Model selection
entry box.

Color Model in Style Sheets

The color model of colors defined in a style sheet can sometimes change after editing the style
sheet. This is a known issue and will be addressed in a subsequent release.

Image Preview in Designer

Ifin the Windows Internet settings (Connection Settings > LAN configuration) a proxy is
enabled, but "Bypass proxy settings for local addresses" is not checked, the image preview
service, conversion service and live preview tab in the Designer will not work and exhibit the
following issues:

« Images will be shown as 0 size boxes (no red 'X' is displayed).

« Live preview does not progress, and when re-activated reports "browsers is busy".

To fix the issue you must check the "Bypass proxy settings for local addresses" option.

VIPP Output

Some templates set up with landscape orientation are being produced as portraitin VIPP. It can
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also sometimes be the case that text and images can be slightly displaced. These are known
issues and will be addressed in a later release of Connect.

Magic Number changes when installing Docker

Installing Docker on a system where Connect has already been installed may impact Connect's
licensing mechanism and require reactivation.

Note

Installing Connect after Docker has already been installed will not cause issues.

Uninstalling

This topic provides some important information about uninstalling (removing) PrintShop Mail
Connect2019.1.

To uninstall PrintShop Mail Connect select the application from within the Add/Remove
programs option under the Control Panel. This will start the PrintShop Mail Connect Setup
Wizard in uninstall mode.

Note

The PrintShop Mail Connect Setup Wizard might take some seconds to appear.

Important Note: Stop any active Anti-Virus software before
uninstalling Connect.

Some anti-virus systems are known to block the uninstallation of MySQL datafiles, as well as
blocking the uninstallation of the MySQL database application itself. Therefore itis highly
recommended that any anti-virus application be stopped prior to uninstalling PrintShop Mail
Connect, as otherwise the Connect uninstallation might not work correctly.

Page 94

PrintShop Mail Connect



Impacts upon other Applications and Services

« The Uninstall will terminate the installed Server / MySQL service(s).
« The following applications / services should be stopped in a controlled fashion, before
running the PrintShop Mail Connect Uninstall:
1. PrintShop Mail Connect
2. Connect products on remote systems which refer to this MySQL database.

Uninstallation Wizard

The uninstallation is done by running the PrintShop Mail Connect Setup Wizard in uninstall
mode. The Wizard consists of the following pages:

1. PrintShop Mail Connect Setup: An information page, listing what will be uninstalled,
and also warning about impacts upon running Applications and Services.

2. Data Management: A page that provides options for backing up or deleting Connect
data. Selections are as follows:

« Delete Connect Workspace Data: Check this box to delete the Workspace data for
the current user, or for selected users (as determined by the "Select Users" button)

« Backup Connect Workspace Data for all specified Users: Check this box
to backup the Workspace data for the specified users (as previously
determined) into a compressed ZIP file (whose location can be customized),
before deletion of the full Workspace data.

o Delete MySQL objectlune Data: Check this box to delete the MySQL database
installed with PrintShop Mail Connect.

« Backup MySQL Date: If the deletion checkbox is selected, this option
appears to allow backing up the MySQL database to a customizable location,
prior to uninstallation.

Note

If an error occurs during uninstallation or after/when re-installing Connect after uninstalling it,
please see: Problems during a Connect installation or version upgrade in Connect's
Knowledge Base.
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Connect: a peek under the hood

Connect consists of visible and invisible parts.

The visible part is of course the Designer, that you use to create templates and Print Presets.
The invisible parts process the Connect job to provide the actual output. This topic introduces
you to those parts.

Here's a simplified, graphical representation of the architecture of PrintShop Mail Connect.

Loading Data DataM.apper
engine
Connect

Database

Content Merge
Creation engine(s)

Templates

Job Presets Job Creation

File Store
Output Output Weaver

Presets Creation engine(s)

The Connect database

The Connect database is the database back-end used by Connect itself when processing jobs.
It can be either the MySQL instance provided by the Connect installer, or a pre-existing
(external) instance (see "Database Considerations" on page 17).

All generated items (records, content items etc.) are stored in this database .
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Note

Email content items are not stored in the Connect database.

A clean-up of the database is performed at regular intervals in accordance with the settings
(see "Clean-up Service preferences" on page 337).

The File Store

Connect has its own File Store which it uses for transient files.
The Clean-up service takes care of removing obsolete files when those files are not marked as
permanent (see "Clean-up Service preferences" on page 337).

The engines

DataMapper engine. A DataMapper engine extracts data from a data file. This is an internal
engine, for which there are no settings to make.

Merge engine/s. A merge engine merges data with a template using the scripts in the template,
in order to create (PrintorEmail) content items.

The number of merge engines is configurable (see Merge Engine Scheduling): it can be
increased depending on the capacity of the machine that runs the solution (see "Performance
Considerations" on page 29).

Weaver engine . The Weaver engine creates Print output from Print content items. It takes the
settings made in Print Presets or in the Print Wizard into account.
The number of Weaver engines is configurable as well (see Weaver Engine Scheduling).

Speed units

The number of 'speed units' is the maximum number of Merge engines or Weaver engines that
are allowed to work in parallel. The output speed of all engines together is limited to a certain
number of output items (web pages, emails, or printed pages) per minute. How many speed
units you have and what the maximum total output speed will be is determined by your licence
and any additional Performance Packs you might have.

PrintShopMail Connect always has just one speed unit. Performance Packs only increase the
output speed. But there is one important twist: when generating Print output, the limit imposed
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by the number of speed units, only applies to the Weaver engine; when creating Email , the
limit applies to the Merge engines only (the Weaver engine is not involved). So, when
generating Print output, multiple Merge engines can be used. The number of Merge engines is
only limited to one when creating Email output.

Each Merge engine and each Weaver engine needs at least one speed unit. However, since
the number of engines is configurable, and since small, medium and large jobs may run
concurrently, the number of engines in use may not match the number of available speed units.
When there are more speed units than there are engines in use, the Connect server distributes
the speed units and the maximum output speed to the engines proportionally.

For advice on engine settings, see "Engine configuration" on page 26.

Connect file types

This article describes the different file types that are related to PrintShop Mail Connect and its
different modules. These are files that are generally transferable between machines, can be
sent via email or other means.

« .OL-template: A Designer Template file (see "Templates" on page 102). Is linked to a
data mapping configuration by default, but not necessarily.

« .OL-datamodel: A data model file which can be imported or exported into either a data
mapping configuration or a template. Contains a list of fields and their data type (date,
currency, string, etc). See The Data Model.

« Print Presets are used when generating a job, ready for output, from Designer (see
"Generating Print output" on page 857) or through Workflow (see Print processes with OL
Connect tasks).

« .OL-jobpreset: A Job Creation Preset file has settings for data filtering and sorting,
grouping (groups are used to split the print output), adding metadata fields, and
finishing options that override the template's Media and Section settings. (See "Job
Creation Presets" on page 632.)

« .OL-outputpreset: An Output Creation Preset file is used to generate the actual
print output in the appropriate format (pcl, afp, pcl, ipds, pdf, etc). It includes print
settings such as impositioning (N-up, cut & stack), inserter marks, tray settings,
separation etc. (See "Output Creation Presets" on page 645.)
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« .OL-package: A transfer file used to package one or many of the above files (the data
model being part of both the template and the data mapping configuration). Created by
using the File > Package dialog. (See "Package dialog" on page 460.)

« .OL-script: One or more Designer scripts. Scripts personalize the output of a template.
They are either added via wizards (see "Personalizing content" on page 312) or self-
written (see "Writing your own scripts" on page 360). They can also be imported or
exported from the Scripts pane in Designer when a template is open.

e .OL-printerdef: A Printer Definition File is used by the Output Creation Preset (see
"Output Creation Presets" on page 645) to determine what type of output to produce.
These definition files are generated by an internal application that is not currently
distributed outside of OL, but the definition files themselves can be provided.
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The Designer

The Designeris a WYSIWYG (what you see is what you get) editor that lets you create
templates for various output channels: Print, Email and Web. A template may contain designs
for multiple output channels: a letter intended for print and an e-mail variant of the same
message, for example. Content, like the body of the message or letter, can be shared across
these contexts. Templates are personalized using scripts and variable data. More advanced
users may edit the underlying HTML, CSS and JavaScript directly.

The following topics will help to quickly familiarize yourself with the Designer.

« "Designer basics" below. These are the basic steps for creating and developing a
template.

« "Features" on the next page. These are some of the key features in the Designer.

» "Designer User Interface" on page 420. This part gives an overview of all elements in the
Designer User Interface, like menus, dialogs and panes.

More help can be found here:

» Tutorials On Video: watch an introductory video, overview tutorials or practical how-to
videos.

« Forum: Browse the forum and feel free to ask questions about the use of Connect
software

o Demo site. Download demonstrations of OL products.

Designer basics

With the Designer you can create templates for personalized letters andemails, and generate
output from them.

These are the basic steps for creating and developing a template:

1. Create a template
Create a template, using one of the Template Wizards. See "Creating a template" on
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page 102.

2. Fill the template
Add text, images and other elements to the template and style them. See "Content
elements" on page 179 and "Styling and formatting" on page 270.

3. Personalize the content
Personalize the content using variable data. See "Personalizing content" on page 312.

4. Generate output
Adjust the settings, test the template and generate output: letters andemails. See
"Generating output" on page 856.

Note that steps 2 and 3 are not necessarily to be followed in this order. For example, as you
add elements to a template, you may start personalizing them right away, before adding other
elements to the template.

Features

The Designer is Connect's module to create templates for personalized customer
communications. These are some of the key features in the Designer:

"Templates" on the facing page. Start creating, using and sharing templates.
"Contexts" on page 109. A context contains one or more designs for one output channel:

« "Print" on page 115. This topic helps you design and fill sections in the Print context.
« "Email" on page 155. This topics helps you design an email template.

« Web. This topic helps you design a web page.

"Sections" on page 110. Sections in one context are designed for the same output channel.

"Content elements" on page 179. Elements make up the biggest part of the content of each
design.

"Snippets" on page 266. Snippets help share content between contexts, or insert content
conditionally.

"Styling and formatting" on page 270. Make your Designer templates look pretty and give them
the same look and feel with style sheets.
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"Personalizing content" on page 312. Personalize your customer communications using
variable data.

"Writing your own scripts" on page 360. Scripting can take personalization much further. Learn
how to script via this topic.

"Generating output" on page 856. Learn the ins and outs of generating output from each of the
contexts.

Templates

The Designeris a WYSIWYG (what you see is what you get) tool to create templates. This topic
gets you started. It explains how to create a template, what is found in a template file, and how
output can be generated.

Creating a template

In the Welcome screen that appears after startup, get off to a flying start choosing Template
Wizards. Scroll down to see all the Template Wizards. After deciding which output channel —
printoremail — will be prevalent in your template, select a template.

The Template Wizards can also be accessed from the menu: click File, click New, expand the
Template folder, and then expand one of the templates folders.

There are Wizards for the twotypes of output channels, or contexts as they are called in the
Designer: Print and Email.
See:

« "Creating an Email template with a Wizard" on page 160

« "Creating a Print template with a Wizard" on page 117
Tip

The quickest way to create a Print template based on a PDF file is to right-click the PDF
file in the Windows Explorer and select Enhance with Connect.
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After creating a template you can add the other contexts (see "Contexts" on page 109), as well
as extra sections (see "Sections" on page 110), to the template.

Itis, however, not possible to use a Template Wizard when adding a context or section to an
existing template.

Tip
If an Email context is going to be part of the template, it is recommended to start with an
Email Template Wizard; see "Creating an Email template with a Wizard" on page 160.

After creating a template, contexts can be added to it, but that can not be done with a
wizard.

Opening a template

To open a template from the Welcome screen, select Open File.
To open a template from the menu, select File > Open.
Then select the template file. A template file has the extension .OL-template.

The most recently opened templates and data mapping configurations are listed on the
Welcome screen and in the menu: File > Open Recent.
To clear these lists, select Window > Clear Recent Files Lists.

Warning

A template created in an older version of the software can be opened in a newer version.
However, opening and saving itin a newer version of the software will convert the
template to the newest file format. The converted template can't be opened in older
versions of the software.

Opening a package file

Templates can also be stored in a package file (see "Creating package files" on page 106). To
open a package file, switch the file type to Package files (*.OL-package) in the Open File
dialog. If the package contains Print Presets, you will be asked if you want to import them into
the proper repositories.
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Saving a template

A Designer template file has the extension .OL-template. It is a zip file that includes up to 3
contexts, all the related resources and scripts, and (optionally) a link to a data mapping
configuration.

To save a template, select File > Save or press Ctrl+S. The first time you'll have to give the
template a name. File > Save as allows you to save the template with a different name.

Tip
To quickly copy the name of any other file, set Save as type to Any file (*.*) in the Save

dialog. Select a file to put its name in the File name field. Then set Save as type to
Template files (*.OL-template) and save the template.

When more than one resource is open and the Designer software is closed, the Save
Resources dialog appears. This dialog displays a list of all open resources with their names
and file location. Selected resources will be saved, deselected resources will have all their
changes since they were last saved dismissed.

Saving older templates

Saving a template in a newer version of the software will convert the template to the newest file
format. This makes it unreadable to older versions of the software.

The warning message that is displayed in this case can be disabled.

To re-enable this message (and all other warning dialogs), go to Window > Preferences >
General, and click the Reset All Warning Dialogs button at the bottom.

Auto Save

After a template has been saved for the first time, Connect Designer can auto save the
template with a regular interval. To configure Auto Save:

1. Select the menu option Window > Preferences > Save.
2. Under Auto save, check the option Enable to activate the Auto Save function.

3. Change how often it saves the template by typing a number of minutes.
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Auto Backup

Connect Designer can automatically create a backup file when you manually save a template.
To configure Auto Backup:

Select the menu option Window > Preferences > Save.
Under Auto backup, check the option Enable to activate the Auto Backup function.

Type the number of revisions to keep.

B nh =

Select the directory in which the backups should be stored.

Backup files have the same name as the original template with two underscores and a
progressive number (without leading zeros) at the end: originalname__1.0OL-template,
originalname__2.0L-template, etc.

Note

The Auto Save function does not cause backup files to be created.

File properties

On the menu, select File > Properties to view and complement the file properties. See "File
Properties dialog" on page 440.

The file properties can also be used in scripts; see "template" on page 831. If you are not
familiar with writing scripts, refer to "Writing your own scripts" on page 360.

Sharing a template

To share a template, you can send the template file itself, or save the template to a package file,
optionally together with a Job Creation Preset and an Output Creation Preset. (See "Job
Creation Presets" on page 632 and "Output Creation Presets" on page 645 for more details.)

To create a package file, select File >Package file, see "Templates" on page 102. The
package file has the extension .OL-package and can be opened in the Designer (see "Opening
a package file" on page 103).
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Exporting a template report

A template report can be used for archiving purposes or to provide information about the
template to people who do not have access to Connect. Such a report can be exported in PDF
or XML format. By default it contains a summary of the template with an overview of all the
settings and resources that are used in the template: media, master pages, contexts, sections,
images, scripts etc. The file properties are included as well (see "File Properties dialog" on
page 440).

To open the Export Template Report wizard, select File > Export Report. For a description of
all options, see "Export Template Report wizard" on page 439.

Creating a custom template report

The Export Template Report wizard also offers the possibility to export custom template reports
(in PDF format only). A custom template report could contain another selection of information
and present that differently, e.g. with the logo of your company.

To create a custom template report, you need two files: A template design with the desired
layout and variable data. This .OL-template file has to be made in the Designer. A data
mapping configuration provides the variable data. You could use the data mapping
configuration made for the standard template report, or create another one in the DataMapper
module, using the standard XML template report as data sample.The DataMapper is included
only in PlanetPress Connect and PReS Connect. Data mapping configurations have the
extension .OL-datamapper. The following zip file contains both the template and data mapping
configuration that are used to generate the standard template report:
http://help.objectiflune.com/en/archive/report-template.zip.

Generating output from the Designer

Output can be generated directly from the Designer; see "Generating Print output” on page 857,
and"Generating Email output" on page 873.

To test a template first, select Context > Preflight. Preflights execute the template without
actually producing output and it displays any issues once it's done (see also: "Testing scripts"
on page 369).

Creating package files

The Package dialog saves templates and Print Presets as a Package file (*.OL-package).

Print Presets make it possible to do such things as filtering and sorting records, grouping
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documents and splitting the print jobs into smaller print jobs, as well as the more standard
selection of printing options, such as binding, OMR markings and the like. See "Job Creation
Presets" on page 632 and "Output Creation Presets" on page 645 for more details.

Package files can be opened by other Connect users.

To open the Package dialog, select File > Package.... For an explanation of the options in it,
see "Package dialog" on page 460.

Resources

This page clarifies the difference between Internal, External and Web resources that may be
used in a template, and explains how to refer to them in HTML and in scripts.

Internal resources

Internal resources are files that are added to and saved with the template. To add images, fonts,
style sheets, and snippets to your template, you can drag or copy/paste them into the
Resources Pane. See also: "Images" on page 252, "Snippets" on page 266, "Styling templates
with CSS files" on page 271 and "Fonts" on page 305.

Resource files can also be dragged or copy/pasted out of the the application to save them on a
local hard drive.

Once imported, internal resources are accessed using a relative path, depending where they're
called from. Resources can be located in the following folders:

« images/ contains the files in the Images folder.

« fonts/ contains the files in the Fonts folder.

css/ contains the files in the Stylesheets folder.

js/ contains the files in the JavaScripts folder.

snippets/ contains the files in the Snippets folder.

When refering to them, normally you would simply use the path directly with the file name. The
structure within those folders is maintained, so if you create a "signatures" folder within the
"Images" folder, you need to use that structure, for example in HTML: <img
src="images/signatures/johnsmith.gif">. In scripts, you can refer to them in the same way, for

example:
results.loadhtml ("snippets/en/navbar.html") ;
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See also: "Loading a snippet via a script" on page 379 and "Writing your own scripts" on
page 360.

Note

When referring to images or fonts from a CSS file, you need to remember that the current
path is css/, meaning you can't just call images/image.jpg. Use a relative path, for
example: #header { background-image: url('../images/image.jpg’); }

External resources

External resources are not stored in the template, but on the local hard drive or on a network
drive. They are accessed using a path. The path must have forward slashes, for example <img
src="file:/llc:[resources/images/signatures/johnsmith.gif"> or var json_variables = loadjson
("file:///d:/jsondatal/variables.json");. The complete syntax is: file://<host>/<path>. If the host

is "localhost", it can be omitted, as itis in the example, resulting in file:///<path>. The empty
string is interpreted as 'the machine from which the URL is being interpreted'.

Network paths are similar: results.loadhtml("file://servername/sharename/folder/snippet.html");
(note that in this case file is followed by 2 slashes only).

Some limitations

« Style sheets cannot refer to external resources.

o The Connect Server user needs access to whichever network path is used. If the network
path is on a domain, the Connect Server must be identified with domain credentials that
have access to the domain resources.

For more information on network paths, please see this Wikipedia entry: file URI scheme.

Web resources

Web resources are simply accessed using a full URL. This URL needs to be publicly
accessible: if you type in that URL in a browser on the server, it needs to be visible.
Authentication is possible only through URL Parameters
(http://www.example.com/data.json?user=username&password=password) or through HTTP
Basic Auth (http://username:password@www.example.com/data.json).
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Contexts

Contexts are parts of a template that are each used to generate a specific type of output: Email
or Print.

« The Print context outputs documents to either a physical printer or a PDF file; see "Print
context" on page 123.

o The Email context outputs HTML email, composed of HTML code with embedded CSS.
See "Email context" on page 163.

When a new template is made, the Context appropriate to that new template is automatically
created, including one section. After a template has been created, the other two contexts can be
added to it; see "Adding a context" on the facing page.

Tip
If an Email context is going to be part of the template, it is recommended to start with an
Email Template Wizard; see "Creating an Email template with a Wizard" on page 160.

After creating a template, contexts can be added to it, but that can not be done with a
wizard.

Outputting and combining contexts

All three contexts can be presentin any template and they can all be used to output documents;
see "Generating Email output" on page 873, "Generating Print output" on page 857 and
Generating Web output.

They can even be combined in output.

If present in the same template, a Print context and a Web context can be attached to an Email
context.

You could select Print sections based on a value in the data with a Conditional Print Sections
script; see "Conditional Print sections" on page 333.

Outputting other combinations of contexts, and selecting other sections based on a value in the
data, can be done via a Control Script; see "Control Scripts" on page 390.
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Adding a context

To add a context, right-click the Contexts folder on the Resources pane and click New print
context, New email context or New web context. Or use Context > Add in the main menu.

Only one context of each type can be presentin a template. Each context, however, can hold
more than one section; see "Sections" below.

Deleting a context

To delete a context, right-click the context on the Resources pane and click Delete.

Warning

If you don't have a backup of the template, the only way to recover a deleted section, is to
click Undo on the Edit menu, until the deleted section is restored. After closing and
reopening the template it is no longer possible to restore the deleted context this way.

In the Saving Preferences you can set whether a backup file should be created when you
save the template; see "Saving Preferences" on page 357.

Sections

Sections are parts of one of the contexts in a template: Print orEmail. They contain the main text
flow for the contents. In each of the contexts there can be multiple sections. A Print context, for
example, may consist of two sections: a covering letter and a policy.

Adding a section

To add a section to a context, right-click the context (Email orPrint) on the Resources pane,
and then click New section.

The new section has the same settings as the currently active section in the same context, or
the first section in the same context if another context is active.

Itis not possible to use a Template Wizard when adding a section to an existing template.
Tip

If an Email context is going to be part of the template, it is recommended to start with an
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Email Template Wizard; see "Creating an Email template with a Wizard" on page 160.
After creating a template, contexts can be added to it, but that can not be done with a
wizard.

Importing a section

To import a section from another template, click File > Import Resources... in the menu. See:
Import Resources dialog.
Remember to copy the related source files, such as images, to the other template as well.

Editing a section

To open a section, expand the Contexts folder on the Resources pane, expand the respective
context (Print orEmail) and double-click a section to open it.

Each section can contain text, images and many other elements (see "Content elements" on
page 179), including variable data and other dynamic elements (see "Personalizing content" on
page 312).

To preview a section, open the Preview tab in the Workspace (see "Workspace" on page 537).

Copying a section

To copy a section:

1. Open the context (EmailorPrint) on the Resources pane.
2. Right-=click the section and select Copy.

3. Right-click the context and select Paste. Note that sections cannot be pasted to another
context.

The copy will have the same settings as the original.
Alternatively you may copy the contents of a section manually:

1. Open the section that you want to copy and go to the Source tab in the workspace.

2. Copy the contents of the Source tab (press Ctrl+A to select everything and then Ctrl+C to
copy the selection).
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3. Add a new section (see "Adding a section" on page 110, above).
4. Go to the Source tab and paste the contents of the other section here (press Ctrl+V).

5. When copying a section to another template, add the related source files, such as images,
to the other template as well.

Tip
The easiest way to copy a section to another template, is to use the Import Resources dialog in
the other template. See: Import Resources dialog.

Deleting a section
To delete a section:

« On the Resources pane, expand the Contexts folder, expand the folder of the respective
context, right-click the name of the section, and then click Delete.

Warning

No backup files are maintained in the template. The only way to recover a deleted
section, is to click Undo on the Edit menu, until the deleted section is restored, or by
reverting to the last saved state (click File > Revert, on the menu). After closing and
reopening the template itis no longer possible to restore the deleted context this way.

Renaming a section

To rename a section:

« On the Resources pane, expand the Contexts folder, expand the folder of the respective
context, right-click the name of the section, and then click Rename.

Section properties

Which properties apply to a section, depends on the context it is part of. See also: "Print
sections" on page 127, "Email templates" on page 166, and Web pages.

To change the properties for a section:
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1. On the Resources pane, expand the Contexts folder.
2. Expand the folder of the respective context.

3. Right-click the name of the section, and then click one of the options.

Applying a style sheet to a section

In order for a style sheet to be applied to a specific section, it needs to be included in that
section. There are two ways to do this.

Drag & drop a style sheet

1. Click and hold the mouse button on the style sheet on the Resources pane.

2. Move the mouse cursor within the Resources pane to the section to which the style sheet
should be applied.

3. Release the mouse button.

Using the Includes dialog

1. On the Resources pane, right-click the section, then click Includes.
2. From the File types dropdown, select Stylesheets.

3. Choose which CSS files should be applied to this section. The available files are listed at
the left. Use the arrow buttons to move the files that should be included to the list at the
right.

4. You can also change the order in which the CSS files are read: click one of the included
CSS files and use the Up and Down buttons. Note that moving a style sheet up in the list

gives it less weight. In case of conflicting rules, style sheets read later will override
previous ones.

Note

Style sheets are applied in the order in which they are included in a section. The styles in
each following style sheet add up to the styles found in previously read style sheets.
When style sheets have a conflicting rule for the same element, class or ID, the last style
sheet ‘wins’ and overrides the rule found in the previous style sheet.
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Note

Style sheets that are linked to (i.e. included in) a section show a chain icon in the
Resources pane (see "Resources pane" on page 525).

Arranging sections

Changing the order of the sections in a context can have an effect on how they are outputted;
see: "Print sections" on page 127, "Email templates" on page 166 and Web pages.

To rearrange sections in a context:

« On the Resources pane, expand the Contexts folder, expand the folder of the respective
context, and then drag and drop sections to change the order they are in.
Alternatively, right-click a section and click Arrange. In the Arrange Sections dialog you
can change the order of the sections in the same context by clicking the name of a section
and moving it using the Up and Down buttons.

Outputting sections

Which sections are added to the output, depends on the type of context they are in.

When generating output from the Print context, each of the Print sections is added to the output
document, one after the other in sequence, for each record. The sections are added to the
output in the order in which they appear on the Resources pane. See "Generating Print output”
on page 857.

In Email output, only one section can be outputted at a time. The section that will be outputis
the section that has been set as the 'default'. See "Generating Email output" on page 873 and
"Email templates" on page 166.

Itis, however, possible to include or exclude Print sections when the output is generated,
depending on a value in the data. A Control Script can do this; see "Control Scripts" on

page 390.

See "Generating output" on page 856 to learn how to generate Print documents or Email.
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Print

Connect supports a number of different types of print outputs. These include:

o AFP

« IPDS (spool file created by Connect, with printer control available through the "Print
Manager" on page 884)

« PCL
. PDF
o PostScript (including the PPML, VIPP and VPS variants)

With the Designer you can create one or more Print templates and merge the template with a
data set to generate personal letters, invoices, policies, or any other type of letter you can think
of.

The Print context is the folder in the Designer that can contain one or more Print sections.

Print templates (also called Print sections), are part of the Print context. They are meant to be
printed directly to a printer or a printer stream/spool file, or to a PDF file (see "Generating Print
output" on page 857).

The Print context can also be added to Email output as a PDF attachment; see "Generating
Email output" on page 873.

When generating output from the Print context, each of the Print sections is added to the output
document, one after the other in sequence, for each record.

When a Print template is created or when a Print context is added to an existing template the
Print context folder is created along with other folders and files that are specific to a Print
context (see "Creating a Print template with a Wizard" on page 117, "Adding a context" on
page 110 and "Print context" on page 123).

Only one Print section is created at the start, but you can add as many Print sections as you
need; see "Print sections" on page 127.

Pages

Unlike emails, Print sections can contain multiple pages. Pages are naturally limited by their
size and margins. If the content of a section doesn't fit on one page, the overflow goes to the
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next page. This happens automatically, based on the section's page size and margins; see
"Page settings: size, margins and bleed" on page 138.

The minimum number of pages can be set via the Print section properties; see "Print section
properties" on page 481.

Although generally the same content elements can be used in all three contexts (see "Content
elements" on page 179), the specific characteristics of pages make it possible to use special
elements, such as page numbers; see "Page numbers " on page 139.

See "Pages" on page 137 for an overview of settings and elements that are specific for pages.

Headers, footers, tear-offs and repeated elements
(Master page)

In Print sections, there are often elements that need to be repeated across pages, like headers,
footers and logos. In addition, some elements should appear on each first page, or only on
pages in between the first and the last page, or only on the last page. Examples are a different
header on the first page, and a tear-off slip that should show up on the last page.

This is what Master Pages are used for. Master Pages can only be used in the Print context.

See "Master Pages" on page 145 for an explanation of how to fill them and how to apply them
to different pages.

Stationery (Media)

When the output of a Print context is meant to be printed on paper that already has graphical
and text elements on it (called stationery, or preprinted sheets), you can add a copy of this
media, in the form of a PDF file, to the Media folder.

Media can be applied to pages in a Print section, to make them appear as a background to
those pages. This ensures that elements added to the Print context will correspond to their
correct location on the preprinted media.

When both Media and a Master Page are used on a certain page, they will both be displayed
on the Preview tab of the workspace, the Master Page being 'in front' of the Media and the Print
section on top. To open the Preview tab, click it at the bottom of the Workspace or select View >
Preview View on the menu.
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The Media will not be printed, unless this is specifically requested through the printer settings in
the Print Wizard; see "Generating Print output" on page 857.

See "Media" on page 148 for further explanation about how to add Media and how to apply
them to different pages.

Copy Fit
Copy Fit is a feature to automatically adjust the font size of text to make it fit the available space. It could
be used for the name of a person on a greeting card, for instance, or for the name of a product on a shelf

talker. This feature is only available with Box and Div elements in Print sections.
For more information about this feature see "Copy Fit" on page 285.

Creating a Print template with a Wizard

A Print template may consist of various parts, such as a covering letter and a policy. Start with
one of the Template Wizards for the first part; other parts (called 'sections') can be added later.

Print template wizards can be found in the Welcome screen and on the File menu.

In the Welcome screen that appears after startup:

« Choose Template Wizards and scroll down until you see the Basic Print templates or
ERP templates and select one of them.

e Orchoose New Template and select PDF-based Print.
Alternatively, on the menu select File > New, expand the Template folder, and then:

o Select PDF-based Print.

« Orexpand the Basic Print templates or ERP templates folder, select a template type
and click Next.

Another way to start a PDF-based Print template is this:

e Right-click the PDF file in the Windows Explorer and select Enhance with Connect.

The various template types and their options are described below.
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See "Print context" on page 123 and "Print sections" on page 127 for more information about
Print templates.

Tip
Use the Outline pane at the left to see which elements are present in the template and to
select an element.

Use the Attributes pane at the right to see the current element's ID, class and some other
properties.

Use the Styles pane next to the Attributes pane to see which styles are applied to the
currently selected element.

Basic Print template wizards

There are two 'basic' Print Template wizards: one for a formal letter, and one for a postcard.

Postcard

The Postcard Wizard lets you choose a page size and two background images, one for the front
and one for the back of the postcard.

When you click Finish, the Wizard creates:

A Print context with one section in it, that has duplex printing (printing on both sides)
enabled. See "Printing on both sides" on page 125.

« Two Master Pages that each contain a background image. The first Master Page is
applied to the front of every page in the Print section. The second Master Page is applied
to the back of every page in the Print section. See "Master Pages" on page 145.

« Scripts and selectors for variable data. The Scripts pane shows, for example, a script
called "first_ name". This script replaces the text "@first nhame@" on the front of the
postcard by the value of a field called "first name" when you open a data set that has a
field with that name. See "Variable Data" on page 322.

« A script called Dynamic Front Image Sample. This script shows how to toggle the image
on the front page dynamically. See also "Writing your own scripts" on page 360.

« One empty Media. Media, also called Virtual Stationery, can be applied to all pages in the
Print section. See "Media" on page 148.
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The Wizard opens the Print section, so that you can fill it with text and other elements; see
"Content elements" on page 179. It already has two Positoned Boxes on it: one on the front, for
text, and one on the back, for the address.

See "Print context" on page 123 and "Print sections" on page 127 for more information about
Print templates.

Formal letter

The Formal Letter Wizard first lets you select the page settings, see "Page settings: size,
margins and bleed" on page 138.

These settings are fairly self-explanatory, except perhaps these:

o Duplex means double-sided printing.

« The margins define where your text flow will go. The actual printable space on a page
depends on your printer.

« The bleed is the printable space around a page. It can be used on some printers to
ensure that no unprinted edges occur in the final timmed document. Printers that can’t
print a bleed, will misinterpret this setting. Set the bleed to zero to avoid this.

« The number of sections is the number of parts in the Print context. Although this Template
wizard can add multiple Print sections to the Print context, it will only add content to the
first section.

On the next settings page (click Next to go there), you can type a subject, the sender's name
and the sender's title. These will appear in the letter. You can also:

« Click the Browse button to select a signature image. This image will appear above the
sender's name and title.

» Select Virtual Stationery: a PDF file with the letterhead stationery. Also see Media.

When you click Finish, the Wizard creates:

« A Print context with one section in it; see "Print context" on page 123 and "Print sections"
on page 127.

« One empty Master Page. Master Pages are used for headers and footers, for images and
other elements that have to appear on more than one page, and for special elements like
tear-offs. See "Master Pages" on page 145.
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« One Media. You can see this on the Resources pane: expand the Media folder. Media 1
is the Virtual Stationery that you have selected in the Wizard. Itis applied to all pages in
the Print section, as can be seen in the Sheet Configuration dialog. (To open this dialog,
expand the Contexts folder on the Resources pane; expand the Print folder and right-
click "Section 1"; then select Sheet Configuration.) See "Media" on page 148.

« Selectors for variable data, for example: @Recipient@. You will want to replace these by
the names of fields in your data. See "Variable Data" on page 322.

The Wizard opens the Print section. You can add text and other elements; see "Content
elements" on page 179.

The formal letter template already has an address on it. The address lines are paragraphs,
located in one cell in a table with the ID address-block-table. As the table has no borders, itis
initially invisible. The address lines will stick to the bottom of that cell, even when the address
has fewer lines. See "Styling and formatting" on page 270 to learn how to style elements.

Tip

Click the Edges button on the toolbar t emporarily adds a frame to certain elements on
the Design tab. These will not .Print or output.

PDF-based Print template

Tip
The quickest way to create a Print template based on a PDF file is to right-click the PDF
file in the Windows Explorer and select Enhance with Connect.

The PDF-based Print template wizard creates a document from an existing PDF file: a
brochure, voucher, letter, etc. The PDF is used as the background image of the Print section
(see "Using a PDF file as background image" on page 132). Variable and personalized
elements, like a reseller address, voucher codes and so on, can be added in front of it (see
"Personalizing content" on page 312 and "Variable Data" on page 322).

By default, the PDF itself is added to the Image folder located in the Resources pane.
Uncheck the option Save with template if the PDF should not be imported in the template. If it
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isn't saved with the template, the image remains external. Note that external images need to be
available when the template is merged with a record set to generate output, and that their
location should be accessible from the machine on which the template's output is produced.
External images are updated (retrieved) at the time the output is generated.

After clicking Next, you can change the settings for the page. The initial page size and bleed
area are taken from the selected PDF.

When you click Finish, the Wizard creates:

« A Print context with one section in it; see "Print context" on page 123 and "Print sections"
on page 127. The selected PDF is used as the background of the Print section; see
"Using a PDF file as background image" on page 132. For each page in the PDF one
page is created in the Print section.

« One empty Master Page. Master Pages are used for headers, footers, images and other
elements that have to appear on more than one page, and for special elements like tear-
offs. See "Master Pages" on page 145.

« One empty Media. Media, also called Virtual Stationery, can be applied to all pages in the
Print section. See "Media" on page 148.

ERP templates

The ERP template wizard creates a business document. There is a collection of business
documents that you can choose from: Sales Invoice, Purchase Order, Collection Letter, etc..
Currently all of these documents follow the corporate style designed by Microspective.

The first page of the wizard lets you select the page settings, see "Page settings: size, margins
and bleed" on page 138. A few clarifications:

o Duplex means double-sided printing.

« The margins define where your text flow will go. The actual printable space on a page
depends on your printer.

« The bleed is the printable space around a page. It can be used on some printers to
ensure that no unprinted edges occur in the final timmed document. Printers that can’t
print a bleed, will misinterpret this setting. Set the bleed to zero to avoid this.

« The number of sections is the number of parts in the Print context. Although this Template
wizard can add multiple Print sections to the Print context, it will only add content to the
first section.
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On the next settings page (click Next to go there):

e Choose the desired type of business document from the General drop-down.
» Select a color for the colored parts of the document; see "Color Picker" on page 436.
« Enter your contact details.

« Click the Browse button to select a logo, or select to use a placeholder logo or no logo at
all.

« Select a PDF file with the letterhead stationery. Also see "Media" on page 148.

Tip
Nice to know: your info and preferences are saved and will be reused the next time you create an
ERP template.

When you click Finish, the Wizard creates:

« A Print context with one section in it; see "Print context" on the next page and "Print
sections" on page 127.

« One Master Page. Master Pages are used for headers and footers, for images and other
elements that have to appear on more than one page, and for special elements like tear-
offs. See "Master Pages" on page 145.

« One Media. You can see this on the Resources pane: expand the Media folder. Media 1
is the Virtual Stationery that you have selected in the Wizard. It is applied to all pages in
the Print section, as can be seen in the Sheet Configuration dialog. (To open this dialog,
expand the Contexts folder on the Resources pane; expand the Print folder and right-
click "Section 1"; then select Sheet Configuration.) See "Media" on page 148.

» Selectors for variable data, for example: @Name@, @Amount@. You will want to
replace these by the names of actual fields in your data. See "Variable Data" on
page 322.

The Wizard opens the Print section. You can add text and other elements; see "Content

elements" on page 179. See "Styling and formatting" on page 270 to learn how to style
elements..
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Print context

The Print context is the folder in the Designer that can contain one or more Print templates.

Print templates (also called Print sections), are part of the Print context. They are meant to be
printed directly to a printer or a printer stream/spool file, or to a PDF file (see "Generating Print
output" on page 857).

The Print context can also be added to Email output as a PDF attachment; see "Generating
Email output" on page 873.

When generating output from the Print context, each of the Print sections is added to the output
document, one after the other in sequence, for each record.

Creating the Print context

You can start creating a Print template with a Wizard (see "Creating a Print template with a
Wizard" on page 117), or add the Print context to an existing template (see "Adding a context"
on page 110).

Tip

Editing PDF files in the Designer is not possible, but when they're used as a section's
background, you can add text and other elements, such as a barcode, to them.

The quickest way to create a Print template based on a PDF file is to right-click the PDF
file in the Windows Explorer and select Enhance with Connect. Alternatively, start
creating a new Print template with a Wizard, using the PDF-based Print template (see
"Creating a Print template with a Wizard" on page 117).

To use a PDF file as background image for an existing section, see "Using a PDF file as
background image" on page 132.

When a Print template is created, the following happens:

» The Print context is created and one Print section is added to it. You can see this on the
Resources pane: expand the Contexts folder, and then expand the Print folder.
The Print context can contain multiple sections: a covering letter and a policy, for
example, or one section that is meant to be attached to an email as a PDF file and
another one that is going to be printed out on paper. Only one Print section is added to it
at the beginning, but you can add as many print sections as you need; see "Adding a
Print section" on page 129.
See "Print sections" on page 127 to learn how to fill a Print section.
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« One Master Page is added to the template, as can be seen on the Resources pane, in
the Master Page folder.

In Print sections, there are often elements that need to be repeated across pages, like
headers, footers and logos. In addition, some elements should appear on each first page,
or only on pages in between the first and the last page, or only on the last page.
Examples are a different header on the first page, and a tear-off slip that should show up
on the last page.

This is what Master Pages are used for. Master Pages can only be used in the Print
context.

See "Master Pages" on page 145.

Initially, the (empty) master page that has been created with the Print context will be
applied to all pages in the Print section, but more Master Pages can be added and
applied to different pages.

« One Media is added to the template, as is visible on the Resources pane, in the Media
folder. This folder can hold the company's stationery in the form of PDF files. When
applied to a page in a Print section, Media can help prevent the contents of a Print section
from colliding with the contents of the stationery. See "Media" on page 148 to learn how to
add Media and, optionally, print them.

Initially, the (empty) media that has been created with the Print context, is applied to all
pages in the Print section. You can add more Media and apply them each to different
pages.

« One Stylesheet, named context_print_styles.css, is added to the template, as you can
see on the Resources pane, in the Stylesheets folder. This stylesheetis meant to be

used for styles that are only applied to elements in the Print context. See also "Styling
templates with CSS files" on page 271.

Print settings in the Print context and sections

The following settings in the Print context and Print sections have an impact on how the Print
context is printed.

Arranging and selecting sections

The Print context can contain one or more Print sections. When generating output from the Print
context, each of the Print sections is added to the output document, one after the other in
sequence, for each record. The sections are added to the output in the order in which they
appear on the Resources pane. This order can be changed; see "Print sections" on page 127.
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Itis also possible to exclude sections from the output, or to include a section only on a certain
condition that depends on a value in the data; see "Conditional Print sections" on page 333.
This can also be done using a Control Script; see "Control Scripts" on page 390.

Printing on both sides

To print a Print section on both sides of the paper, that Print section needs to have the Duplex
printing option to be enabled; see "Enabling double-sided printing (Duplex, Mixplex)" on
page 135. This setting can not be changed in a Job Creation Preset or an Output Creation
Preset.

Note

Your printer must support duplex for this option to work.

Setting the binding style for the Print context

The Print context , as well as each of the Print sections, can have its own Finishing settings. In
printing, Finishing is the way pages are bound together after they have been printed. Which
binding styles can be applied depends on the type of printer that you are using.

To set the binding style of the Print context:

1. On the Resources pane, expand the Contexts folder; then right-click the Print context
and select Finishing.
Alternatively, select Context > Finishing on the main menu. This option is only available
when editing a Print section in the Workspace.

2. Choose a Binding style and, if applicable, the number of holes. For an explanation of all
Binding and Hole making options, see "Finishing options" on page 643.

To set the binding style of a Print section, see "Setting the binding style for a Print section" on
page 135.

Overriding binding styles in a job creation preset

A Job Creation Preset can override the binding styles set for the Print sections and for the Print
context as a whole. To bind output in another way than defined in the template’s settings:
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1. Create a Job Creation Preset that overrides the settings of one or more sections: select
File > Presets and see "Job Creation Presets" on page 632 for more details.

2. Select that Job Creation Preset in the Print wizard; see "Generating Print output" on
page 857.

Setting the bleed

The bleed is the printable space around a page. It can be used on some printers to ensure that
no unprinted edges occur in the final trimmed document. The bleed is one of the settings for a
section. See "Page settings: size, margins and bleed" on page 138.

Overprint and black overprint

Normally, when two colors overlap in Print output, the underlying color is not printed. It is
"knocked out", for two reasons: firstly, the underlying color may affect the top color, especially if
the top color is lighter than the underlying color. Secondly, not printing an underlying color,
which is not visible anyway, will save ink or toner.

However, there are cases when underlying colors should not be knocked out:

« Ifthe top color is a special ink or toner, such as varnish or UV, it should go over any
other colors, as itis meant to be transparent and go over other content. In Connect you
may enable overprint when you define a spot color; see "Defining colors, spot colors and
tints" on page 301.

« If small black text is printed over a colored area, mis-registration may cause white areas
to be visible around the text if the underlying color is knocked out.

The option to print small black text over other colors is referred to as black overprint. To
enable black overprint for text smaller than a given size:

1. Right-click the Print context in the Resources pane and select Color Output.

2. In the Text smaller than field, enter a text size (in points, for example: 3pt).

Note
Black overprint only works with CMYK black.
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Converting RGB black to CMYK black

In Print output, black is by default output as a CMYK color. RGB black is converted into CMYK
black.
If that is not desirable for any reason, it is possible to prevent it:

1. Right-click the Print context in the Resources pane and select Color Output.

2. Enable the Keep RGB black in output option.

In Connect versions prior to 2018.2, RGB black was not automatically converted to CMYK
black. Therefore, this option is by default enabled in templates made with an earlier version.
In new templates, this option is disabled by default.

Print sections

Print templates (also called Print sections), are part of the Print context. They are meant to be
printed directly to a printer or a printer stream/spool file, or to a PDF file (see "Generating Print
output" on page 857).

The Print context can also be added to Email output as a PDF attachment; see "Generating
Email output" on page 873.

When generating output from the Print context, each of the Print sections is added to the output
document, one after the other in sequence, for each record.

Pages

Unlike emails, Print sections can contain multiple pages. Pages are naturally limited by their
size and margins. If the content of a section doesn't fit on one page, the overflow goes to the
next page. This happens automatically, based on the section's page size and margins; see
"Page settings: size, margins and bleed" on page 138.

The minimum number of pages can be set via the Print section properties; see "Print section
properties" on page 481.

Although generally the same content elements can be used in all three contexts (see "Content
elements" on page 179), the specific characteristics of pages make it possible to use special

elements, such as page numbers; see "Page numbers " on page 139.

See "Pages" on page 137 for an overview of settings and elements that are specific for pages.
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Using headers, footers, tear-offs and repeated elements

In Print sections, there are often elements that need to be repeated across pages, like headers,
footers and logos. In addition, some elements should appear on each first page, or only on
pages in between the first and the last page, or only on the last page. Examples are a different
header on the first page, and a tear-off slip that should show up on the last page.

This is what Master Pages are used for. Master Pages can only be used in the Print context.

See "Master Pages" on page 145 for an explanation of how to fill them and how to apply them
to different pages.

Using stationery (Media)

When the output of a Print context is meant to be printed on paper that already has graphical
and text elements on it (called stationery, or preprinted sheets), you can add a copy of this
media, in the form of a PDF file, to the Media folder.

Media can be applied to pages in a Print section, to make them appear as a background to
those pages. This ensures that elements added to the Print context will correspond to their
correct location on the preprinted media.

Note

When both Media and a Master Page are used on a certain page, they will both be
displayed on the Preview tab of the workspace, the Master Page being 'in front' of the
Media and the Print section on top. To open the Preview tab, click it at the bottom of the
Workspace or select View > Preview View on the menu.

See "Media" on page 148 for a further explanation about how to add Media and how to apply
them to different pages.

Note: The Media will not be printed, unless this is specifically requested through the printer
settings; see "Generating Print output" on page 857.

Copy Fit

Copy Fitis a feature to automatically adjust the font size of text to make it fit the available
space. It could be used for the name of a person on a greeting card, for instance, or for the
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name of a product on a shelf talker. This feature is only available with Box and Div elements in
Print sections.

For more information about this feature see "Copy Fit" on page 285.

Adding a Print section

The Print context can contain multiple sections: a covering letter and a policy, for example, or
one section that is meant to be attached to an email as a PDF file and another one that is meant
to be printed out on paper. When a Print template is created (see "Creating a Print template
with a Wizard" on page 117 and "Print context" on page 123), only one Print section is added to
it, but you can add as many print sections as you need.

To add a section to a context:

« On the Resources pane, expand the Contexts folder, right-click the Print context , and
then click New section.

Note that the new section automatically gets the same properties as the first section.

The first Master Page (see "Master Pages" on page 145) and Media (see "Media" on page 148)
will automatically be applied to all pages in the new section, but this can be changed, see
"Applying a Master Page to a page in a Print section" on page 147 and "Applying Media to a
page in a Print section" on page 152.

Note that Print sections always start on a front page. To avoid empty pages between sections,
consider combining them into one section, and use page breaks to push content to the next
page (see "Page breaks" on page 143).

Tip

Editing PDF files in the Designer is not possible, but when they're used as a section's
background, you can add text and other elements, such as a barcode, to them.

The quickest way to create a Print template based on a PDF file is to right-click the PDF
file in the Windows Explorer and select Enhance with Connect. Alternatively, start
creating a new Print template with a Wizard, using the PDF-based Print template (see
"Creating a Print template with a Wizard" on page 117).

To use a PDF file as background image for an existing section, see "Using a PDF file as
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background image" on page 132.

Note

Via a Control Script, sections can be added to a Print context dynamically; see
"Dynamically adding sections (cloning)" on page 400.

Tip
If you need a whole Print section to be visible in the output only under certain conditions,

consider using the Conditional Print Section script wizard; see "Conditional Print
sections" on page 333.

You can use the Conditional Content script wizard to hide parts of the content of a
section; see "Showing content conditionally" on page 330.

Deleting a Print section
To delete a Print section:

« On the Resources pane, expand the Contexts folder, expand the Print context, right-
click the name of the section, and then click Delete.

Warning

If you don't have a backup of the template, the only way to recover a deleted section, is to
click Undo on the Edit menu, until the deleted section is restored. After closing and
reopening the template itis no longer possible to restore the deleted context this way.

In the Saving Preferences you can set whether a backup file should be created when you
save the template; see "Saving Preferences" on page 357.

Arranging Print sections

When generating output from the Print context, each of the Print sections is added to the output
document, one after the other in sequence, for each record. The sections are added to the
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output in the order in which they appear on the Resources pane, so changing the order of the
sections in the Print context changes the order in which they are outputted to the final
document.

To rearrange sections in a context:

« On the Resources pane, expand the Print context and drag and drop sections to change
the order they are in.

« Alternatively, on the Resources pane, right-click a section in the Print context and click
Arrange. In the Arrange Sections dialog you can change the order of the sections by
clicking the name of a section and moving it using the Up and Down buttons.

Styling and formatting a Print section

The contents of a Print section can be formatted directly, or styled with Cascading Style Sheets
(CSS). See "Styling and formatting" on page 270.

In order for a style sheet to be applied to a specific section, it needs to be included in that
section. There are two ways to do this.

Drag & drop a style sheet

1. Click and hold the mouse button on the style sheet on the Resources pane.

2. Move the mouse cursor within the Resources pane to the section to which the style sheet
should be applied.

3. Release the mouse button.

Using the Includes dialog

1. On the Resources pane, right-click the section, then click Includes.
2. From the File types dropdown, select Stylesheets.

3. Choose which CSS files should be applied to this section. The available files are listed at
the left. Use the arrow buttons to move the files that should be included to the list at the
right.

4. You can also change the order in which the CSS files are read: click one of the included
CSS files and use the Up and Down buttons. Note that moving a style sheet up in the list
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gives it less weight. In case of conflicting rules, style sheets read later will override
previous ones.

Note

Style sheets are applied in the order in which they are included in a section. The styles in
each following style sheet add up to the styles found in previously read style sheets.
When style sheets have a conflicting rule for the same element, class or ID, the last style
sheet ‘wins’ and overrides the rule found in the previous style sheet.

Note

Style sheets that are linked to (i.e. included in) a section show a chain icon in the
Resources pane (see "Resources pane" on page 525).

Using a PDF file as background image

In the Print context, a PDF file can be used as a section's background. It is different from the
Media in that the section considers the PDF to be content, so the number of pages in the
section will be the same as the number of pages taken from the PDF file.

With this feature it is possible to create a Print template from an arbitrary PDF file. Of course,
the PDF file itself can't be edited in a Designer template, but when it is used as a section's
background, text and other elements, such as a barcode, can be added to it.

Encrypted PDF files are not supported in PDF pass-through mode.
To use a PDF file as background image:

1. On the Resources pane, expand the Print context, right-click the print section and click
Background.

2. Click the downward pointing arrow after Image and select From PDF resource.

3. Fora PDF resource, you have to specify the path. Clicking the Select Image button
opens the Select Image dialog (see "Select Image dialog" on page 484).

4. « Click Resources, Disk or Url, depending on where the image is located.
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« Resources lists the images that are present in the Images folder on the
Resources pane.

» Disk lists image files that reside in a folder on a hard drive that is accessible
from your computer. Click the Browse button to select a folder (or an image in
a folder).
As an alternative it is possible to enter the path manually. You can give a local
path (e.g. C:\Images\Test.jpg) or use the "file" protocol. The complete syntax of
a fully qualified URL with the "file" protocol is: file://<host>/<path>.
Note: if the host is "localhost", it can be omitted, resulting
infile:///<path>,forexample:
file:///c:/resources/images/image. jpg.

« Urllists image files from a specific web address. Select the protocol (http or
https), and then enter a web address (for example,
http://www.mysite.com/images/image.jpg).

Note

If a URL doesn't have a file extension, and the option Save with template is
not selected, the Select Image dialog automatically adds the filetype
parameter with the file extension as its value (for example: ?filetype=pdf
(ifitis the first parameter) or camp; filetype=pdf).

The filetype, page and nopreview parameters are not sent to the host;
they are used internally. Therefore, URLs that rely on one of these parameters
cannot be used.

« With an external image, you can check the option Save with template. If this option
is checked, the file will be inserted in the Images folder on the Resources pane at
the top left.

If itisn't saved with the template, the image remains external. Note that external
images need to be available when the template is merged with a record set to
generate output, and that their location should be accessible from the machine on
which the template's output is produced. External images are updated (retrieved) at
the time the output is generated.
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5. Selectthe PDF's position:
« Fit to page stretches the PDF to fit the page size.
« Centered centers the PDF on the page, vertically and horizontally.

« Absolute places the PDF at a specific location on the page. Use the Top field to
specify the distance between the top side of the page and the top side of the PDF,
and the Left field to specify the distance between the left side of the page and the
left side of the PDF.

The Top and Left offset can be specified in the usual units of measurement or as a
percentage of the page (for example: a Left value of 25% means it will be placed at
25% of the page width).

6. Setthe scale of the image as a percentage of the original image.
7. Click one of the options next to Rotation to rotate the image.

8. Optionally, if the PDF has more than one page, you can set the range of pages that
should be used.

Note

The number of pages in the Print section is automatically adjusted to the number of
pages in the PDF file that are being used as the section's background image.

9. Finally, click OK.

Note

To set the background of a section in script, you need a Control Script; see "Control
Script: Setting a Print section's background" on page 398.

The settings made in the Control Script take precedence over the settings made in the
Print Section Properties dialog.

Tip
An alternative to using a PDF as background inside the template is to layer the template
(i.e. the PDF output of a Print section) over the background PDF via a Scripttask in a
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Workflow process. This is called 'stamping'. In the unusual case where extracting text
from the PDF that is the output of a Print section with a PDF background doesn't work, it
is recommended to use this method. For more information, see this how-to: Stamping one
PDF file on another.

Setting the binding style for a Print section

In printing, Finishing is the binding style, or the way pages are bound together. Each Print
section can have its own Finishing settings, as well as the Print context as a whole; see
"Setting the binding style for the Print context" on page 125.

To set the binding style of a Print section:

1. On the Resources pane, expand the Contexts folder, expand the Print context and right-
click the Print section.

2. Click Finishing.

3. Choose a Binding style and, if applicable, the number of holes.

Overriding binding styles in a job creation preset
A Job Creation Preset can override the binding styles set for the Print sections and for the Print
context as a whole. To bind output in another way than defined in the template’s settings:

1. Create a Job Creation Preset that overrides the settings of one or more sections: select
File > Presets and see "Job Creation Presets" on page 632 for more details.

2. Select that Job Creation Preset in the Print wizard; see "Generating Print output" on
page 857.

Enabling double-sided printing (Duplex, Mixplex)

To print a Print section on both sides of the paper, that Print section needs to have the Duplex
printing option to be enabled. This is an option in the Sheet Configuration dialog. (See "Sheet
Configuration dialog" on page 485.)
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Note

Your printer must support Duplex for this option to work.

To enable Duplex or Mixplex printing:

1. On the Resources pane, expand the Print context, right-click the print section and click
Sheet configuration.

2. Check Duplex to enable content to be printed on the back of each sheet.
3. When Duplex printing is enabled, further options become available.

« Check Omit empty back side for Last or Single sheet to reset a page to Simplex
if it has an empty back side. This changes the Duplex job into a Mixplex job.
Thus changing a Duplex job into a Mixplex job may reduce volume printing costs
as omitted back sides aren'tincluded in the number of printed pages.

Empty means that there is no content and no master page on that side. To
suppress the master page on emtpy back sides and single sheets, check the option
Omit Master Page Back in case of an empty back page.

Note

Use a print format that supports Duplex/Simplex switching to get a proper
Mixplex job. PDF is not suitable as it has no device control.

Print sections always start on a front page. To avoid empty pages between
sections, consider combining them into one section, and use page breaks to
push content to the next page (see "Page breaks" on page 143).

o Check Tumble to duplex pages as in a calendar.

« Check Facing pages to have the side margins switched alternately, so that after
printing and binding the pages, they look like in a magazine or book. See "Pages"
on the next page to find out how to set a left and right margin on a page.

Note

Master Pages, Media and Duplex printing options can also be set in a Control Script (see "Control
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Scripts" on page 390 and "Control Script API" on page 811). This is especially useful when you
need identical sections with different settings.

Pages

Unlike emails, Print sections can contain multiple pages. Pages are naturally limited by their
size and margins. If the content of a section doesn't fit on one page, the overflow goes to the
next page. This happens automatically, based on the section's page size and margins; see
"Page settings: size, margins and bleed" on the facing page.

The minimum number of pages can be set via the Print section properties; see "Print section
properties" on page 481.

Although generally the same content elements can be used in all three contexts (see "Content
elements" on page 179), the specific characteristics of pages make it possible to use special
elements, such as page numbers; see "Page numbers " on page 139.

The widow/orphan setting lets you control how many lines of a paragraph stick together, when
content has to move to another page; see "Preventing widows and orphans" on page 142. You
can also avoid or force a page break before or after an entire element, see "Page breaks" on
page 143.

Each page in a print section has a natural position: it is the first page, the last page, a 'middle’
page (a page between the first and the last page) or a single page. For each of those positions,
a different Master Page and Media can be set. A Master Page functions as a page's
background, with for example a header and footer. A Media represents preprinted paper that a
page can be printed on. See "Master Pages" on page 145 and "Media" on page 148.

Page specific content elements

The specific characteristics of pages make it possible to use these special elements:

« Page numbers can only be used in a Print context. See "Page numbers " on page 139 to
learn how to add and change them.

» Conditional content and dynamic tables, when used in a Print section, may or may not
leave an empty space at the bottom of the last page. To fill that space, if there is any, an
image or advert can be used as a whitespace element; see "Whitespace elements:
using optional space at the end of the last page" on page 139.
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 Detail tables can be used in all contexts, but transport lines are only useful in a Print
context; see Detail Table.

Positioning and aligning elements
Sometimes, in a Print template, you don't want content to move up or down with the text flow.
To prevent that, put that contentin a Positioned Box. See "Content elements" on page 179.

When it comes to positioning elements on a page, Guides can be useful, as well as Tables.
See "How to position elements" on page 286.

Page settings: size, margins and bleed

On paper, whether it is real or virtual, content is naturally limited by the page size and margins.
These, as well as the bleed, are set per Print section, as follows:

« On the Resources pane, right-click a section in the Print context and click Properties.

For the page size, click the drop-down to select a page size from a list of common paper sizes.
Changing the width or height automatically sets the page size to Custom.

Margins define where your text flow will go. Static elements can go everywhere on a page, that
is to say, within the printable space on a page that depends on the printer.

The bleed is the printable space around a page. It can be used on some printers to ensure that
no unprinted edges occur in the final timmed document. Note: Printers that can’t print a bleed,
will misinterpret this setting. Set the bleed to zero to avoid this.

Tip

By default, measurements settings are in inches (in). You could also type measures in
centimeters (add 'cm' to the measurement, for example: 20cm) or in millimeters (for
example: 150mm).

To change the default unit for measurement settings to centimeters or millimeters: on the
menu, select Window > Preferences > Print > Measurements.
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Whitespace elements: using optional space at the end of the last page

Print sections with conditional content and dynamic tables (see "Personalizing content" on
page 312) can have a variable amount of space at the bottom of the last page. Itis useful to fill
the empty space at the bottom with transpromotional material, but of course you don’t want
extra pages created just for promotional data. 'Whitespace elements' are elements that will only
appear on the page if there is enough space for them.

To convert an element into a whitespace element:

1. Import the promotional image or snippet; see "Images" on page 252 and "Snippets" on
page 266.

2. Insert the promotional image or snippet in the content.

Note

« Only a top-level element (for example, a paragraph that is not inside a table or
div) can function as a whitespace element.

« Do not place the promotional image or snippet inside an absolute positioned
box. Whitespacing only works for elements that are part of the text flow, not for
absolute-positioned boxes.

3. Select the image or the element that holds the promotional content: click it, or use the
breadcrumbs, or select it on the Outline tab; see "Selecting an element" on page 183.

4. On the Attributes pane, check the option Whitespace element.

5. (Optional.) Add extra space at the top of the element: on the menu Format, click the
option relevant to the selected element (Image for an image, Paragraph for a paragraph,
etc.) and adjust the spacing (padding and/or margins).

Do not add an empty paragraph to provide space between the whitespace element and
the variable content. The extra paragraph would be considered content and could end up
on a separate page, together with the whitespace element.

Page numbers

Inserting page numbers

Page numbers can be added to a Print section, but they are usually added to a Master Page,
because headers and footers are designed on Master Pages; see also: "Master Pages" on
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page 145.

To insert a page number, select Insert > Special character > Markers on the menu, and then
click one of the options to decide with what kind of page number the marker will be replaced:

« Page number: The current page number in the document. If a page is empty or does not
display a page number, it is still added to the page count.

« Page count: The total number of pages in the document, including pages with no
contents or without a page number.

« Content page number: The current page number in the document, counting only pages
with contents that are supplied by the Print section. A page that has a Master Page (as set
in the Sheet Configuration dialog, see "Applying a Master Page to a page in a Print
section" on page 147) but no contents, is not included in the Content page count.

« Content page count: This is the total number of pages in the current document that have
contents, supplied by the Print section. A page that has a Master Page but no contents, is
notincluded in the Content page count.

« Sheet number: The current sheet number in the document. A sheetis a physical piece of
paper, with two sides (or pages). This is equivalent to half the page number, for example if
there are 10 pages, there will be 5 sheets.

« Sheet count: This marker is replaced by the total number of sheets in the document,
whether or not they have contents.

Note

When a marker is inserted, a class is added to the element in which the marker is inserted. Do not
delete that class. It enables the software to quickly find and replace the marker when generating
output. The respective classes are: pagenumber, pagecount, contentpagenumber,
contentpagecount, sheetnumber, and sheetcount.

Tip
Instead of page numbers, you might want to display the current record index and/or the total

number of records in the record set, in the document. There is a How-to that explains how to do
that: How to get the record index and count.
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Creating a table of contents

A table of contents can only be created in a script.

If you are looking to create a short, simple table of contents in one section, you could add a
Standard Script that uses the pageref () function. For an example, see "Creating a table of
contents" on page 778.

For a multi-page, cross-section table of contents you must use a Post Pagination Script; see
"Creating a Table Of Contents" on page 407.

The basics of script-writing in the Designer are explained in the following topic: "Writing your
own scripts" on page 360.

Configuring page numbers

By default the page numbers are Arabic numerals (1, 2, 3, etc.) without leading zeros nor prefix,
and page numbering starts with page 1 for each section. But this can be changed. To do that:

1. On the Resources pane, right-click a section in the Print context and click Numbering.

2. Uncheck Restart Numbering if you want the page numbers to get consecutive page
numbers, instead of restarting the page numbering with this section.

Note

Even if a section is disabled, so it doesn't produce any output, this setting is still
taken into account for the other sections. This means that if Restart Numbering is
checked on a disabled section, the page numbering will be restarted on the next
section.

Disabling a section can only be done in a Control Script (see "Control Scripts" on
page 390). Control Scripts can also change where page numbers restart.

3. Use the Format drop-down to select uppercase or lowercase letters or Roman numerals
instead of Arabic numerals.

4. In Leading Zeros, type zeros to indicate how many digits the page numbers should have.
Any page number that has fewer digits will be preceded by leading zeros.

5. Type the Number prefix. Optionally, check Add Prefix to Page Counts, to add the prefix
to the total number of pages, too.

6. Close the dialog.
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Preventing widows and orphans

Widows and orphans are lines at the beginning or at the end of a paragraph respectively,
dangling at the bottom or at the top of a page, separated from the rest of the paragraph.

By default, to prevent orphans and widows, lines are moved to the next page as soon as two
lines get separated from the rest of the paragraph. The same applies to list items (in unordered,
numbered and description lists).

The number of lines that should be considered a widow or orphan can be changed for the
entire Print context, and per paragraph and in tables.

Note

Widows and orphans are ignored if the page-break-inside property of the paragraph is
set to avoid; see "Preventing a page break" on page 144.

In the entire Print context

To prevent widows and orphans in the entire Print context:

1. On the menu, select Edit > Stylesheets.
2. Select the Print context.

3. Click New (or, when there are already CSS rules for paragraphs, click the selector p and
click Edit).

4. Click Format.

5. After Widows and Orphans, type the minimum number of lines that should be kept
together.

Alternatively, manually set the set the widows and orphans properties in a style sheet:

1. Open the style sheet for the Print context: on the Resources pane, expand the Styles
folder and double-click context_print_styles.css.

2. Add a CSS rule, like the following:
p { widows: 4; orphans: 3 }
Per paragraph

To change the widow or orphan setting for one paragraph only:
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1. Open the Formatting dialog. To do this, you can:

« Select the paragraph using the breadcrumbs or the Outline pane (next to the
Resources pane) and then select Format > Paragraph in the menu.

« Right-click the paragraph and select Paragraph... from the contextual menu.

2. After Widows and Orphans, type the minimum number of lines that should be kept
together.

In tables

The CSS properties widows and orphans can be used in tables to prevent a number of rows
from being separated from the rest of the table.

A Standard Table doesn't flow over multiple pages by default. Splitting a Standard Table over
multiple pages requires setting the Connect-specific data-breakable attribute on all of its rows.
You can either open the Source tab, or write a script to replace each <tr> with <tr data-
breakable="">. Note that the effect will only be visible in Preview mode.

To set the number of widows and orphans for a table:

1. Open the Formatting dialog. To do this, you can:

« Select the table using the breadcrumbs or the Outline pane (next to the Resources
pane) and then select Format > Table in the menu.

« Right-click the paragraph and select Table... from the contextual menu.

2. After Widows and Orphans, type the minimum number of table rows that should be kept
together.

Page breaks

A page break occurs automatically when the contents of a section don't fit on one page.

Note

Improved page breaking in Connect 2019.1 might impact upon templates made with earlier
versions. See "Known Issues" on page 86.
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Inserting a page break

To insert a page break before or after a certain element, set the page-break-before property or
the page-break-after property of that element (a paragraph for example; see also "Styling text
and paragraphs" on page 281):

1. Selectthe element (see "Selecting an element" on page 183).
2. On the Format menu select the respective element to open the Formatting dialog.
3. In the Breaks group, set the before or after property.

« Before: Sets whether a page break should occur before the element. This is
equivalent to the page-break-before property in CSS; see CSS page-break-before
property for an explanation of the available options.

« After: Sets whether a page break should occur after the element. Equivalent to the
page-break-after property in CSS; see CSS page-break-after property for an
explanation of the available options.

Click the button Advanced to add CSS properties and values to the inline style tag directly.
Alternatively you could set this property on the Source tab in the HTML (for example: <h1
style="page-break-before: always;">), oradd a rule to the style sheet; see "Styling your
templates with CSS files" on page 275.

Note

You cannot use these properties on an empty <div> or on absolute-positioned elements.

Preventing a page break

To prevent a page break inside a certain element, set the page-break-inside property of that
element to avoid:

« Selectthe element (see "Selecting an element" on page 183).
« On the Format menu, select the respective element to open the Formatting dialog.

« In the Breaks group, set the inside property to avoid, to prevent a page break inside the
element. For an explanation of all available options of the page-break-inside property in
CSS, see CSS page-break-inside property.
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Alternatively you could set this property on the Source tab in the HTML (for example: <u1
style="page-break-inside: avoid;">), or add a rule to the style sheet; see "Styling your
templates with CSS files" on page 275.

Adding blank pages to a section

How to add a blank page to a section is described in a how-to: Create blank page on field
value.

Master Pages

In Print sections, there are often elements that need to be repeated across pages, like headers,
footers and logos. In addition, some elements should appear only on specific pages, such as
only the first page, or the last page, or only on pages in-between. Examples are a different
header on the first page, and a tear-off slip that shows up on the last page.

This is what Master Pages are used for. Master Pages can only be used in the Print context
(see "Print context" on page 123).

Master Pages resemble Print sections, and they are edited in much the same way (see "Editing
a Master Page" on the facing page) but they contain a single page and do not have any text
flow. Only one Master Page can be applied per page in printed output. Then a Print template is
created, one master page is added to it automatically. You can add more Master Pages; see
"Adding a Master Page" below. Initially, the original Master Page will be applied to all pages,
but different Master Pages can be applied to different pages; see "Applying a Master Page to a
page in a Print section" on page 147.

Examples

There are a few How-tos that demonstrate the use of Master Pages:

« Showing a Terms and Conditions on the back of the first page only.

« A tear-off section on the first page of an invoice.

o Tips and tricks for Media and Master Pages.

Adding a Master Page

When a Print template is created, one master page is added to it automatically. Adding more
Master Pages can be done as follows:
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On the Resources pane, right-click the Master pages folder and click New Master Page.

Type a name for the master page.

Optionally, set the margin for the header and footer. See "Adding a header and footer"
below.

Click OK.

Initially, the master page that has been created together with the Print context will be applied to
all pages in the Print section. After adding more Master Pages, different Master Pages can be
applied to different pages; see "Applying a Master Page to a page in a Print section" on the
next page.

Editing a Master Page

Master Pages are edited just like sections, in the workspace. To open a Master Page, expand
the Master pages folder on the Resources pane, and double-click the Master Page to open it.
The drop-downs at the top of the Workspace let you select a Section and a Media (front or
back) that will serve as a background to your Master Page design.

A Master Page can contain text, images and other elements (see "Content elements" on

page 179), including variable data and dynamic images (see "Personalizing content" on

page 312). All elements on a Master Page should have an absolute position or be inside an
element that has an absolute position. It is good practice to position elements on a Master Page
by placing them in a Positioned Box (see "Content elements" on page 179).

Keep in mind that a Master Page always remains a single page. lts content cannot overflow to a
next page. Content that doesn't fit, will not be displayed.

Note

Editing the Master Page is optional. One Master Page must always existin a Print
template, but if you don't need it, you can leave it empty.

Adding a header and footer

Headers and footers are not designed as part of the contents of a Print section, but as part of a
Master Page, which is then applied to a page in a print section.

To create a header and footer:

Page 146

PrintShop Mail Connect



1. Firstinsert elements that form the header or footer, such as the company logo and
address, on the Master Page; see "Editing a Master Page" on the previous page.

2. Next, define the margins for the header and footer. The margins for a header and footer
are set in the Master Page properties. This does not change the content placement within
the Master Page itself; in Master Pages, elements can go everywhere on the page.
Instead, the header and footer of the Master Page limit the text flow on pages in the Print
sections to which this Master Page is applied. Pages in a Print section that use this
Master Page cannot display content in the space that is reserved by the Master Page for
the header and footer, so that content in the Print section does not collide with the content
of the header and footer. To set a margin for the header and/or footer:

1. On the Resources pane, expand the Master pages folder, right-click the master
page, and click Properties.

2. Fill out the height of the header and/or the footer. The contents of a print section will
not appear in the space reserved for the header and/or footer on the corresponding
master page.

3. Finally, apply the master page to a specific page in a print section. See "Applying a
Master Page to a page in a Print section" below.

Applying a Master Page to a page in a Print section

Every sheetin a Print section has a natural position: it can be the first, the last, one of the
sheets in between ('middle’), or a single sheet. For each of these positions, you can set a

different Master Page and Media (see "Media" on the facing page). It can even have two master
pages, if printing is done on both sides (called duplex printing).

To apply Master Pages to specific page positions in a Print section:

1. On the Resources pane, expand the Print context; right-click the Print section, and click
Sheet configuration.

2. Optionally, check Duplex to enable content to be printed on the back of each sheet. Your
printer must support duplex for this option to work. If Duplex is enabled, you can also
check Tumble to duplex pages as in a calendar, and Facing pages to have the margins
of the section switch alternately, so that pages are printed as if in a magazine or book.

3. Ifthe option Same for all positions is checked, the same Master Page will be applied to
every page in the print section (and to both the front and the back side of the page if
duplex printing is enabled). Uncheck this option.
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4. Decide which Master Page should be linked to which sheet (position): click the downward
pointing arrow after Master Page Front and select a Master Page. If Duplex is enabled,
you can also select a Master Page for the back of the sheet and consequently, check
Omit Master Page Back in case of an empty back page to omit the specified Master
Page on the last backside of a section if that page is empty and to skip that page from the
page count.

5. Optionally, decide which Media should be linked to each sheet.

6. Click OK to save the settings and close the dialog.

Note

Master Pages, Media and Duplex printing options can also be set in a Control Script (see "Control
Scripts" on page 390 and "Control Script API" on page 811). This is especially useful when you
need identical sections with different settings.

Deleting a Master Page

To delete a Master Page, expand the Master pages folder on the Resources pane, right-click
the master page, and click Delete.

Note that one Master Page as well as one Media must always exist in a Print template. Just
leave it empty if you don't need it.

Media

When the output of a Print context is meant to be printed on paper that already has graphical
and text elements on it (called stationery, or preprinted sheets), you can add a copy of this
media, in the form of a PDF file, to the Media folder.

Media can be applied to pages in a Print section, to make them appear as a background to
those pages. This ensures that elements added to the Print context will correspond to their

correct location on the preprinted media.

For further explanation about how to apply Media to different pages, see "Applying Media to a
page in a Print section" on page 152.

Media will not be printed, unless you want them to; see below.
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Per Media, a front and back can be specified and you can specify on what kind of paper the
output is meant to be printed on. This includes paper weight, quality, coating and finishing; see
"Setting Media properties" below.

Adding Media

To add a Media, right-click the Media folder on the Resources pane and select New Media.

The new Media is of course empty. You can specify two PDF files for the Media: one for the
front, and, optionally, another for the back.

Specifying and positioning Media

Specifying a PDF for the front: the fast way

To quickly select a PDF file for the front of a Media, drag the PDF file from the Windows
Explorer to one of the Media. The Select Image dialog opens; select an image and check the
option Save with template if you want to insert the image into the Images folder on the
Resources pane. (For PDF files selected by URL this option is always checked.)
Alternatively you could firstimport the PDF file to the Images folder on the Resources pane
(using drag & drop) and drag it from there on one of the Media in the Media folder.

Either way, you cannot set any options.

To be able to specify a PDF file for both the front and the back of the Media, and to specify a
position for the Media's PDF files, you have to edit the properties of the Media.

Setting Media properties

Media have a number of properties that you can set. You can change the Media's page size
and margins (as long as itisn't applied to a section), you can specify a PDF file (or any other
type of image file) for both the front and the back of the Media, and you can determine how the
virtual stationery should be positioned on the page. This is done as follows:

1. On the Resources pane, expand the Contexts folder, expand the Media folder, right-
click the Media and click Properties.

2. Now you can change the name and page size of the Media. Note that it isn't possible to
change the page size once the Media is applied to a section. Media can only be applied
to sections that have the same size.
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3. On the Virtual Stationery tab, you can click the Select Image button to select a PDF
image file.

Note
Encrypted PDF files are not supported in PDF pass-through mode.

« Click Resources, Disk or Url, depending on where the image is located.

e Resources lists the images that are present in the Images folder on the
Resources pane.

» Disk lists image files that reside in a folder on a hard drive that is accessible
from your computer. Click the Browse button to select a folder (or an image in
a folder).
As an alternative it is possible to enter the path manually. You can give a local
path (e.g. C:\Images\Test.jpg) or use the "file" protocol. The complete syntax of
a fully qualified URL with the "file" protocol is: file://<host>/<path>.
Note: if the host is "localhost", it can be omitted, resulting
infile:///<path>,forexample:
file:///c:/resources/images/image. jpg.

« Url lists image files from a specific web address. Select the protocol (http or
https), and then enter a web address (for example,
http://www.mysite.com/images/image.jpg).

Note

If a URL doesn't have a file extension, and the option Save with template is
not selected, the Select Image dialog automatically adds the filetype
parameter with the file extension as its value (for example: ?filetype=pdf
(ifitis the first parameter) or samp; filetype=pdf).

The filetype, page and nopreview parameters are not sent to the host;
they are used internally. Therefore, URLs that rely on one of these parameters
cannot be used.
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« With an external image, you can check the option Save with template. If this option
is checked, the file will be inserted in the Images folder on the Resources pane at

the top left.

If it isn't saved with the template, the image remains external. Note that external
images need to be available when the template is merged with a record set to
generate output, and that their location should be accessible from the machine on
which the template's output is produced. External images are updated (retrieved) at
the time the output is generated.

4. If the PDF file consists of more than one page, select the desired page.

Note

The number of pages in a PDF file can not be determined via the HTTP and
HTTPS protocols. If you wish to use a page other than page 1 in a remote PDF,
check the option Save with template; then click OK and reopen the dialog. Next, on
the Resources tab, select the PDF, and select a page.

5. Click Finish.
6. For each of the PDF files, select a position:
« Fit to page stretches the PDF to fit the page size.
« Centered centers the PDF on the page, vertically and horizontally.

« Absolute places the PDF at a specific location on the page. Use the Top field to
specify the distance between the top side of the page and the top side of the PDF,
and the Left field to specify the distance between the left side of the page and the
left side of the PDF.

7. Finally, click OK.

Setting the paper's characteristics

To set a Media's paper characteristics:

1. On the Resources pane, expand the Contexts folder, expand the Media folder, and
right-click the Media. Click Characteristics.
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2. Specify the paper's characteristics:

« Media Type: The type of paper, such as Plain, Continuous, Envelope, Labels,
Stationery, etc.

« Weight: The intended weight of the media in grammage (g/m2).

« Front Coating: The pre-process coating applied to the front surface of the media,
such as Glossy, High Gloss, Matte, Satin, etc.

« Back Coating: The pre-process coating applied to the back surface of the media.

« Texture: The intended texture of the media, such as Antique, Calenared, Linen,
Stipple or Vellum.

« Grade: The intended grade of the media, such as Gloss-coated paper, Uncoated
white paper, etc.

« Hole Name: A predefined hole pattern that specifies the pre-punched holes in the
media, such as R2-generic, R2m-MIB, R4i-US, etc.

3. Click OK.

Rename Media

To rename Media:

« On the Resources pane, expand the Contexts folder, expand the Media folder, right-
click the Media and click Rename. Type the new name and click OK.

« Alternatively, on the Resources pane, expand the Contexts folder, expand the Media
folder, right-click the Media and click Properties. Type the new name in the Name field
and click OK.

Applying Media to a page in a Print section

Every page in a print section has a natural position: it can be the first page, the last page, one of
the pages in between (a 'middle page'), or a single page. For each of those positions, you can
set different Media.

To apply Media to specific page positions in a Print section:

1. On the Resources pane, expand the Print context; right-click the Print section, and click
Sheet configuration.
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2. Optionally, check Duplex to enable content to be printed on the back of each sheet. Your
printer must support duplex for this option to work. If Duplex is enabled, you can also
check Tumble to duplex pages as in a calendar, and Facing pages to have the margins
of the section switch alternately, so that pages are printed as if in a magazine or book.

3. If the option Same for all positions is checked, the same Media will be applied to every
page in the print section. Uncheck this option.

4. Decide which Media should be linked to each sheet position: click the downward pointing
arrow after Media and select a Media.

5. Optionally, decide which Master Page should be linked to each sheet; see "Master
Pages" on page 145.

Note

When both Media and a Master Page are used on a certain page, they will both be
displayed on the Preview tab of the workspace, the Master Page being 'in front' of the
Media and the Print section on top. To open the Preview tab, click it at the bottom of the
Workspace or select View > Preview View on the menu.

Note

Master Pages, Media and Duplex printing options can also be set in a Control Script (see "Control
Scripts" on page 390 and "Control Script API" on page 811). This is especially useful when you
need identical sections with different settings.

Dynamically switching the Media

In addition to applying Media to sheets via the settings, itis possible to change Media
dynamically, based on a value in a data field, in a script. The script has already been made;
you only have to change the name of the Media and the section in the script, and write the
condition on which the Media has to be replaced.

1. On the Resources pane, expand the Contexts folder, expand the Print context, right-
click the print section and click Sheet configuration.

2. Decide which pages should have dynamically switching media: every first page in the
Print section, every last page, one of the pages in between (a 'middle page'), or a single
page. (Uncheck the option Same for all positions, to see all page positions.)
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3. In the area for the respective sheet position, click the Edit script button next to Media.

The Script Wizard appears with a standard script:
results.attr ("content", "Media 1");

Media 1 will have been replaced with the name of the media selected for the chosen

sheet position.
The field Selector in the Script Wizard contains the name of the section and the sheet

position that you have chosen.

4. Change the script so that on a certain condition, another media will be selected for the

content. For instance:
if (record.fields.GENDER === 'M') {
results.attr ("content", "Media 2");

}

This script changes the media to Media 2 for male customers.
See "Writing your own scripts" on page 360 if you are not familiar with how scripts are

written.

5. Click Apply, open the tab Preview and browse through the records to see if the script
functions as expected.

6. When you click OK, the script will be added to the Scripts pane.

Rotating the Media in a Print section

The actual orientation of the Media and that of a section to which the Media is applied may not

match.
The Media (to be more accurate: the Virtual Stationery images specified for this Media) can

therefore be rotated per Print section:

« On the Resources pane, expand the Print context; right-click the Print section, and click
Sheet configuration.

« Click one of the options next to Media rotation.

The Media will be rotated accordingly in the entire section.
Note

« Any Virtual Stationery settings made for the Media also influence how the Media is
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displayed in each section (see "Setting Media properties" on page 149).

« Section backgrounds are rotated separately (see "Using a PDF file as background
image" on page 132).

Ifin the Media properties, the Virtual Stationery position is set to Absolute, any offset given by
the Top and Left values will be applied after rotation. A Virtual Stationery image located
absolutely at the top left (Top: 0, Left: 0) will still appear at the top left of the page after rotating
the Media.

Printing virtual stationery

Media are not printed, unless you want them to. Printing the virtual stationery is one of the
settings in a Job Creation Preset. To have the virtual stationery printed as part of the Print
output:

1. Create a job creation preset that indicates that Media has to be printed: select File >
Presets and see "Output Creation Presets" on page 645 for more details.

2. Selectthatjob creation presetin the Print Wizard; see "Generating Print output" on
page 857.

Email

With the Designer you can create one or more Email templates and merge the template with a
data set to generate personalized emails.

The Email context is the folder in the Designer that can contain one or more Email templates,
also called Email sections. The HTML generated by this context is meant to be compatible

with as many clients and as many devices as possible.

Email template

Itis strongly recommended to start creating an Email template with a Wizard; see "Creating an
Email template with a Wizard" on page 160.

Also see "Designing an Email template" on the facing page for guidelines on the design.
Designing HTML email that displays properly on a variety of devices and screen sizes is
challenging. Building an email is not like building for the web. While web browsers comply with
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standards (to a significant extent), email clients do not. Different email clients interpret the same
HTML and CSS styles in totally different ways.

When an Email template is created, either with a Wizard or by adding an Email context to an
existing template (see "Adding a context" on page 110), the Email context folder is created
along with other files that are specific to an Email context; see "Email context" on page 163.

Only one Email section is created at the start, but you can add as many Email sections as you
need; see "Email templates" on page 166. However, when the Designer merges a data set to
generate output from the Email context, it can merge only one of the templates with each
record; see "Generating Email output" on page 873.

Email templates are personalized just like any other template; see "Variable Data" on
page 322.

Sending email

When the template is ready, you can change the email settings (see "Email header settings" on
page 169) and send the email. To test a template, you can send a test email first.

Output, generated from an Email template, can have the following attachments:

« The contents of the Print context, in the form of a single PDF attachment. (Compression
options for PDF attachments can be specified in the Email context's properties; see
"Compressing PDF attachments" on page 165.)

« Otherfiles, an image or a PDF leaflet for example.

Attaching the Print context is one of the options in the "Send (Test) Email" on page 482 dialog.

See "Email attachments" on page 175 and "Generating Email output" on page 873.

Designing an Email template

With the Designer you can design Email templates. It is strongly recommended to start creating
an Email template with an Email Template Wizard, because it is challenging to design HTML
email that looks good on all email clients, devices and screen sizes that customers use when
they are reading their email.
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This topic explains why designing HTML email design is as challenging as it is, which
solutions are used in the Email Template Wizards and it lists good practices, for example
regarding the use of images in HTML email. It will help you to create the best possible Email
templates in the Designer.

HTML email challenges

Creating HTML email isn't like designing for the Web. That's because email clients aren't like
web browsers. Email clients pass HTML email through a preprocessor to remove anything that
could be dangerous, introduce privacy concerns or cause the email client to behave
unexpectedly. This includes removing javascript, object and embed tags, and unrecognized
tags. Most preprocessors are overly restrictive and remove anything with the slightest potential
to affect the layout of their email client. Next, the HTML has to be rendered so that it is safe to
show within the email client. Unfortunately, desktop, webmail, and mobile clients all use
different rendering engines, which support different subsets of HTML and CSS. More often than
not, the result of these operations is that they completely break the HTML email's layout.

Designing HTML email in PrintShop Mail Designer

The problem of HTML email is that preprocessing and rendering engines break the HTML
email's layout. HTML tables, however, are mostly left untroubled. As they are supported by
every major email client, they are pretty much the only way to design HTML emails that are
universally supported. That's why Tables are heavily used to position text and images in HTML
email.

Nesting tables (putting tables in table cells) and applying CSS styles to each table cell to make
the email look good on all screen sizes is a precision work that can be a tedious and
demanding. Connect's Designer offers the following tools to make designing HTML email
easier.

Email templates: Slate and others

The most obvious solution offered in the Designer is to use one of the templates provided with
the Designer; see "Creating an Email template with a Wizard" on page 160. The layout of these
templates has been tested and proven to look good in any email client, on any device and
screen size. The Tables in these templates are nested (put inside another table) and they have
no visible borders, so readers won't notice them.
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Tip
Click the Edges button on the toolbar to make borders of elements visible on the Design
tab. The borders will not be visible on the Preview tab or in the output.

Litmus

There are several tools to preview how email will be rendered on a variety of clients. We
recommend using Litmus. Support for Litmus is integrated into the Designer; the Send Test
Email dialog has an option to "Send to Litmus".

Emmet

Emmet is a plugin that enables the lightning-fast creation of HTML code though the use of a
simple and effective shortcut language. The Emmet functionality is available in the HTML and
CSS source editors of Connect Designer. Emmet transforms abbreviations for HTML elements
and CSS properties to the respective source code. The expansion of abbreviations is invoked
with the Tab key.

In the Source tab of the Workspace, you could for example type div.row. This is the
abbreviation for a <div> element with the class row.

On pressing the Tab key, this abbreviation is transformed to:

<div class="row"></div>

To quickly enter a table with the ID 'green’, one row, and two cells in that row, type:
tablef#fgreen>tr>td*2

On pressing the Tab key, this is transformed to:

<table id="green">

<tr>
<td></td>
<td></td>
</tr>
</table>

All standard abbreviations can be found in Emmet's documentation: Abbreviations.

To learn more about Emmet, please see their website: Emmet.io and the Emmet.io
documentation: http://docs.emmet.io/.
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Preferences

To change the way Emmet works in the Designer, select Window > Preferences, and in the
Preferences dialog, select Emmet; see "Emmet Preferences" on page 349.

Using CSS files with HTML email

Email clients do not read CSS files and some even remove a <style>tag when itis presentin
the email's header. Nevertheless, CSS files can be used with the Email context in the
Designer. When generating output from the Email context, the Designer processes all CSS
rules that apply to the content of the email to inline style properties, as if local formatting was
applied.

Using images in email campaigns: tips

Host images on a public server

In the Designer you can add images as resource to the template document. When used in
email messages these images are automatically embedded on sending the email. These
embedded images appear instantly when viewing the message in your email client.

There is, however, a downside to this method: embedded images can't be used to track email
open rates. Email services like mandrillapp.com embed a tiny tracer image at the bottom of your
message. Each time a recipient opens the email the tracer image (aka beacon image) is
downloaded and yet another 'open’ is registered. On mobile devices this happens when the
user clicks the Display Images button.

So, when tracking open rates in your email campaigns, store your images on a publicly-
accessible server (preferably your own server) or a reputable image hosting service, like
photobucket.com. Don't forget to set the Alternate Text for your images on the Attributes pane.

Do not capture your email in one big image

Most e-mail clients do not automatically download images, so do not capture your email in one
big image. The recipient initially sees a blank message and probably deletes it right away.

Do not resize images in your email

Many mail clients do not support image resizing and will show the image in its original
dimensions. Resize the images before you link to or embed them.
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Use background images wisely

Most mail clients do not support background images: a very good reason to stay away from
them in your mainstream email campaign. There is one situation in which they do come in
handy. Both iPhone and Android default mail have solid CSS support and cover most of the
mobile marketspace. You could use background images to substitute images when viewed on
these devices. This is done by hiding the actual image and showing a mobile-friendly image as
background image instead. This is a technique used in Responsive Email Design.

Creating an Email template with a Wizard

With the Designer you can design Email templates as well as PDF attachments. PDF
attachments are designed in the Print context; see "Print context" on page 123.

It is strongly recommended to start creating an Email template with a Wizard, because
designing HTML email that displays properly on a variety of devices and screen sizes is
challenging. Email clients can, and will, interpret the same HTML and (inline) CSS in totally
different ways (see "Designing an Email template" on page 156).

With an Email Template Wizard you can easily create an Email template that outputs emails
that look good on virtually any email client, device and screen size.

After creating an Email template, the other contexts can be added to it, as well as other sections
(see "Contexts" on page 109 and "Email templates" on page 166).

To create an Email template with a Template Wizard:

1. In the Welcome screen that appears after startup:

o Choose Browse Template Wizards.
Scroll down until you see the Email Template Wizards. There are three types of
Email Template Wizards:

» Basic Email templates
« Banded Email templates
« Slate: Responsive Email templates by Litmus.

« Orchoose Create a New Template and select the Email template. This starts the
Basic Action Email wizard.

Alternatively, on the File menu, click New, and:
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« Select Email Template. This starts the Basic Action Email wizard.

« Or expand the Template folder, and then expand the Basic Email templates folder,
the Banded Email templates folder, or the Slate: Responsive Email Templates
by Litmus folder.

See "Email Template Wizards" on the facing page for information about the various types
of Template Wizards.

2. Select a template and click Next. If you don't know what template to choose, see below;
the characteristics of each kind of template are described further down in this topic.

3. Make adjustments to the initial (or last used) settings. The options for each type of
template are listed below.
Click Next to go to the next settings page if there is one.

4. Click Finish to create the template.

The Wizard creates:

« An Email context with one section in it. The section contains dummy text and one or more
selectors for variable data, for example: "Hello @first@". You will want to replace those
by the names of fields in your data. See "Variable Data" on page 322.

The Invoice email template also contains a Detail Table; see Detail table.

« One script, named "To". Double-click that script on the Scripts pane to open it. This
script ensures that the email is sent to an email address that is specified in a data field
called "email-to". After loading data, you can change the script so that it uses the actual
field in your data that holds the customer's email address. See "Email header settings" on
page 169

« A style sheet, named context_htmlemail_styles.css, and another style sheet depending
on which Template Wizard was used. The style sheets can be found in the Stylesheets
folder on the Resources pane.

The Wizard opens the Email section, so that you can fill it with text and other elements; see

"Content elements" on page 179, "Email context" on page 163, and "Email templates" on
page 166.

Tip

Use the Outline pane at the left to see which elements are present in the template and to
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select an element.

Use the Attributes pane at the right to see the current element's ID, class and some other
properties.

Use the Styles pane next to the Attributes pane to see which styles are applied to the
currently selected element.

Note that the contents of the email are arranged in tables. The many tables in an Email
template ensure that the email looks good on virtually any email client, device and screen size.
As the tables have no borders, they are initially invisible.

Tip
Click the Edges button on the toolbar t emporarily adds a frame to certain elements on
the Design tab. These will not .Print or output.

Email Template Wizards

There are Wizards for three kinds of Email templates: for Basic Email, for Banded Email, and
Slate templates for responsive email designed by Litmus.

Slate: Responsive Email Templates by Litmus

Scroll past the Web Template Wizards to see the Slate: Responsive Email templates, created
by Litmus (see https://litmus.com/resources/free-responsive-email-templates).

More than 50% of emails are opened on mobile. These five responsive HTML email templates
are optimized for small screens and they look greatin any inbox. They’ve been tested in Litmus
and are completely bulletproof.

Tip

After creating the email template, click the Responsive Design View icon = v atthe top
of the workspace to see how the email looks on different screen sizes.
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The only thing you can set in advance for a Slate template is the color of the call-to-action
button. Click the small colored square, right next to the field that holds the default color value, to
open the Color dialog and pick a color (see "Color Picker" on page 436).

The color can be changed later; see "Colors" on page 301.

Basic Email and Banded Email

The difference between Basic and Banded email is that the contents of a Basic email extend to
the email's margin, rather than to the edge of the window in which itis read, as the contents of
Banded emails do.

The Banded Email Action Template is a simple call-to-action email with a message, header
and a button linking to a website, such as an informational or landing page.

The Banded Email Invoice Template is an invoice with an optional Welcome message and
Pay Now button.

Settings

For a Blank email you can not specify any settings in the Wizard.
For an Action email, the Email Template Wizard lets you choose:

« The subject. You can change and personalize the subject later, see "Email header
settings" on page 169.

« The text for the header. The header is the colored part at the top. The text can be edited
later.

« The color of the header and the color of the button. Click the small colored square, right
next to the field that holds the default color value, to open the Color dialog and pick a
color (see "Color Picker" on page 436). The color can be changed later; see "Colors" on
page 301.

« The web address where the recipient of the email will be taken after clicking the button in
the email. Type the URL in the Link field.

Email context

In the Designer the Email context is the folder that contains Email templates. From the Email
context, output can be generated in the form of email (see below).
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When an Email template is created (see "Creating an Email template with a Wizard" on
page 160) or when an Email context is added to a template (see "Adding a context" on
page 110) the following happens:

» The Email context is created and one Email section is added to it. You can see this on
the Resources pane: expand the Contexts folder, and then expand the Email folder.
See "Email templates" on page 166 to learn how to fill an Email section.

Although only one email can be sent per record when generating Email output, the Email
context can contain multiple sections. One Email section is created at the start, but you
can add more; see "Adding an Email template" on page 166.

« A style sheet, named context_htmlemail_styles.css, is added to the template. Depending
on which Template Wizard was used to create the template, another style sheet can be
added as well. Style sheets are located in the folder Stylesheets on the Resources

pane. These style sheets are meant to be used for styles that are only applied to elements
in the Email context.

The Wizard opens the Email section, so that you can fill it with text and other elements; see
"Content elements" on page 179 and "Email templates" on page 166.

Sending email

When the template is ready, you can generate Email output; See "Generating Email output" on
page 873.

To test a template, you can send a test email first. This allows you to override the recipient
address.

Output, generated from an Email template, can have the following attachments:

« The contents of the Print context, in the form of a single PDF attachment. (Compression
options for PDF attachments can be specified in the Email context's properties; see
"Compressing PDF attachments" on the next page.)

« Otherfiles, an image or a PDF leaflet for example.

Attaching the Print context is one of the options in the "Send (Test) Email" on page 482 dialog.

Note

To split the Print context into multiple attachments, and to rename this type of attachment,
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you need to create a Control Script that specifies parts; see "Parts: splitting and
renaming email attachments" on page 396.

See "Email attachments" on page 175.

Email output settings

The following settings in an Email context influence how the Email output is generated.

Compressing PDF attachments

For PDF attachments, generated from the Print context, you can set the Print Context Image
Compression to determine the quality of the files, and with that, the size of the files.

To set the Print Context Image Compression:

1. On the Resources pane, expand the Contexts folder; then right-click the Email context
and select PDF Attachments.
Alternatively, select Context > PDF Attachments on the main menu. This option is only
available when editing an Email section in the Workspace.

2. Change the properties of the PDF file that will be attached when the Print context is
attached to the email.
Lossless is the maximum quality. Note that this will produce a larger PDF file. Uncheck
this option to be able to set a lower quality.
The quality is setin a percentage of the maximum quality.
Tile Size is the size of the files in which the image that is being compressed is divided. (If
the image height or width is not an even multiple of the tile size, partial tiles are used on
the edges.) Image data for each tile is individually compressed and can be individually
decompressed. When low Quality values are used to optimize images smaller than 1024
x 1024 pixels, using the largest tile size will produce better results.

Setting a default section for output

When generating output from the Email context, only one of the Email templates can be merged
with each record. One of the Email sections is the 'default’; see "Setting a default Email
template for output” on page 168.
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Email templates

Email templates (also called Email sections) are part of the Email context in a template. The
Email context outputs HTML email with embedded formatting to an email client through the use
of an email server. Since email clients are numerous and do not support same features, the
HTML generated by this context is not optimized for any specific client - rather, it's meant to be
compatible with as many clients and as many devices as possible.

In Email templates, many content elements can be used; see "Content elements" on page 179.
However, special attention must be paid to the way elements are positioned. In Email sections,
itis advisable to position elements using Tables and to put text in table cells.

Email templates are personalized just like any other template; see "Variable Data" on
page 322.

The subject, recipients (To, CC and BCC), sender and reply-to address are specified with
Email Script Wizards; see "Email header settings" on page 169.

An Email context can contain multiple templates. When generating output from the Email
context, however, only one of the Email templates can be merged with each record. Set the
'default' Email section (see below) before generating Email output; see also "Generating Email
output" on page 873.

Adding an Email template

When an Email template is created (see "Creating an Email template with a Wizard" on
page 160), only one Email section is added to it. An Email context may contain various
templates, but per record only one of those can be sent when you generate Email output.

It is not possible to add an Email section to an existing Email context with the help of a
Template Wizard.

To provide alternative content for your email, you could use Conditional Content (see "Showing
content conditionally" on page 330), or Snippets and a script (see "Snippets" on page 266 and

"Loading a snippet via a script" on page 379).

If you would like to start with a template that is identical to the one you already have, consider
copying it (see "Copying a section" on page 111).

To add a section to the Email context:
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« On the Resources pane, expand the Contexts folder, right-click the Email folder, and
then click New Email.

Deleting an Email template

To delete an Emaiil section:

« On the Resources pane, expand the Contexts folder, expand the Email context, right-
click the name of the section, and then click Delete.

Warning

If you don't have a backup of the template, the only way to recover a deleted section, is to
click Undo on the Edit menu, until the deleted section is restored. After closing and
reopening the template itis no longer possible to restore the deleted context this way.

In the Saving Preferences you can set whether a backup file should be created when you
save the template; see "Saving Preferences" on page 357.

Styling and formatting an Email template

The contents of an Email section can be formatted directly, or styled with Cascading Style
Sheets (CSS). See "Styling and formatting" on page 270.

Email clients do not read CSS files and some even remove a <style>tag when itis presentin
the email's header. Nevertheless, CSS files can be used with the Email context in the
Designer. When generating output from the Email context, the Designer processes all CSS
rules that apply to the content of the email to inline style properties, as if local formatting was
applied.

Tip
Before you can style an element, you have to selectit. In an Email context it can be

difficult to select an element by clicking on it. Use the breadcrumbs at the top and the
Outline pane at the left, to select an element. See "Selecting an element" on page 183.

In order for a style sheet to be applied to a specific section, it needs to be included in that
section. There are two ways to do this.
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Drag & drop a style sheet

1. Click and hold the mouse button on the style sheet on the Resources pane.

2. Move the mouse cursor within the Resources pane to the section to which the style sheet
should be applied.

3. Release the mouse button.

Using the Includes dialog

1. On the Resources pane, right-click the section, then click Includes.
2. From the File types dropdown, select Stylesheets.

3. Choose which CSS files should be applied to this section. The available files are listed at
the left. Use the arrow buttons to move the files that should be included to the list at the
right.

4. You can also change the order in which the CSS files are read: click one of the included
CSS files and use the Up and Down buttons. Note that moving a style sheet up in the list
gives it less weight. In case of conflicting rules, style sheets read later will override
previous ones.

Note

Style sheets are applied in the order in which they are included in a section. The styles in
each following style sheet add up to the styles found in previously read style sheets.
When style sheets have a conflicting rule for the same element, class or ID, the last style
sheet ‘wins’ and overrides the rule found in the previous style sheet.

Note

Style sheets that are linked to (i.e. included in) a section show a chain icon in the
Resources pane (see "Resources pane" on page 525).

Setting a default Email template for output

An Email context can contain multiple templates. When generating output from the Email
context, however, only one of the Email templates can be merged with each record.
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To select the Email section that will be output by default:

« On the Resources pane, expand the Email context, right-click a section and click Set as
Defau